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Microsoft, Windows and Windows Server are trademarks or registered trademarks of Microsoft 
Corporation in the United States and other countries.
Apple, iPhone, AirPrint, iPad, Bonjour, macOS, and Mac are trademarks of Apple Inc., registered in 
the U.S. and other countries.
IOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under 
license.
Android and Google Play are trademarks of Google LLC.
Mopria and the Mopria logo are registered trademarks and service marks of Mopria Alliance, Inc. in 
the United States and other countries. Unauthorized use is strictly forbidden.
Other company names or product names are trademarks or registered trademarks of their 
respective companies.
Microsoft product screen shot(s) reprinted with permission from Microsoft Corporation.

FUJIFILM and FUJIFILM logo are registered trademarks or trademarks of FUJIFILM Corporation.
Apeos is a registered trademark or a trademark of FUJIFILM Business Innovation Corp. in Japan and/
or other countries.

Items in this manual displayed with the  mark are cautions to promote safe use. Be sure to read 
them before operation, and to follow instructions.

As the copying machine contains a feature designed to prevent forging of certain documents, there 
may be rare instances where copies do not achieve the desired results.

We are not responsible for any breakdown of machines due to infection of computer virus or 
computer hacking.

Important
 Do not edit, alter or indiscriminately reprint this manual.
 The content of this manual may be changed in the future without notice.
 Each illustration included in this manual shows only one example. Variations may occur, 

depending on the device, software and OS version you are using.
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91.1   Types of Manuals

1 Before Beginning
1.1 Types of Manuals
Setup Guide

This is a description of operational procedures and other basic information on the machine.

Safety Notes
This is a description of cautions and other information to help you use the machine safely.

Reference Guide (this manual) (official website)
Describes how to get ready to print, copy, fax, and scan as well as set various features. It also covers 
the operator panel menus, troubleshooting tips, and maintenance information.

Note
 Optional accessories are available for the machine. Depending on the product, a manual describing 

procedures such as installation may be included.

1.2 Conventions
 Please note that the screenshots shown in this manual apply to a fully configured machine and 

therefore may not exactly represent the configuration being used.
 This manual uses the following symbols:

 Orientation of documents or paper is described in this manual as follows:

, , LEF Orientation: Loading documents or paper in portrait orientation.
, , SEF Orientation: Loading documents or paper in landscape orientation.

 The content of this manual is subject to change without notice. For the latest information, visit the 
official company website.

Indicates important information you have to know or be reminded before 
operations.

Indicates supplemental information useful for operations.

Indicates reference sections or documents.

" "  A cross-reference included in this manual.
 Entered characters and the names of features are displayed.
 Indicates the manual referred to.

[ ]  Buttons or menus displayed on the operator panel screen.
 Buttons, menus, folders, windows, or dialog boxes displayed on the 

computer screen.

< > Indicates hardware buttons on the operator panel.

> Indicates an abbreviated process flow on the operator panel or the 
computer.

Important

Note

Refer
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 Unless otherwise specified, the operations demonstrated in this manual using computers describe 
procedures for Microsoft Windows 10 and MacOS 10.15.

 "WSD" is an abbreviation of "Web Services on Devices."
 WIA stands for Windows Image Acquisition.

1.3 About the Machine
 In order to use the machine more securely, connect to networks with firewall or other protection 

and configure security settings appropriately.
 Optional accessories may be necessary, depending on the function. For details, contact our local 

representative.
 Items appearing on the touch panel display will vary depending on authentication status and 

installed options.
 The fax feature can be used with Apeos C325 z.
 Some features may be unavailable for use depending on country or territory.

1.4 Machine Overview

Machine Main Unit

Front and Right Sides

*1 :This feature can be pulled out for use when printing on paper sizes larger than A4 or for high-volume printing.

1 Operator Panel 5 Tray 1 (Standard Tray)

2 Document Feeder 6 USB Port

3 Right Side Cover 7 Bypass Tray

4 Tray 2 (250-Sheet Feeder) (optional) 8 Output Extension Tray*1

1 2

4
5

6
7

8

3
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Left Side and Rear

Note
 The TEL and LINE ports can be used with models with the FAX feature.

Internal View

1 USB Port 5 Kensington Security Slot

2 Ethernet Port 6 Power Supply Cord Socket

3 TEL Port 7 Fusing Unit

4 LINE Port 8 Rear Cover

1 Drum Cartridge 3 Waste Toner Container

2 Toner Cartridges

6

7

8
1

4

2

3

5

3

2

1
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Document Feeder

Operator Panel

1 Top Cover 6 Document Feeder Tray

2 Document Guide 7 Output Extension Tray

3 Document Glass Cover 8 Document Output Tray

4 Narrow Glass Strip 9 Document Feed Rollers

5 Document Glass

1 Touch Panel Displays various settings, instructions, and error messages.
Configures the settings by directly tapping the screen.

2  (Home) button Display the Home screen.

3 NFC Touch Area Hold the mobile device over the machine to start communication 
between it and the machine through the NFC feature.

4 Status LED  Blinks in green when the machine starts, when a job is 
completed, when an identification signal is received from a 
mobile device, when authentication is successful, and when an 
error is cleared.

 Blinks in orange when an error occurs.

5 Data LED  Blinks when faxes are being sent or received.
 When Secure Fax Receive mode is enabled, it illuminates when 

fax data has been received.

1 2
3

5

4

6

7

8

9

1

2

36
5

4
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1.5 Symbols Used with the Machine
For details on the meanings of symbols, refer to the following.

6  (Power Supply / 
Power Saver) button

 Turns on/off the machine.
 Switches the machine between two modes: standby and power 

saver. Blinks slowly when the machine is in the power saver 
mode.

Refer
 For details on how to turn the power supply on or off, refer to 

"Turning On/Off the Machine" (P.15).
 For details on power saving features, refer to "Power Saver Mode" 

(P.42).

Symbol Description

Cautions, hazards and warnings

Caution: high temperature

Disassembly prohibited

Follow instructions

Do not throw into open flame

Do not touch the light-sensitive 
part of drum cartridge.

Do not throw drum cartridge 
into open flame

Do not throw waste toner 
container into open flame

Do not place waste toner 
container upside-down

Do not expose drum cartridge to 
light.

Power On/Off

Home

Do not use documents with clips 
or staples attached

Do not copy money or stamps

Do not use documents that are 
excessively curled

Do not use documents with 
punched holes

Do not use creased, torn or 
wrinkled documents

Do not use documents that are 
thin and translucent.

Do not use documents with 
adhesive notes or tape attached

Do not use carbon paper 
documents

Symbol Description
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Do not use inkjet paper

Do not use creased, wrinkled or 
curled paper

Do not use OHP film

Do not use the back side of 
paper (printed on by another 
machine)

Paper

Document

Envelope

Load paper with the side you 
want to print on facing up

Maximum load

Load paper

Paper jam

LAN

USB

TEL Port

Symbol Description

LINE Port

Cooling

Elapsed time

Symbol Description
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2 Setting Up the Machine
2.1 Turning On/Off the Machine

Turning On the Machine
1. Press the  (Power Supply / Power Saver) button.

Setting Up Initial Settings of the Machine
When turning on the machine for the first time, screen to set the initial settings of the machine will 
be displayed.

1. Specify the language, then tap [OK].

2. Tap [Next].

3. Follow the on-screen instructions to specify an Internet Services administrator password and 
network.

Note
 Use the character string printed on the rear panel of the machine as the default administrator password, 

and enter it as in the example.
For example, if the imprint on the rear panel were as shown in the illustration, the default password would 
be "AB1-123456".

 You can select [Skip] and change the password later.
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Refer
 For details on Internet Services, refer to "Using Internet Services" (P.151)

Turning Off the Machine
Important
 The print data in the memory is cleared when the machine is turned off.

1. Press the  (Power Supply / Power Saver) button.

2. Tap [Power Off] on the touch panel display.

2.2 Connecting the Machine to a Computer
The machine can connect with wired network, USB, and wireless network connections. After 
connecting, install print driver and other necessary software.

Connecting to a Wired (Ethernet) Network
Note
 Use a LAN cable that is category-5 or greater.

1. At the Home screen, tap  > [Device].

2. Tap [Network Settings]>[Network].
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3. If [Wi-Fi] is selected, select [Ethernet], then tap [OK].
If [Ethernet] is selected, proceed to step 6.

4. If a confirmation screen appears, tap [OK].

5. Turn off the machine, and then turn it on again.

6. Insert the network cable into the machine's Ethernet port.

7. Connect a hub or other network device to the other network cable port.

8. Set the IP address for the machine.

Refer
 For details on how to configure IP addresses, refer to "Setting the IP Address" (P.23).

Connecting to a Computer With USB
1. Press the  (Power Supply / Power Saver) button, select [Power Off] to turn the power off.

2. Insert the USB cable in the machine's (upper) USB port.
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Important
 Do not connect the machine to a USB hub.

3. Connect the computer with the other USB cable port.

4. Press the  (Power Supply / Power Saver) button to turn the power on.

Connecting to a Wireless Network

Preparing to Use a Wireless Network
Perform the following procedures before configuring the wireless settings.

1. At the Home screen, tap  > [Device].

2. Tap [Network Settings]>[Network].

3. If [Ethernet] is selected, select [Wi-Fi], then tap [OK].
If [Wi-Fi] is selected, proceed to wireless LAN connection.

4. If a confirmation screen appears, tap [OK].

5. Turn off the machine, and then turn it on again.
 
Wi-Fi settings can be configured as follows.
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Refer
 "Automatically Connecting to a Wireless Network" (P.19)
 "Manually Connecting to a Wireless Network" (P.20)
 "Connecting Using [Quick Setup] (Windows)" (P.21)
 "Connecting Using Support Tools (Windows)" (P.22)

Automatically Connecting to a Wireless Network
This machine supports wireless LAN connection using WPS (push button method) and WPS (PIN 
code method).
 For WPS (push button method), configure the settings on the operator panel, and then press the 

WPS button on your access point or wireless router.
 For WPS (PIN code method), enter the PIN code assigned to the machine into the access point or 

wireless router.
These methods are available only when the access point or wireless router supports WPS.

Refer
 For details about the WPS operation on the access point or wireless router, see the manual supplied with 

the access point or wireless router.

When Connecting With WPS (push button method)

1. At the Home screen, tap  > [Device].

2. Tap [Network Settings] > [Wi-Fi] > [WPS Setup].

3. When the [Press the WPS button of the wireless LAN router.] message appears, press the WPS 
button on the wireless network access point within 2 minutes.
When connection to an access point or wireless router is complete, the machine will restart 
automatically.
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When Connecting With WPS (PIN code method)

1. At the Home screen, tap  > [Device].

2. Tap [Network Settings] > [Wi-Fi] > [WPS Setup].

3. Tap [Use PIN].

Note
 Write down the eight-digit PIN code displayed on the touch panel.

4. After the message of [PIN: XXXX Operate the wireless LAN router.] appears, set a PIN code for 
the wireless network access point.
When connection to an access point or wireless router is complete, the machine will restart 
automatically.

Refer
 For details about how to enter the PIN code, see the manual supplied with the access point or wireless 

router.

Manually Connecting to a Wireless Network
Connect to a wireless network by selecting your access point or wireless router from the list or by 
specifying the SSID.

Note
 You need the SSID and the WEP key or passphrase of the access point or wireless router. For details, see 

the manual supplied with the access point or wireless router.

When Connecting by Selecting an Access Point or Wireless Router

1. At the Home screen, tap  > [Device].
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2. Tap [Network Settings] > [Wi-Fi].

3. Tap [Wi-Fi Setup Wizard].

4. Tap the desired access point or wireless router.

Note
 If the wireless network access point does not appear, specify the SSID by entering it manually. For details, 

refer to "When Connecting by Entering the SSID Manually" (P.21).

5. Enter the WEP key or passphrase and tap [OK].
When connection to an access point or wireless router is complete, the machine will restart 
automatically.

When Connecting by Entering the SSID Manually

1. At the Home screen, tap  > [Device].

2. Tap [Network Settings] > [Wi-Fi].

3. Tap [Wi-Fi Setup Wizard].

4. Tap [Enter SSID].

5. Enter the SSID and tap .

6. Select [Infrastructure] or [Ad hoc], depending on the environment you are using.

Note
 If [Wi-Fi Direct] is enabled, [Ad hoc] cannot be used.

7. Tap .

8. Specify the encryption type.

9. Tap .

10. Enter the WEP key or passphrase as needed, and tap [OK].

Connecting Using [Quick Setup] (Windows)
Using [Printer Software], [Quick Setup] makes wireless network connections easy to set up. Using 
[Quick Setup], when you connect to a network, you can handle the software installation at the same 
time.
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[Printer Software] is available for download at the official company website.
Access the following URL to download and install.
https://fujifilm.com/fbglobal/eng/support

You can use [Quick Setup] to connect to a wireless network when the following conditions are met.
 Your computer is connected to the access point or wireless router that you want to set on the 

machine.
 The machine is not connected to another wireless network.

Note
 Depending on the environment you are using, there may be cases in which you cannot use [Quick Setup] 

to connect to a wireless network.
 When specifying the encryption type as WEP and connecting to a wireless network, [Quick Setup] cannot 

be used. Configure the wireless network settings from the operator panel and install the software with 
[Custom Installation]. For details on wireless network connection settings, refer to "Manually Connecting 
to a Wireless Network" (P.20) and for details on how to install software, refer to "Installing with [Custom 
Installation]" (P.27)

Refer
 For details on connecting and installing software using [Quick Setup], refer to "Installing Software for 

Windows" (P.25).

Connecting Using Support Tools (Windows)
You can use the [Printer Software] support tool, available for download from the official company 
website, to configure wireless network settings. You can connect to a wireless network with the 
support tools when the following conditions are met.
 Your computer is connected to the access point or wireless router that you want to set on the 

machine.
 The machine is not connected to another wireless network.

1. Extract [Printer Software] after downloading to the computer, and double-click on 
"Launcher.exe" in the generated folder.

2. Click on [Support Tools].

3. Click on [Wi-Fi Settings].

4. Follow the on-screen instructions to configure the settings.

https://fujifilm.com/fbglobal/eng/support
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Setting the IP Address

Setting the IP Address
This section describes how to set/change the IP address.

Note
 When specifying an IP address for an IPv6 environment, use the [Printer Software] support tool available 

for download from the official company website, or Internet Services. For details on support tools, refer 
to "Configuring Settings with [Support Tools] (Windows)" (P.24). For details on Internet Services, refer 
to Internet Services Help.

Setting the IP Address From the Operator Panel

1. At the Home screen, tap  > [Device].

2. Tap [Network Settings].

3. Tap [Ethernet] if the machine is connected by a wired network connection, and [Wi-Fi] if it is 
connected by a wireless network connection.

4. Tap [IP Mode].

5. Tap [Dual Stack], [IPv4] or [IPv6], depending on the environment you are using.

Note
 If the network you are using is compatible with both IPv4 and IPv6, select [Dual Stack].

6. Tap [OK].

7. Tap [TCP/IP].

8. Tap [IP Addressing].

9. Specify the IP address.

To set the IP address automatically

1)Tap [DHCP/AutoIP], [BOOTP] or [DHCP].

2)Tap [OK].

To set the IP address manually

1)Tap [Manual Input].
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2)Tap [OK].

3)Tap [IP Address].

4)Enter the IP address and tap [OK].

5)Tap [Subnet Mask].

6)Enter the subnet mask and tap [OK].

7)Tap [Gateway Address].

8)Enter the gateway address and tap [OK].

10. Turn off the machine, and then turn it on again.

Configuring Settings with [Support Tools] (Windows)

1. Extract [Printer Software] after downloading to the computer, and double-click on 
"Launcher.exe" in the generated folder.

2. Click on [Support Tools].

3. Click on [IP Address Settings].

4. Follow the on-screen instructions to configure the settings.

Checking the IP Address
You can check the settings by using the operator panel, or by printing the System Settings report.

Using the Operator Panel

1. At the Home screen, tap  > [Device].

2. Tap [About].

3. Confirm the IP address displayed in [IPv4] or [IPv6].

Using the System Settings Report

1. Print the System Settings report.

Refer
 For details on how to print reports and lists, refer to "[Information Pages]" (P.116).
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2. Confirm the IP address listed in the report.

Installing Software for Windows
The latest Windows version of [Printer Software] is available at the official company website.
Access the following URL to download and install.
https://fujifilm.com/fbglobal/eng/support

Note
 Perform the following procedure in advance, and then start installing.

- "Connecting to a Wired (Ethernet) Network" (P.16)
- "Connecting to a Computer With USB" (P.17)
- "Preparing to Use a Wireless Network" (P.18)

Using [Printer Software]
You can use the [Printer Software], available for download from the official company website, to 
configure the following features.

1 [Quick Setup]
You can install the basic software bundle used with the machine. When using a wireless network, you 
can obtain the software in one installation by connecting to the network.
The following software can be installed:
 [PCL Driver]
 [Scanner Driver]
 [Print & Scan Hub]

Refer
 For details on the installation method, refer to "Installing with [Quick Setup]" (P.26).
 For details on Print & Scan Hub, refer to "Print & Scan Hub (Windows)" (P.153).

2 [Custom Installation] > [Driver]
You can select and install only the drivers that you need. The following drivers can be installed:
 [PCL Driver]
 [PS Driver]
 [Scanner Driver]

1 2 3 4 5 6 7

https://fujifilm.com/fbglobal/eng/support
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Refer
 For details on the installation method, refer to "Installing with [Custom Installation]" (P.27).

3 [Custom Installation] > [Software]
You can select and install only the software that you need. The following software can be installed:
 [Print & Scan Hub]
 [Scan/Fax phonebook tool]
 [ContentsBridge Utility]

Refer
 For details on the installation method, refer to "Installing with [Custom Installation]" (P.27).
 For details on software, refer to "Using Software Supplied With the Machine" (P.152).

4 [Support Tools] > [Create Driver Setup Disk]
You can create a setup disk for the drivers. Using the setup disk reduces the amount of work required 
when installing drivers on multiple computers with the same settings.

Note
 The setup disk cannot be used with a computer that runs an OS which differs from that of the computer 

that created the disk. Create setup disks for each OS.

5 [Support Tools] > [IP Address Settings]
You can configure the IP address settings.

Refer
 For details on the configuration method, refer to "Configuring Settings with [Support Tools] (Windows)" 

(P.24).

6 [Support Tools] > [Wi-Fi Settings]
You can configure the wireless LAN settings for the machine and your computer.

Refer
 For details on how to configure settings, refer to "Connecting Using Support Tools (Windows)" (P.22)

7 [Support Tools] > [Media Information]
You can check the content recorded in [Printer Software].

Installing with [Quick Setup]

1. Extract [Printer Software] after downloading to the computer, and double-click on 
"Launcher.exe" in the generated folder.
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2. Click on [Quick Setup].

3. Follow the on-screen instructions to complete the setup.

Installing with [Custom Installation]

1. Extract [Printer Software] after downloading to the computer, and double-click on 
"Launcher.exe" in the generated folder.

2. Click on [Driver] or [Software].
If [Software] is selected, proceed to step 5.

3. Select [I accept the terms of the license agreement], and click on [Next].

4. Select your connection method and click on [Next].

5. Follow the on-screen instructions to complete the setup.
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Installing Software for Mac
You can download the latest software for Mac from the official company website.
https://fujifilm.com/fbglobal/eng/support

Installing Software

1. Download software to your computer.

2. Double-click on the downloaded dmg file.

3. Double-click the pkg file in the folder.

4. Follow the on-screen instructions to complete the setup.

Registering the Machine in a Mac

Adding the Machine Using USB Connection

1. Turn on the machine.

2. Connect the USB cable to the machine and your computer.

3. From the [Apple] menu, open [System Preferences], and click on [Printers & Scanners].

4. If the machine appears in [Printers], then registration is complete.
If the machine is not displayed, add the machine following step 5 and the steps that follow.

5. Click on .

6. In the [Kind] column, select the name for the machine displayed as [USB] from [Name].

7. From [Use], select a driver compatible with the machine.

8. Click on [Add].

9. Make sure that the machine is displayed in [Printers].

Adding a Machine Using LPD Connection

1. Turn on the machine.

2. Make sure that your computer and the machine are connected.
If you use a wired connection, connect the machine to the network using an Ethernet cable.
If you use a wireless connection, make sure that the wireless connection of your computer and the 
machine are established properly.

3. From the [Apple] menu, open [System Preferences], and click on [Printers & Scanners].

4. Click on .

5. Click on [IP].

https://fujifilm.com/fbglobal/eng/support
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6. From [Protocol], select [Line Printer Daemon-LPD].

7. Enter the machine's IP address in [Address].

8. From [Use], select a driver compatible with the machine.

9. Click on [Add].

10. Specify an optional accessory already installed on the machine, and click [OK].

11. Make sure that the machine is displayed in [Printers].

Adding the Machine Using Bonjour

1. Turn on the machine.

2. Make sure that your computer and the machine are connected.
If you use a wired connection, connect the machine to the network using an Ethernet cable.
If you use a wireless connection, make sure that the wireless connection of your computer and the 
machine are established properly.

3. From the [Apple] menu, open [System Preferences], and click on [Printers & Scanners].

4. Click on .

5. From [Name], select the name for the machine displayed as [Bonjour Multifunction] in the [Kind] 
column.

6. From [Use], select a driver compatible with the machine.

7. Click on [Add].

8. Specify an optional accessory already installed on the machine, and click [OK].

9. Make sure that the machine is displayed in [Printers].

Enabling Optional Accessories
On the driver, specify the optional accessories installed on the machine to enable the associated 
features.

1. From the [Apple] menu, open [System Preferences], and click on [Printers & Scanners].

2. From [Printers], select this machine, and click on [Options & Supplies].

3. Click on [Options].

4. Select an optional accessory already installed on the machine, and click [OK].
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2.3 Configuring Fax Settings
To use the fax function, connect the machine to a telephone line, and initialize the fax settings from 
the operator panel on the machine.

Connecting the Machine to a Telephone Line
Note
 If you are unable to establish communication correctly with an optical line or ADSL connection, inquire 

with your telephone line service provider. Also inquire with your telephone line service provider for 
details on connection methods.

Connecting to a Public Phone Line

When Using Fax Exclusively

1. Connect one telephone line to the LINE port  on the rear of the machine, and connect the other 
end to the public line.

When Using Both Phone and Fax

1. Connect one telephone line to the LINE port  on the rear of the machine, and connect the other 
end to the public line.

2. Connect one telephone line to the TEL port  on the rear of the machine, and connect the other 
end to the telephone.

Connecting to a Private Branch Exchange (PBX)

1. Connect one telephone line to the LINE port  on the rear of the machine, and connect the other 
end to a private branch exchange (PBX) or other controller.

Setting Initial Fax Settings
To use the fax feature, it is necessary to configure the following settings from the operator panel.

Refer
 For details on settings, refer to "[Fax Settings]" (P.122).

[Country/Region]

1. At the Home screen, tap  > [Device].

2. Select the country you want to specify from [General]>[Fax Settings]>[Country/Region], then 
tap [OK].

3. Tap [OK] on the confirmation screen.
The machine will restart automatically.

[Fax Number] / [Company Name]

1. At the Home screen, tap  > [Device].
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2. Tap [General] > [Fax Settings] > [Fax Number] or [Company Name].

[Transmission]

1. At the Home screen, tap  > [Device].

2. Tap [General] > [Fax Settings] > [Fax Line Settings] > [Transmission].

[Receive Mode]

1. At the Home screen, tap  > [Device].

2. Tap [General] > [Fax Settings] > [Incoming Fax Settings] > [Receive Mode].

[Dial Type]

1. At the Home screen, tap  > [Device].

2. Tap [General] > [Fax Settings] > [Outgoing Fax Settings] > [Dial Type].
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3 Using Your Machine
3.1 Using the Operator Panel

The operator panel comprises the touch panel display,  (Home) button,  (Power Supply / 
Power Saver) button, Data LED, Status LED, and NFC touch area.

Refer
 For details on the Operator Panel, refer to "Operator Panel" (P.12).

About the Home Screen
To display the Home screen, press the  (Home) button. You can customize the Home screen 
according to your purpose of use.

Refer
 To customize the Home screen, refer to "Customizing the Home Screen" (P.36).

1. Apps
Tap  in the upper part of the Home screen to display apps. You can use the following apps.

[Copy]
You can make copies, or configure the copy settings.

Refer
 "Making a Copy" (P.69)

[Copy (ID Card)]
You can copy ID cards, or configure the Copy (ID Card) settings.

Refer
 "Copying an ID Card" (P.72)

[Fax]
You can send and receive faxes, or configure the fax settings.

13 2
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Refer
 "Sending/Receiving a Fax" (P.99)

[Email]
Send Scanned Data by E-mail.

Refer
 "Sending Scanned Data by E-mail" (P.83)

[USB]
You can directly save scanned data to a USB flash drive, and also print documents and photos stored 
in the USB flash drive.

Refer
 "Printing a File in a USB Flash Drive" (P.64)
 "Saving Scanned Data to USB Memory" (P.88)

[Scan to Network]
You can scan documents and send the scanned data to a server, or configure the scan settings.

Refer
 "Storing to a Computer or Server With FTP/SMB (Scan to Network)" (P.78)

[WSD Scan Profile]
You can send scanned data to a computer with Web Services on Devices (WSD).

Refer
 "Storing to a Computer Connected to the Network (Scan to WSD)" (P.82)

[Scan to PC]
Save scanned data directly to a computer.

Refer
 "Storing to a Computer Connected by USB (Scan to PC) (Windows only)" (P.76)

[ID Card Scan]
You can scan both sides of an ID card, and save it to a network server.

Refer
 "Scanning ID Cards" (P.91)

2. PIN List
Tap  in the upper part of the Home screen, and the PIN List will appear. By registering settings for 
frequently used apps, you can easily execute their functions without having to define the settings 
with each use.
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3. Device Management Screen
Tap the left-hand area of the Home screen  and the Device Management screen will appear. The 
Device Management screen display includes address book, job information, device settings, 
consumables status, error messages and network information.

Note
 An icon indicating information on the status of the machine may appear in . In such cases, tap on  to 

check details.

 When the User Authentication feature is enabled,  will appear in the upper part of . Tap it to display a 
list of registered users, and you will also be able to switch accounts. For details, refer to "Using the User 
Authentication Feature" (P.174).

[Address Book]
You can register an address to the address book, or edit/delete the contact information.

Refer
 "Using the Address Book" (P.157)

[Jobs]
You can check the job status or cancel active jobs. Also, you can print the print jobs stored in the 
machine or the faxes received in the secure receiving mode.

Refer
 "Checking Jobs" (P.43)
 "Canceling a Print Job" (P.58)
 "Secure Print" (P.60)
 "Sample Set" (P.61)
 "Using the Secure Receiving Mode" (P.102)

[Device]
You can configure the basic machine settings.

Refer
 "Changing the Machine Settings" (P.115)

[Supplies]
Tap  to check the status of consumables usage.

Indicates whether and how many notifications are present.

Indicates that a job is in progress.

Indicates whether and how many saved jobs are present.
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Refer
 "[Supplies]" (P.120)

[Network Information], [Wi-Fi Direct Information]
Tap ,  or  to check information on the network you are connected to.

Note
 The icon display will vary depending on the connected network and network status.

Refer
 "[Network Settings]" (P.126)
 "[Wi-Fi Direct]" (P.128)

Basic Operations on the Touch Panel

Selecting Apps & Menus
Tap the app or menu.

Scrolling the Screen
Scroll the screen upward or downward.
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Customizing the Home Screen
You can customize the Home screen according to your purpose of use.
You can arrange the tiles on the Home screen for easy access to frequently used apps, and remove 
tiles you don't use.

By registering frequently-used settings—such as "Make 15 two-sided color copies," for instance—in 
the PIN List, you can easily execute their functions without having to define the settings with each 
use.

Moving Apps

1. On the Home screen, press and hold an app.

2. Drag the app to the desired location.
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The bar is displayed in the relocated position. Check the position, and place the app.

3. Press the  (Home) button.

Adding Apps to the Home Screen

1. On the Home screen, press and hold an app.

2. Scroll the Home screen, and tap the  tile.
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3. On the Home screen, tap the apps you want to add.

4. Press the  (Home) button.

Deleting Apps from the Home Screen

1. On the Home screen, press and hold an app.

2. Select the apps to delete, then tap  in the upper left part of the screen.

3. Press the  (Home) button.

Registering App Settings in the PIN List
Frequently used App settings can be registered in the PIN List.

Registering Settings
This description uses the procedure for registering copy-related settings as an example.
When registering settings for faxing, scanning or other features, perform the comparable procedure 
at the relevant settings screen.
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1. At the Home screen, tap [Copy].

2. Change the copy settings.

Refer
 For details on copy settings, refer to "Various Copy Features" (P.70).

3. Tap  > [Pin].

4. Enter the settings name.

5. Tap [Done].
The app settings will be registered in the PIN List.

Deleting Registered Settings

1. At the Home screen, tap .

2. Tap  for the settings you want to delete.

3. Tap [Delete].

4. Tap [Yes].

Changing App Defaults
You can change the app default values. This description uses the procedure for changing copy-
related app default values as an example.
When changing defaults for apps related to faxing, scanning or other features, perform the 
comparable procedure at the relevant settings screen.
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1. At the Home screen, tap  > [Device].

2. Tap [App Defaults] > [Copy Settings].

3. Change the job settings as needed.

4. Tap [OK].

Resetting
You can reset the saved settings for each app. This description uses the procedure for resetting 
copy-related apps as an example.
When resetting apps for faxing, scanning or other features, perform the comparable procedure at 
the relevant settings screen.

1. At the Home screen, tap [Copy].

2. Tap  > [Reset].

Changing Language Settings
You can select the language used on the machine.

1. At the Home screen, tap  > [Device].

2. Tap [Language].

3. Select the language you wish to set, and tap [OK].

Limiting Access to Features
You can use passcodes to limit access to each feature. This prevents unauthorized users from 
operating the machine.
Access restrictions can be applied to the following features:
 [Address Book]
 [Information Pages]
 [General]
 [Network Settings]
 [App Defaults]
 [Security Settings]
 [Maintenance]
 [Advanced Settings]
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1. At the Home screen, tap  > [Device].

2. Tap [Security Settings] > [Admin Authentication].

3. Tap [On].

4. Enter the 4 digit passcode and tap [OK].

5. Re-enter the passcode and tap [OK].
Features subject to access restrictions are marked with . Passcode entry is necessary in order to 
operate restricted features.

Restricting Usage of Functions on Each User
When the user authentication feature is enabled, you can restrict access to the features of the 
machine on each user.
To use the machine, registered users log in to a registered user account using the operator panel. A 
registered user who uses the machine without logging in will be treated as a guest user.
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Refer
 For details, refer to "Using the User Authentication Feature" (P.174).

3.2 Power Saver Mode
The machine is equipped with power saving features that reduce electric power consumption volume 
to conserve electricity.
Power saving features include Low Power Mode and Sleep Mode.
Sleep Mode reduces electric power consumption even more than Low Power Mode, but requires a 
longer recovery period than Low Power Mode.

Switching to Power Saver Mode
The machine enters Power Saver mode in the following cases. In Power Saver mode, the  
(Power Supply / Power Saver) button blinks.
 Press the  (Power Supply / Power Saver) button, and tap [Sleep Mode]
 When the machine has not been operated, no jobs have been executed, and no print data has been 

received until it is time for the machine to enter Power Saver Mode

Note
 The machine will not enter Power Saver Mode while an error message is displayed for paper jams, 

consumables replacement, etc.

Refer
 For details on how to change the interval until the machine enters Power Saver Mode, refer to "Setting 

the Power Saving Features" (P.43).

Recovering From the Power Saver Mode
The machine recovers from Power Saver Mode with the following procedure or state.
 When the  (Power Supply / Power Saver) button is pressed
 When the machine receives a job

Note
 When you press the  (Power Supply / Power Saver) button immediately after the touch panel 

display turns off, or when the machine has not completely entered Power Saver mode, leaving Power 
Saver mode may take some time. Wait until the machine accepts the operation releasing it from Power 
Saver mode, then press the  (Power Supply / Power Saver) button again.

 When the machine receives a job in Power Saver mode, it may return to Power Saver Mode after job 
execution earlier than the specified time.
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Setting the Power Saving Features
1. At the Home screen, tap  > [Device].

2. Tap [General] > [Power Saver].

3. Tap [Low Power Timer] or [Sleep Timer].

4. Enter the desired value.

5. Tap [OK].

3.3 Checking Jobs
At the machine's [Jobs] screen, you can check on job status or cancel queued jobs, etc. You can also 
print or delete jobs saved in the machine.

Note
 Check job status with a report, or with Internet Services. For details, refer to "[Job History]" (P.117) or 

Internet Services Help.

Checking the Job Status
1. At the Home screen, tap  > [Jobs].

Job status is listed.
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Canceling the Pending Jobs

1. At the Home screen, tap  > [Jobs].

2. Select the job you want to cancel.

3. Tap [Cancel].

Printing/Deleting Jobs Stored in the Machine

Printing/Deleting Stored Print Jobs
You can print or delete the jobs that are stored for Secure Print and Sample Set.

Refer
 For details, refer to "Secure Print" (P.60) or "Sample Set" (P.61).

Printing Faxes Received Using the Secure Receiving Mode
Enter a four-digit passcode to print faxes received using the secure receiving mode.

Refer
 For details, refer to "Printing Received Faxes" (P.102).

3.4 Print Media Guidelines
Note
 For details on paper that can be used, contact our local representative.

Feed Performance for Each Tray
Paper Tray Supported Paper 

Weight (gsm)
Paper Size Permissible sheet 

count load*1

Tray 1 60 to 176 Width: 76.2 - 215.9 mm*2

Height: 127.0 - 355.6 mm
250 sheets

Tray 2 (250-Sheet 
Feeder) (optional)

60 to 176 Width: 76.2 - 215.9 mm
Height: 210.0 - 355.6 mm

250 sheets

Bypass Tray 60 to 176 Width: 76.2 - 215.9 mm*2

Height: 127.0 - 355.6 mm
50 sheets
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*1 :For 80 gsm paper
*2 :Envelopes only, up to 220.0 mm

Important
 The presence of water, rain, steam or other moisture may cause images to come off of the print surface. 

For details, contact our local representative.

Note
 Envelopes can be loaded into the trays to the following stack heights (envelope counts).

Tray 1: approximately 27.5 mm (20 envelopes)
Bypass Tray: approximately 5.4 mm (5 envelopes)

 The automatic two-sided feature can be used with the following paper sizes and weights.
Width: 139.0 mm - 215.9 mm
Height: 210.0 mm - 355.6 mm
Paper weight: 60-176 gsm

Paper That Cannot Be Used
To avoid machine problems, do not use the following print media:
 Inkjet paper
 Heat-sensitive paper / thermal transfer paper
 Textile transfer paper
 Water transfer paper
 Paper with items such as staples, paper clips, ribbons or tape attached
 Windowed envelopes
 Envelopes with protrusions or clasps
 Paper with special surface coatings
 Paper with surfaces that are rough, fibrous or otherwise not smooth
 Paper with inks that deteriorate when exposed to the heat of the fusing process
There are also other types of paper that cannot be used. For details, contact our local representative.

Storing and Handling Print Media

Storing Print Media
 Store paper in a cabinet or other location where humidity is low. If the paper absorbs moisture, this 

could cause paper jams and poor print quality.
 When the print media package is opened but not used up, store unused print media in the 

wrapping paper.
 Store print media on a flat surface so that the edges do not buckle or curl.
 Store print media in places not exposed to direct sunlight.

Handling Print Media
 Straighten the edges of the print media stack before loading.
 Do not load multiple sizes of paper at the same time.
 Flex and fan label sheets before loading, otherwise a paper jam may occur or multiple sheets may 

be fed at a time.
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3.5 Loading Print Media

Flex and Fan the Paper
Flex and fan the paper well before loading.

1. Hold one end of the paper, and flex and fan as shown in the illustration.

2. Turn the paper over, then flex and fan again.

3. Loosen the paper.

4. Repeat the procedure described above several times, then align the four corners of the paper 
stack.

Loading Paper in Tray 1 / Tray 2 (250-Sheet Feeder) 
(Optional)

Important
 Do not add paper of a different size or type to the paper remaining in the tray. Doing so could cause a 

paper jam or error.
 Do not add paper to or remove paper from the paper tray while printing or copying from it. Doing so 

could cause a paper jam.

1. Supporting the paper tray with both hands, pull it out completely.
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2. Move the paper guides to the position to fit the paper size.

Note
 When loading legal-sized paper, press and hold the button on the bottom while pulling out the front side 

of the tray.

3. Place the side you want to copy or print on facing up, and load the paper with its leading edge 
aligned with the interior end of the tray.

Important
 Do not load paper in amounts exceeding the fill line (marked "MAX"). Doing so could cause a paper jam 

or malfunction.

Note
 Misalignment between the paper and paper guide could cause a paper jam. If the paper and paper guide 

are misaligned, readjust the paper guides according to the paper size.

4. Insert the paper tray into the machine main unit, and press it in slowly until it stops.

5. When the paper settings screen appears on the operator panel, tap [Paper Size].

6. Select paper size, then tap .

7. Tap [Paper Type].
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8. Select paper type, then tap .

9. Tap [OK].

Loading paper in the Bypass Tray
Important
 Do not add paper to or remove paper from the Bypass Tray while printing or copying from it. Doing so 

could cause a paper jam.

Note
 If the paper jams, load paper one sheet at a time.

1. Open the Bypass Tray.

Note
 Pull out the Extension Tray as needed. When pulling out the Extension Tray, do so slowly.

2. Adjust the paper guides according to the paper size that you want to load.
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3. Place the side on which you want to copy or print facing up, and with the paper aligned, insert 
until its leading edge is lightly stopped.

Important
 Do not load paper in amounts exceeding the fill line (marked "MAX"). Doing so could cause a paper jam 

or malfunction.

Note
 Misalignment between the paper and paper guide could cause a paper jam. If the paper and paper guide 

are misaligned, readjust the paper guides according to the paper size.
 When you load custom size paper, adjust the paper guides according to the paper size.

4. When the paper settings screen appears on the operator panel, tap [Paper Size].

Note
 The factory default settings are configured to display the paper settings screen. If the paper settings 

screen does not appear, for [Bypass], set [Display Tray Prompt] to [On]. For details, refer to "[Bypass]" 
(P.118)

5. Select paper size, then tap .

6. Tap [Paper Type].

7. Select paper type, then tap .

8. Tap [OK].

Printing on Paper Loaded in the Bypass Tray
This description uses the procedure for the Windows PCL driver as an example.
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1. At the Home screen, tap  > [Device].

2. Tap [Trays]>[Bypass]>[Prioritize Driver Setting].

3. Tap [On]> >[OK].

4. Press the  (Home) button.

5. Load paper into the Bypass Tray.

6. When the paper settings screen appears on the operator panel, tap [OK].

7. On your computer, open the file that you want to print.

8. From the [File] menu, select [Print].

Note
 Menu names may differ depending on the application.

9. From [Select Printer], select this machine, and click on [Preferences].

10. Under the [Paper/Output] tab, click on  for [Paper], then select [Select By Tray]>[Bypass Tray].

11. Click on  for [Paper], then specify the same paper size and type as is loaded in the paper tray.

12. Click on [OK].

13. Click on [Print].

Note
 Under the print driver's [Select By Tray], you can print by selecting [Automatically Select]. In this case, at 

the [Bypass Tray Settings] screen, set [Prioritize Driver Setting] to [Off], and correctly specify the same 
paper size and type as is loaded.

Refer
 For details about a print driver feature, see the print driver help.
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Copying on Paper Loaded in the Bypass Tray

1. At the Home screen, tap  > [Device].

2. Tap [Trays]>[Bypass]>[Prioritize Driver Setting].

3. Tap [Off] > .

4. Tap [Paper Size].

5. Select the paper size to be loaded, then tap .

6. Tap [Paper Type].

7. Select the paper type to be loaded, then tap .

8. Tap [OK].

9. Press the  (Home) button.

10. Load paper into the Bypass Tray.

11. When the paper settings screen appears on the operator panel, tap [OK].

12. Load documents.

Refer
 For details on how to load documents, refer to "Loading a Document" (P.54)

13. At the Home screen, tap [Copy].
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Refer
 For details on copy features, refer to "Copying" (P.69).

14. Tap [Paper Trays].

15. Select [Bypass], then tap .

16. Scroll the screen to change copy settings as needed.

Refer
 For details on copy settings, refer to "Various Copy Features" (P.70).

17. Tap [Start].

Loading Envelopes
Envelopes can be loaded in the Bypass Tray or Tray 1.

Note
 If the envelopes are not loaded right after they are unpacked, they may curl. To avoid jams, press the 

envelopes firmly to flatten them before loading, as shown in the illustration.

 If the envelopes are not fed correctly, curl the edge of the envelopes as shown in the illustration. Curl 
length of 2 to 3 mm is recommended. Area that should be curved is 8 to 10 mm from the edge of the 
envelope. Do not excessively curl or wrinkle the envelope.

Feed direction

2 – 3 mm

8 – 10 mm
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Envelopes with the Flap on the Short Edge
Place the side on which you want to copy or print facing up, open the flap, and load so that the 
bottom edge of the envelope enters the machine first.

When the Flap Is on the Long Edge
 No. 10 Envelope, Monarch Envelope, DL Envelope, C5 Envelope

Place the side on which you want to copy or print facing up, close the flap, and load so that the flap 
faces toward the left side of the machine.

 DL Envelope
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Open the flap, and load the envelope so that its bottom edge enters the machine first.

3.6 Loading a Document
Load documents in the document feeder or on the document glass.

Important
 Load creased, wrinkled, cut-and-pasted, curled or carbon-backed documents on the document glass. 

Loading them into the Document Feeder could cause paper jams.
Documents that can be loaded on the document feeder
 One-sheet document
 Multiple-sheet document
Documents that can be loaded on the Document glass:
 One-sheet document
 Booklet

Loading the Document Feeder
1. Before loading a document, remove the paper clips or staples.

2. Place the side you want to copy or scan (the front side in the case of two-sided document) facing 
up, and load in the center of the document feeder.
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Important
 Remove any sticky tags, paper clips, staples or adhesive tape from the document before loading. These 

items can cause paper to jam or the document feeder to malfunction.
 Do not load documents in amounts exceeding the fill line (marked "MAX"). Doing so could cause a paper 

jam or malfunction.

3. Adjust the document guides according to the document size that you want to load.

Note
 Open the Output Extension Tray to prevent documents from falling off.

Loading a Document on the Document Glass
CAUTION
 When copying booklets or other thick documents, do not press down forcefully on the 

document. This could cause the glass to break, resulting in injury.

Note
 Check to ensure that no documents are loaded in the document feeder. Documents loaded in the 

document feeder will be scanned before documents on the document glass.
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1. Open the document glass cover.

2. Place a document facing down on the document glass and align it to the top left corner of the 
document glass.

3. Close the document glass cover.
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4 Printing
4.1 Printing From a Computer

Note
 The content of print driver settings override settings configured through the operator panel. For details 

about a print driver feature, refer to the print driver help.
The following describes a typical printing procedure.

For Windows
1. Open the file that you want to print.

2. From the [File] menu, select [Print].

Note
 Menu names may differ depending on the application.

3. From [Select Printer], select this machine, and click on [Preferences].

4. Change the settings as needed, then click on [OK].

5. Click on [Print].

For Mac
Note
 When using the AirPrint feature with a USB connection, log in to Internet Services as the Administrator 

and click on [Network] in the upper part of the screen. From [Mobile Printing], select [AirPrint], then 
select the checkbox for [USB Connection]. For details, refer to Internet Services Help.

1. Open the file that you want to print.

2. From the [File] menu, select [Print].

Note
 Menu names may differ depending on the application.

3. From [Printers], select this machine and change the settings as necessary.

4. Click [Print].
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4.2 Canceling a Print Job

Canceling a Job From the Operator Panel
1. At the Home screen, tap  > [Jobs].

2. Select print documents to be canceled.

3. Tap [Cancel].

Canceling a Job From a Computer
1. Double-click on the printer icon in the Windows task bar.

2. Select the document to cancel, and press the <Delete> key.

Note
 If the document to be canceled is not displayed in the window, cancel printing from the operator panel.
 Print jobs can be canceled in the [Jobs] tab of the Internet Services. For details on how to operate, refer 

to Internet Services Help.

4.3 Printing Color Jobs in Black and White
Forcibly prints color jobs in black and white for all users.
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Note
 You can also use the Print Accounting feature to restrict color printing by user. For details, refer to "Using 

Print Accounting" (P.164).

1. At the Home screen, tap  > [Device].

2. Tap [Security Settings].

3. Tap [Auto Color To Mono Print] > [On].

4. Tap [OK].

5. Turn off the machine, and then turn it on again.

6. Perform printing.

Refer
 For details on how to print, refer to "Printing From a Computer" (P.57).

4.4 Using Stored Print (Windows)
Temporarily store the document to be printed in the machine, and begin printing from the operator 
panel. Convenient features include Secure Print, which enables you to assign passcode to documents 
for confidential document management, and Sample Set, which enables you to print multiple sets of 
print jobs.

Note
 The data in the memory is cleared when the machine is turned off.

Secure Print
On the print driver, you can set the user ID and passcode and save printing instruction data in the 
machine. When you want to print, you can then do so by operating the machine.

Send confidential data. Print data.
Enter the password
from the operator
panel.
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Secure Print

Specifying With the Print Driver

1. Open the file that you want to print.

2. From the [File] menu, select [Print].

Note
 Menu names may differ depending on the application.

3. From [Select Printer], select this machine, and click on [Preferences].

4. Under the [Paper/Output] tab, select [Secure Print] from [Job Type].

5. At [Setup], specify [User ID] and [Secure Print Passcode], then click on [OK].

6. Change other settings as needed, and click on [OK].

7. Click on [Print].

Refer
 For details about a print driver feature, see the print driver help.

Printing Secure Print Jobs

1. At the Home screen, tap .

2. Tap  in the upper right part of the screen, and select the folder with the desired user ID.

Note
 Secure Print folders are displayed with .

3. Enter the specified passcode.

4. Select the document you want to print, and then specify the number of printouts.

Note
 Under [Delete after Printing], select [On] to delete the job after printing.

5. Tap [Print].
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Deleting Secure Print Jobs

1. At the Home screen, tap .

2. Tap  in the upper right part of the screen, and select the folder with the desired user ID.

Note
 Secure Print folders are displayed with .

3. Enter the specified passcode.

4. Select documents to delete, and tap.

5. Tap [Delete].

6. Tap [Yes].

Sample Set
When printing multiple copies of a job, the Sample Set feature enables you to store the print data in 
the machine, print one initial copy of the job, then to check the print result before starting to print the 
rest of the copies from the operator panel.

Sample Set

Specifying With the Print Driver

1. Open the file that you want to print.

2. From the [File] menu, select [Print].

Print a single set.

Print the rest of sets.

(2)

(1)
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Note
 Menu names may differ depending on the application.

3. From [Select Printer], select this machine, and click on [Preferences].

4. Under the [Paper/Output] tab, select [Sample Set] from [Job Type].

5. At [Setup], specify [User ID].

6. Change other settings as needed, and click on [OK].

7. Click on [Print].

Note
 Only one copy will be printed, and the document will be stored in the machine.

Refer
 For details about a print driver feature, see the print driver help.

Printing Sample Set Jobs

1. At the Home screen, tap .

2. Tap  in the upper right part of the screen, and select the folder with the desired user ID.

3. Select the document you want to print, and then specify the number of printouts.

4. Tap [Print].
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Deleting Sample Set Jobs

1. At the Home screen, tap .

2. Tap  in the upper right part of the screen, and select the folder with the desired user ID.

3. Select documents to delete, and tap.

4. Tap [Delete].

5. Tap [Yes].

4.5 Printing a File in a USB Flash Drive
You can print files stored in a USB flash drive without using a computer.

Note
 In the following file formats, you can print directly from a USB flash drive:

- PDF
- TIFF
- JPEG

 This feature cannot be used on USB flash drives encrypted by a software.
 When using this feature with [Print Accounting] enabled, it is necessary to enable [Unauthenticated User 

Print]. For details, refer to "[Unauthenticated User Print]" (P.138).
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Printing a File in a USB Flash Drive
1. Insert a USB flash drive into the front USB port of the machine.

2. Tap [PDF/TIFF Print] or [Photo-Image Print (JPEG)].

Note
 You can also display it by tapping [USB] at the Home screen.

3. Select a file to print, and tap [OK].

Note
 For document printing (PDF/TIFF), tap  and you can display a preview of the selected file. For image 

printing (JPEG), you can display previews of some file types in the file selection screen.

4. Scroll the screen to change print settings as needed.

Refer
 For details on document printing (PDF/TIFF) preferences refer to "Configuring the Settings for PDF/TIFF 

Print Feature" (P.65), and for photo-image printing (JPEG) preferences, refer to "Configuring the 
Settings for Photo-Image Print (JPEG) Feature" (P.66).

5. Tap [Start].

6. Make sure that the machine is not accessing the USB flash drive, and then remove the drive from 
the machine.
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Important
 Do not remove a USB flash drive while it is being accessed. This could damage the data in the USB flash 

drive and the drive itself, rendering it unusable.

Configuring the Settings for PDF/TIFF Print Feature

1. Insert a USB flash drive into the front USB port of the machine.

2. Tap [PDF/TIFF Print].

Note
 You can also display it by tapping [USB] at the Home screen.

3. Select a file to print, and tap [OK].

4. Scroll the screen to change print settings as needed.

[Select File]
Display the file list screen.

[Output Color]
Specify whether to print in color or black and white.

[Quantity]
Tap + (plus) or - (minus), or tap the numeric keys to specify the number of printouts.
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[Paper Trays]
Select a paper feed tray.

[2-Sided]
Specify whether to print on both sides of the paper. For two-sided printing, specify whether the 
printouts are bound at the long edge or short edge.

[Layout]
Specify the number of pages to be imposed on one side of print media.

[PDF Password]
Enter the password to open the secured PDF.

[Image Type]
Select the print image quality.

[Collation]
When printing multiple pages multiple times, specify whether to produce the output page by page or 
grouped by batch.

Configuring the Settings for Photo-Image Print (JPEG) Feature

1. Insert a USB flash drive into the front USB port of the machine.

2. Tap [Photo-Image Print (JPEG)].
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Note
 You can also display it by tapping [USB] at the Home screen.

3. Select a file to print, and tap [OK].

4. Scroll the screen to change print settings as needed.

[Select File]
Display the file list screen.

[Output Color]
Specify whether to print in color or black and white.

[Quantity]
Tap + (plus) or - (minus), or tap the numeric keys to specify the number of printouts.

[Layout]
Specify the number of pages to be imposed on one side of print media.

[Paper Trays]
Select a paper feed tray.

[2-Sided]
Specify whether to print on both sides of the paper. For two-sided printing, specify whether the 
printouts are bound at the long edge or short edge.

[Image Type]
Select the print image quality.

[Collation]
When printing multiple pages multiple times, specify whether to produce the output page by page or 
grouped by batch.

4.6 Printing on Envelopes

Printing on Envelopes
1. Load envelopes into Tray 1 or the Bypass Tray.

Refer
 For details on loading envelopes, refer to "Loading Envelopes" (P.52).

2. Open the file that you want to print.

3. From the [File] menu, select [Print].

4. From [Select Printer], select this machine, and click on [Preferences].

5. On the lower part of the [Paper/Output] screen, click on [Envelope/Paper Setup Wizard].
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6. Click on [Envelope]>[Next].

7. Select the envelope size or paper type to be used from [Paper Size] and [Paper Type], then click 
on [Next].

8. Select the tray to be loaded with the envelopes used from [Paper Tray], then click on [Finish].

9. Configure the other print settings as needed.

10. Click on [OK].

11. Click on [Print] to begin printing.
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5 Copying
5.1 Making a Copy

Basic Copying

Using the Document Feeder

1. Load a document.

Refer
 For details on how to load documents, refer to "Loading the Document Feeder" (P.54).

2. At the Home screen, tap [Copy].

3. Scroll the screen to change copy settings as needed.

Refer
 For details on copy settings, refer to "Various Copy Features" (P.70).

4. Tap [Start].

Making Copies From the Document Glass
CAUTION
 When copying booklets or other thick documents, do not press down forcefully on the 

document. This could cause the glass to break, resulting in injury.

Note
 When copying from the document glass, remove documents from the document feeder.

1. Place a document.

Refer
 For details on how to load documents, refer to "Loading a Document on the Document Glass" (P.55).
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2. At the Home screen, tap [Copy].

3. Scroll the screen to change copy settings as needed.

Refer
 For details on copy settings, refer to "Various Copy Features" (P.70).

4. Tap [Start].

Various Copy Features
1. At the Home screen, tap [Copy].

2. Scroll the screen to change copy settings as needed.

[Quantity]
Tap + (plus) or - (minus), or tap the numeric keys to specify the number of copies.
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[Output Color]
Specify whether to copy in color or black and white.

[Lighten/Darken]
Specify the density to make the copy darker or lighter.

[Reduce/Enlarge]
Specify the zoom ratio to enlarge or reduce the copied image.

[Paper Trays]
Select the paper tray.

[2-Sided]
Specify whether to copy on both sides of a sheet of paper.

[2-Up]
Two pages of content will be printed on one sheet. The zoom ratio will be set automatically.

[Sharpness]
Specify the sharpness level to make the image sharper or softer.

[Original Size]
Select the document size to be copied.

Note
 Select [Auto], and the machine will automatically detect and configure for the document size.

[Original Type]
Select the document type. You can make a copy with image quality that is optimal for the document 
type.

[Collation]
When copying multiple pages multiple times, specify whether to produce the output page by page or 
grouped by batch.

[Saturation]
Specify the vividness of color.

[Background Suppression]
Specify whether to suppress the background color of the document (the color of the paper or 
background) when copying.

[Top & Bottom Erase], [Left & Right Erase], [Center Erase]
Specify whether to remove the shadows on the top and bottom, the left and right, or the middle 
when copying a thick document or a booklet.
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5.2 Copying an ID Card

Basic Copy (ID Card)
You can copy both sides of an ID card in actual size on one side of a sheet of paper. And you can copy 
two ID cards at one time.

1. At the Home screen, tap [Copy (ID Card)].

Front Back

ID card ID card orientation
Copy output

· When copying only one ID card

· When copying two ID cards at the same time

Front

ID cards

ID card orientation

Back

Front BackFront Back
First ID card

Front Back
Second ID card

SEF orientation paper

Copy output
SEF orientation paper
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2. Scroll the screen to change Copy (ID Card) settings as needed.

Refer
 For details on copy settings, refer to "Various Copy (ID Card) Features" (P.74).

3. Open the document glass cover.

4. Load ID cards with the side to be copied facing down on the document glass.

Note
 Load ID cards in the position shown in the illustration that appears when you tap [Card Placement].

5. Close the document glass cover.

6. Tap [Start].
After the front of the ID card is scanned, a message is displayed on the operator panel prompting you 
to turn over the card.
To copy the back of the ID card, follow the on-screen instructions on the operator panel.
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Various Copy (ID Card) Features
1. At the Home screen, tap [Copy (ID Card)].

2. Scroll the screen to change Copy (ID Card) settings as needed.

[Card Placement]
The following describes how to position an ID card.

[Quantity]
Tap + (plus) or - (minus), or tap the numeric keys to specify the number of copies.

[Output Color]
Specify whether to copy in color or black and white.

[Lighten/Darken]
Specify the density to make the copy darker or lighter.

[Paper Trays]
Select the paper tray.

[Number of Cards]
Select the number of cards to be copied at the same time.
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[Sharpness]
Specify the sharpness level to make the image sharper or softer.

[Saturation]
Specify the vividness of color.

[Background Suppression]
Specify whether to suppress the background color of the document (the color of the paper or 
background) when copying.
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6 Scanning
6.1 Overview

With this machine, you can scan documents using a variety of methods. These are broadly divided 
into these operated from the machine, and those operated from a computer or mobile device.
The following illustration shows the overview for each scanning type.

6.2 Scanning Using the Operator Panel of 
the Machine

Storing Scanned Data to a Computer

Storing to a Computer Connected by USB (Scan to PC) 
(Windows only)

Note
 It will be necessary to install a scanner driver and [Print & Scan Hub] in the computer. For details on how 

to install the Software, refer to "Installing Software for Windows" (P.25).
 The scanned data will be stored in the [Picture] folder. You can change the data storage destination with 

[Print & Scan Hub].

Operate From the Machine
"Storing to a Computer Connected by USB (Scan to 
PC) (Windows only)" (P.76)
"Storing to a Computer Connected to the Network 
(Scan to WSD)" (P.82)
Operate From a Computer/Mobile Device
"Scanning From a Computer" (P.94)
"Operation from Smartphones or Tablets" (P.108)

Operate From the Machine
"Storing to a Computer or Server With FTP/SMB 
(Scan to Network)" (P.78)
"Scanning ID Cards" (P.91)

Operate From the Machine
"Sending Scanned Data by E-mail" (P.83)

Operate From the Machine
"Saving Scanned Data to USB Memory" (P.88)

Scan

USB

E-mail

FTP Server/
Shared Folder

Computer/
Mobile Device
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1. Load a document.

Refer
 For details on how to load documents, refer to "Loading a Document" (P.54).

2. At the Home screen, tap [Scan to PC].

3. Scroll the screen to change scan settings as needed.

Refer
 For details on settings, refer to "Configuring the Settings for the Scan to PC Feature" (P.77).

4. Tap [Start].

Note
 When the following document-related message is displayed, follow the instructions shown on the screen 

to complete loading the document.

Configuring the Settings for the Scan to PC Feature

1. At the Home screen, tap [Scan to PC].

2. Scroll the screen to change scan settings as needed.

 [File Name]
Specify the file name when saving scanned data.
File names can be specified up to 50 characters, in the following format.
img_YYMMDDHHMMSS.extension

Note
 YYMMDDHHMMSS includes two digits each to indicate the year, month, date, hour, minute and second.
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 In cases where files are formatted one page per file, or file names are duplicated in the destination folder, 
a - (hyphen) and consecutive four-digit number (0001 - 9999) are added after the file name.

 The following characters cannot be used for the file name even though they are displayed on the screen 
keyboard.
\ / : * ? " < > |

 [File Format]
Select the file format to be used when saving scanned data.

 [Output Color]
Select the color mode when scanning a document.

 [Resolution]
Select the scan resolution rate when scanning a document.

 [2-Sided Scanning]
Specify whether one side or both sides of a document are to be scanned.

 [Lighten/Darken]
Specify the density to make the scanned data darker or lighter than the document.

 [Sharpness]
Specify the sharpness level to make the image sharper or softer.

 [Contrast]
Specify image contrast.

 [Background Suppression]
Specify whether to suppress the background color of the document (the color of the paper or 
background) when scanning.

 [Original Size]
Select the document size to be scanned.

 [Top & Bottom Erase] , [Left & Right Erase] , [Center Erase]
Remove the shadows on the top and bottom, the left and right, or the middle when scanning a thick 
document or a booklet.

Storing to a Computer or Server With FTP/SMB (Scan to 
Network)

When using the Scan to Network feature, you can save the scanned data on an FTP server or in a 
shared folder.
To save scanned data, it is necessary to register the server and shared folder address in the Address 
Book. To register the server and shared folder address with [Scan/Fax phonebook tool], install [Scan/
Fax phonebook tool] on your computer.
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Note
 It is necessary to install [Scan/Fax phonebook tool] on your computer. For details on how to install the 

software, refer to "Installing Software for Windows" (P.25).

Storing to an FTP Server

 Registering the FTP Server Address in the Address Book
Register using the Address Book Editor For details, refer to [Scan/Fax phonebook tool] Help.

 Storing Scanned Data to an FTP server

1. Load a document.

Refer
 For details on how to load documents, refer to "Loading a Document" (P.54).

2. At the Home screen, tap [Scan to Network].

3. Tap [Destination].

4. Tap the destination of the scanned document.

5. Scroll the screen to change scan settings as needed.

Refer
 For details on settings, refer to "Configuring the Settings for the Scan to Network Feature" (P.81).

Scan

Computer

Computer

FTP Server

Using SMB

Using FTP
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6. Tap [Start].

Note
 When the following document-related message is displayed, follow the instructions shown on the screen. 

Once the message is displayed, if a specific interval elapses with no operations performed, the document 
will be sent automatically, and the display will return to the scanner transmission screen. The interval 
before the document is sent can be changed with [Auto Clear].

Storing to a Shared Folder Using SMB

 Creating Shared Folders on a PC
Create a shared folder to store the scanned data from the machine.

Note
 You can also create shared folders using the Address Book Editor. For details, refer to [Scan/Fax 

phonebook tool] Help.
Once shared folder creation is complete, register the destination in the Address Book using [Scan/
Fax phonebook tool]. For details, refer to [Scan/Fax phonebook tool] Help.

 Storing Scanned Data

1. Load a document.

Refer
 For details on how to load documents, refer to "Loading a Document" (P.54).

2. At the Home screen, tap [Scan to Network].

3. Tap [Destination].

4. Tap the destination of the scanned document.

5. Scroll the screen to change scan settings as needed.

Refer
 For details on settings, refer to "Configuring the Settings for the Scan to Network Feature" (P.81).

6. Tap [Start].

Note
 When the following document-related message is displayed, follow the instructions shown on the screen. 

Once the message is displayed, if a specific interval elapses with no operations performed, the document 
will be sent automatically, and the display will return to the scanner transmission screen. The interval 
before the document is sent can be changed with [Auto Clear].
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Configuring the Settings for the Scan to Network Feature

1. At the Home screen, tap [Scan to Network].

2. Scroll the screen to change scan settings as needed.

 [Destination]
Specify storage destinations from registered servers.

 [File Name]
Specify the file name when saving scanned data.
File names can be specified up to 50 characters, in the following format.
img_YYMMDDHHMMSS.extension

Note
 YYMMDDHHMMSS includes two digits each to indicate the year, month, date, hour, minute and second.
 In cases where files are formatted one page per file, or destination file names are duplicates, a - (hyphen) 

and consecutive four-digit number (0001 - 9999) are added after the file name.
 The following characters cannot be used for the file name even though they are displayed on the screen 

keyboard.
\ / : * ? " < > |

 [File Format]
Select the file format to be used when saving scanned data.

Note
 You can set passwords for encryption when saving to PDF.

 [Preview]
Specify whether to display the preview of the scanned data before storing.

 [Output Color]
Select the color mode when scanning a document.

 [Resolution]
Select the scan resolution rate when scanning a document.

 [2-Sided Scanning]
Specify whether one side or both sides of a document are to be scanned.

 [Lighten/Darken]
Specify the density to make the scanned data darker or lighter.

 [Sharpness]
Specify the sharpness level to make the image sharper or softer.
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 [Contrast]
Specify image contrast.

 [Background Suppression]
Specify whether to suppress the background color of the document (the color of the paper or 
background) when scanning.

 [Original Size]
Select the document size to be scanned.

 [Add Folder]
Specify whether to create a new folder to which the scanned data is stored.

 [Top & Bottom Erase], [Left & Right Erase], [Center Erase]
Specify whether to remove the shadows on the top and bottom, the left and right, or the middle 
when scanning a thick document or a booklet.

 [Next Orig on Doc Glass]
Specifies whether to show a confirmation screen regarding the next document after a document has 
been placed on the document glass and scanned.

Storing to a Computer Connected to the Network (Scan to WSD)
If the machine is connected to a computer via network using Web Services on Devices (WSD), you 
can send scanned data to a computer.

Setting Up Web Services on Devices (WSD)

 Checking the Machine Settings
To scan using the Scan to WSD feature, it is necessary to enable the machine's [WSD Scan Profile] 
feature.

1. At the Home screen, tap  > [Device].

2. Tap [Network Settings] > [Protocol].

3. Make sure that [WSD Scan Profile] is displayed in [Enable].

 Setting the Computer

1. Click on the Start button, then [Settings].

2. Click on [Devices].
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3. Click on [Printers & scanners]>[Add a printer or scanner].

4. Select the machine, and click on [Add device].
The machine is connected to your computer using Web Services on Devices (WSD).

Note
 You can specify the operation to be performed when the scanned data is received by the computer. On 

your computer, open [Scan properties] for the machine. Under the [Event] tab, use [Action] to configure 
settings for operations when receiving. For details, refer to your computer's Help utility.

 Storing Scanned Data to a Computer

1. Load a document.

Refer
 For details on how to load documents, refer to "Loading a Document" (P.54).

2. At the Home screen, tap [WSD Scan Profile].

3. Tap [Destination].

4. Tap the name of the computer that you want to send the scanned data to.

5. Tap [Event] to select an operation to be executed after the scan.

6. Tap [Start].

7. In the screen displayed on the computer that the scanned data is sent to, select the application to 
receive the scanned data, and scanning starts with the selected application.

Note
 Depending on the settings of your computer, actions or the application that your computer takes may 

differ.

Sending Scanned Data by E-mail

Registering the DNS Server Address in the Machine

1. Enter IP address of the machine in the web browser and start Internet Services.

Note
 To check the machine's IP address, press the  (Home) button on the operator panel, and tap  > 

[Device] > [About].
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2. Click on [Log In] in the upper right part of the screen.

3. Enter the [User Name] and [Password] for the administrator, and click on [Log In].

Refer
 For details on the default user name and password, refer to "Logging in" (P.152).

4. Click on [Network] in the upper part of the screen.

5. Click on [Ethernet].

6. Click on [Edit] for [DNS], then perform one of the following operations.

When Acquiring the DNS Server Address Automatically:
Depending on the network environment you are using, select the checkbox for either [IPv4 DNS 
Servers] > [Use DHCP to Assign Address] or [IPv6 DNS Servers] > [Use DHCPv6-lite to Assign 
Address].

When Acquiring the DNS Server Address Manually:
Depending on the network environment you are using, deselect the checkbox for [IPv4 DNS Servers] 
> [Use DHCP to Assign Address] and enter a [Server Address], or deselect the checkbox for [IPv6 
DNS Servers] > [Use DHCPv6-lite to Assign Address] and enter a [Server Address].

7. Click on [OK].

8. Click on [Restart Now].

9. Once the machine completes restart, click on [Refresh].

Registering the Mail Server Settings in the Machine

1. Enter IP address of the machine in the web browser and start Internet Services.

Note
 To check the machine's IP address, press the  (Home) button on the operator panel, and tap  > 

[Device] > [About].
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2. Click on [Log In] in the upper right part of the screen.

3. Enter the [User Name] and [Password] for the administrator, and click on [Log In].

Refer
 For details on the default user name and password, refer to "Logging in" (P.152).

4. Click on [Network] in the upper part of the screen.

5. Click on [Protocols]>[POP3].

6. Configure the server settings, and click on [OK].

Refer
 For details on how to configure settings, refer to Internet Services Help.

7. Click on [Restart Now].

8. Once the machine completes restart, click on [Refresh].

9. Click on [Protocols]>[SMTP].

10. Configure the server settings, and click on [OK].

Refer
 For details on how to configure settings, refer to Internet Services Help.

11. Click on [Restart Now].

12. Once the machine completes restart, click on [Refresh].

Note
 When sending e-mail through SSL/TLS communication, configure the machine's SSL/TLS communication 

settings. For details, refer to "Using the Encryption Feature" (P.178).
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Sending Scanned Data

1. Load a document.

Refer
 For details on how to load documents, refer to "Loading a Document" (P.54).

2. At the Home screen, tap [Email].

3. Enter the e-mail address for the recipient.

Note
 You can also specify an e-mail address using the Address Book or LDAP server. For details, refer to "Using 

the Address Book" (P.157).

4. Tap [OK] to change the scan settings as needed.

Refer
 For details on settings, refer to "Configuring the Settings for the Scan to Email Feature" (P.86).

5. Tap [Start].

Note
 When the following document-related message is displayed, follow the instructions shown on the screen. 

Once the message is displayed, if a specific interval elapses with no operations performed, the document 
will be sent automatically, and the display will return to the scanner transmission screen. The interval 
before the document is sent can be changed with [Auto Clear].

Configuring the Settings for the Scan to Email Feature

1. At the Home screen, tap [Email].
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2. Scroll the screen to change settings for the Scan to Email feature as needed.

[Contact]
Enter the e-mail address for the recipient.

[File Name]
Specify the file name when saving scanned data.
File names can be specified up to 50 characters, in the following format.
img_YYMMDDHHMMSS.extension

Note
 YYMMDDHHMMSS includes two digits each to indicate the year, month, date, hour, minute and second.
 - (hyphen) and consecutive four-digit number (0001 - 9999) are added after the file name.
 The following characters cannot be used for the file name even though they are displayed on the screen 

keyboard.
\ / : * ? " < > |

[File Format]
Select the file format to be used when saving scanned data.

Note
 You can set passwords for encryption when saving to PDF.

[Preview]
Specify whether to display the preview of the scanned data before storing.

[Output Color]
Select the color mode when scanning a document.

[Resolution]
Select the scan resolution rate when scanning a document.

[2-Sided Scanning]
Specify whether one side or both sides of a document are to be scanned.

[Lighten/Darken]
Specify the density to make the scanned data darker or lighter.

[Sharpness]
Specify the sharpness level to make the image sharper or softer.

[Contrast]
Specify image contrast.

[Background Suppression]
Specify whether to suppress the background color of the document (the color of the paper or 
background) when scanning.

[Original Size]
Select the document size to be scanned.
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[Top & Bottom Erase], [Left & Right Erase], [Center Erase]
Specify whether to remove the shadows on the top and bottom, the left and right, or the middle 
when scanning a thick document or a booklet.

[From]
Specify the e-mail address for the sender.

[Next Orig on Doc Glass]
Specifies whether to show a confirmation screen regarding the next document after a document has 
been placed on the document glass and scanned.

Saving Scanned Data to USB Memory
The Scan to USB feature allows you to store scanned data directly to a USB flash drive attached to 
the machine.

1. Load a document.

Refer
 For details on how to load documents, refer to "Loading a Document" (P.54).

2. Insert a USB flash drive into the front USB port of the machine.

3. Tap [Scan to USB].

Note
 You can also display it by tapping [USB] at the Home screen.
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4. Tap [Destination] to select a folder in which to store scanned data.

5. Tap [OK].

6. Tap [File Format], and select the file format to be used when saving scanned data.

7. Tap .

8. Scroll the screen to change scan settings as needed.

Refer
 For details on settings, refer to "Configuring the Settings for the Scan to USB Feature" (P.89).

9. Tap [Start].

Important
 Do not remove a USB flash drive while it is being accessed. This could damage the data in the USB flash 

drive and the drive itself, rendering it unusable.

Note
 When the following document-related message is displayed, follow the instructions shown on the screen. 

Once the message is displayed, if a specific interval elapses with no operations performed, the document 
will be sent automatically, and the display will return to the scanner transmission screen. The interval 
before the document is sent can be changed with [Auto Clear].

10. Make sure that the machine is not accessing the USB flash drive, and then remove the drive from 
the machine.

Note
 When the following document-related message is displayed, follow the instructions shown on the screen 

to complete loading the of the document.

Check a preview of scanned data
Check the scanned image before saving. Enable [Preview], and a preview screen will appear after the 
document is scanned.

Configuring the Settings for the Scan to USB Feature

1. Insert a USB flash drive into the front USB port of the machine.



90 6   Scanning

2. Tap [Scan to USB].

3. Scroll the screen to change settings for the Scan to USB feature as needed.

[Destination]
Specify the folder (USB memory) in which to save the scanned data.

[File Name]
Specify the file name when saving scanned data.
File names can be specified up to 50 characters, in the following format.
img_YYMMDDHHMMSS.extension

Note
 YYMMDDHHMMSS includes two digits each to indicate the year, month, date, hour, minute and second.
 In cases where files are formatted one page per file, or destination file names are duplicates, a - (hyphen) 

and consecutive four-digit number (0001 - 9999) are added after the file name.
 The following characters cannot be used for the file name even though they are displayed on the screen 

keyboard.
\ / : * ? " < > |

[File Format]
Select the file format to be used when saving scanned data.

Note
 You can set passwords for encryption when saving to PDF.

[Preview]
Specify whether to display the preview of the scanned data before storing.

[Output Color]
Select the color mode when scanning a document.

[Resolution]
Select the scan resolution rate when scanning a document.

[2-Sided Scanning]
Specify whether one side or both sides of a document are to be scanned.

[Lighten/Darken]
Specify the density to make the scanned data darker or lighter.
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[Sharpness]
Specify the sharpness level to make the image sharper or softer.

[Contrast]
Specify image contrast.

[Background Suppression]
Specify whether to suppress the background color of the document (the color of the paper or 
background) when scanning.

[Original Size]
Select the document size to be scanned.

[Add Folder]
Specify whether to create a new folder to which the scanned data is stored.

[Top & Bottom Erase], [Left & Right Erase], [Center Erase]
Specify whether to remove the shadows on the top and bottom, the left and right, or the middle 
when scanning a thick document or a booklet.

[Next Orig on Doc Glass]
Specifies whether to show a confirmation screen regarding the next document after a document has 
been placed on the document glass and scanned.

6.3 Scanning ID Cards

Basic ID Card Scanning
You can save the data for both scanned sides of an ID card in shared computer folders and on an FTP 
server.

Note
 It is necessary to specify the server addresses in advance. For details, refer to [Scan/Fax phonebook tool] 

Help.

Front Back

ID card ID card orientation
Scanned data

Front Back
SEF orientation
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1. At the Home screen, tap [ID Card Scan].

2. Tap [Destination].

3. Select the network address of the storage destination.

Note
 You can select addresses registered beforehand in [Scan/Fax phonebook tool].

4. Scroll the screen to change ID Card scan settings as needed.

Refer
 For details on scan settings, refer to "Various ID Card Scanning Features" (P.93).

5. Open the document glass cover.

6. Load ID cards with the side to be scanned facing down on the document glass.

Note
 Load ID cards in the position shown in the illustration that appears when you tap [Card Placement].

7. Close the document glass cover.

8. Tap [Start].
After the front of the ID card is scanned, a message is displayed on the operator panel prompting you 
to turn over the card.
To scan the back of the ID card, follow the on-screen instructions on the operator panel.
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Various ID Card Scanning Features
1. At the Home screen, tap [ID Card Scan].

2. Scroll the screen to change ID Card scan settings as needed.

[Card Placement]
The following describes how to position an ID card.

[Destination]
Specify storage destinations from registered servers.

[File Name]
Specify the file name when saving scanned data.
File names can be specified up to 50 characters, in the following format.
img_YYMMDDHHMMSS.extension

Note
 YYMMDDHHMMSS includes two digits each to indicate the year, month, date, hour, minute and second.
 - (hyphen) and consecutive four-digit number (0001 - 9999) are added after the file name.
 The following characters cannot be used for the file name even though they are displayed on the screen 

keyboard.
\ / : * ? " < > |

[File Format]
Select the file format to be used when saving scanned data.
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Note
 You can set passwords for encryption when saving to PDF.

[Output Color]
Select the color mode when scanning a document.

[Resolution]
Select the scan resolution rate when scanning a document.

[Output Size]
Specify output size.

[Lighten/Darken]
Specify the density to make the scanned data darker or lighter.

[Sharpness]
Specify the sharpness level to make the image sharper or softer.

[Contrast]
Specify image contrast.

[Background Suppression]
Specify whether to suppress the background color of the document (the color of the paper or 
background) when scanning.

[Add Folder]
Specify whether to create a new folder to which the scanned data is stored.

6.4 Scanning From a Computer
Important
 When you scan a document from your computer, pay close attention when you move away from the 

machine to operate your computer with the document loaded in the machine. If another user operates 
the machine by mistake with your document loaded in the machine, this may cause a loss of the 
document or an information leakage. Operate your computer as close to the machine as possible. Also, 
check that you have all the pages of your document in hand after you finish scanning.

For Windows

Scanning With the Print & Scan Hub
You can use the machine's [Print & Scan Hub] software to scan a document.

Refer
 It will be necessary to install a scanner driver and [Print & Scan Hub] in the computer. For details on how 

to install the Software, refer to "Installing Software for Windows" (P.25).
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1. Load a document.

Refer
 For details on how to load documents, refer to "Loading a Document" (P.54).

2. Click on [Start] > [FUJIFILM Print & Scan Hub] > [Print & Scan Hub] on the computer.

3. Select [Device List] from the machine.

4. Click on [Scan].

5. Specify with [Scan Settings] as necessary.

6. Click [Scan] to scan.

7. Edit scanned data as necessary using [Edit].
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8. When saving scanned data, use [Save Settings] to specify the file format, filename and the 
location in which to store it.

9. Click on [Save].

Scanning Using Web Services on Devices (WSD)
If the machine is connected to a computer via network using Web Services on Devices (WSD), you 
can scan documents from a computer.

Setting Up Web Services on Devices (WSD)

 Checking the Machine Settings
To scan using the Scan to WSD feature, it is necessary to enable the machine's [WSD Scan Profile] 
feature.

1. At the Home screen, tap  > [Device].

2. Tap [Network Settings] > [Protocol].

3. Check to ensure that [WSD Scan Profile] is set to [Enable].

 Setting the Computer

1. Click on the Start button, then [Settings].

2. Click on [Devices].

3. Click on [Printers & scanners]>[Add a printer or scanner].

4. Select the machine, and click on [Add device].
The machine is connected to your computer using Web Services on Devices (WSD).

Scanning From a Computer
You can use the machine's [Print & Scan Hub] software or Windows FAX and Scan to scan a 
document.
This description uses the procedure for Windows FAX and Scan as an example.

1. Load a document.

Refer
 For details on how to load documents, refer to "Loading a Document" (P.54).
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2. On your computer, start Windows FAX and Scan.

3. Click on [New Scan].

4. When the scanner selection screen appears, select the machine, and click on [OK].

5. In [Source], specify whether you will scan a document loaded on the document glass, or one 
loaded in the document feeder.

6. Configure the other scan settings as needed.

7. Click on [Scan].

Scanning with the Windows Image Acquisition (WIA) Driver
You can use the machine's [Print & Scan Hub] software or Windows FAX and Scan to scan a 
document.
This description uses the procedure for Windows FAX and Scan as an example.

Note
 It will be necessary to install a scanner driver in the computer. For details on how to install the driver, 

refer to "Installing Software for Windows" (P.25).

1. Load a document.

Refer
 For details on how to load documents, refer to "Loading a Document" (P.54).

2. On your computer, start Windows FAX and Scan.

3. Click on [New Scan].

4. When the scanner selection screen appears, select the machine, and click on [OK].

5. In [Source], specify whether you will scan a document loaded on the document glass, or one 
loaded in the document feeder.

6. Configure the other scan settings as needed.

7. Click on [Scan].

Scanning with a TWAIN Driver
You can scan with TWAIN-compatible applications.

Note
 It will be necessary to install a scanner driver in the computer. For details on how to install the driver, 

refer to "Installing Software for Windows" (P.25).
The following procedure uses typical program that supports TWAIN as an example.

1. Load a document.

Refer
 For details on how to load documents, refer to "Loading a Document" (P.54).

2. Start TWAIN-compatible imaging software on your computer.
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3. Select the machine from the TWAIN menu on the graphic program, specify the necessary 
settings, and then start scanning.

For Mac
You can scan documents using Image Capture, a standard program for Mac.

Note
 When scanning with a Mac, log in to Internet Services as the Administrator and click on [Network] in the 

upper part of the screen. From [Mobile Printing], select [AirPrint], then make sure that the checkbox for 
[Enable] is selected. When the machine and a Mac are connected via USB, select the checkbox for 
[AirPrint]>[USB Connection]. For details, refer to Internet Services Help.

1. Load a document.

Refer
 For details on how to load documents, refer to "Loading a Document" (P.54).

2. On the computer, click [Applications] > [Image Capture] in the [Go] menu.

3. Select the machine name under [Devices] or [Shared] on the lefthand side of the screen.

Note
 If the machine name is not displayed, position the mouse pointer to the right of [Devices] or [Shared], 

and then click on [Show Details].

4. Configure the scan settings as needed.

5. Click on [Scan].

Refer
 For details about how to use Image Capture, see the Image Capture help.
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7 Fax
7.1 Sending/Receiving a Fax

Sending a Fax
Note
 Before using the fax feature, specify a country code from [Device] > [General] > [Fax Settings] > 

[Country/Region]. After configuring the settings, restart the machine.
 When sending a fax, confirm the address before transmitting.

Basic Faxing

1. Load a document.

Refer
 For details on how to load documents, refer to "Loading a Document" (P.54).

2. At the Home screen, tap [Fax].

3. Enter the recipient fax number and tap [OK].

Note
 Tap  to display the most recently dialed fax number.
 You can also specify a fax number using the Address Book or LDAP server. For details, refer to "Using the 

Address Book" (P.157).

4. Scroll the screen to change fax settings as needed.

Refer
 For details on settings, refer to "Configuring the Detailed Settings" (P.104).

5. Tap [Start].

Note
 When the following document-related message is displayed, follow the instructions shown on the screen. 

Once the message is displayed, if a specific interval elapses with no operations performed, the document 
will be sent automatically, and the display will return to the fax screen. The interval before the document 
is sent can be changed with [Auto Clear].
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Sending a Fax Using On-Hook Dialing

1. Load a document.

Refer
 For details on how to load documents, refer to "Loading a Document" (P.54).

2. At the Home screen, tap [Fax].

3. Enter the recipient fax number and tap .

Note
 Tap , scroll the screen, and you can change fax settings as needed.
 You can also specify a fax number using the Address Book or LDAP server. For details, refer to "Using the 

Address Book" (P.157).

4. When the on-hook screen appears, tap [OK] to make a phone call. When the recipient answers, 
tap [Send].

Refer
 For details on settings, refer to "Configuring the Detailed Settings" (P.104).

Note
 When you send a fax using on-hook dialing, you cannot use the automatic redial function.

Receiving a Fax
Note
 When a faxes are received during copying or printing, or while paper or toner have run out, the incoming 

faxes will be temporarily saved to the memory. Once copying or printing is completed, or consumables 
have been replenished, faxes will be automatically printed from the memory, then cleared from the 
memory once printing is completed. When the memory is full, faxes cannot be received.

Receiving a Fax Automatically
To receive faxes automatically, set the fax receiving mode to [FAX Mode], [TEL/FAX Mode] or [Ans/
FAX Mode]. [FAX Mode] is the factory default settings.

Refer
 For details about fax receiving mode, refer to "[Receive Mode]" (P.123).

Note
 To use [TEL/FAX Mode] or [Ans/FAX Mode], connect an external telephone or answering machine to the 

 TEL port on the rear of the machine.
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Receiving a Fax Manually
To receive faxes through an external telephone or by operating the touch panel display, set the fax 
receiving mode to [TEL Mode].

Refer
 For details about fax receiving mode, refer to "[Receive Mode]" (P.123).

Note
 To use [TEL Mode], connect an external telephone to the  TEL port on the rear of the machine.

Using Remote Receive
If an external telephone is connected to the machine, the remote receive feature enables you to 
receive a fax by operating the external telephone.

Note
 To use this feature, it is necessary to set [Remote Receive] to [On], and to register a two-digit code on 

the displayed screen. For details, refer to "[Remote Receive]" (P.125).
 Set the dialing system of your external telephone to DTMF.

1. When the external telephone rings, pick up the handset.

2. Make sure that you hear the fax tone, and then enter the remote receive code with the telephone.

Note
 When entering the remote receive code, press the number keys slowly in sequence. If you still hear the 

fax tone from the remote machine, try entering the two-digit code again.

3. Hang up the handset.

Using Off-Hook Dialing

1. When the external telephone rings, pick up the handset.

2. When you hear the fax tone, press the  (Home) button.

3. Tap [Fax].

4. Tap [Receive].

5. Hang up the handset.
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Using the Secure Receiving Mode
You can configure the machine settings so that the received faxes cannot be browsed by other 
persons. In the secure receiving mode, incoming faxes are not printed immediately, and are stored in 
the machine's memory. You can print saved faxes by entering a preset passcode.

Configuring the Secure Receiving Mode Settings

1. At the Home screen, tap  > [Device].

2. Tap [Security Settings] > [Admin Authentication].

3. Tap [On].

4. Specify a four-digit Admin Authentication passcode and tap [OK].

5. Enter the specified passcode again and tap [OK]> .

6. Tap [Secure Fax Receive].

7. Tap [On].

8. Specify a four-digit passcode for Secure Fax Receive and tap [OK].
Faxes received in secure receiving mode are saved to the memory. On the [Jobs] screen,  is 
displayed, indicating that a fax has been saved to the memory.

Printing Received Faxes

1. At the Home screen, tap  > [Jobs].

2. Tap  in the upper right part of the screen.
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3. Specify a four-digit passcode for Secure Fax Receive and tap [OK].

Polling Receive
You can operate the machine to receive faxes stored in a remote machine according to the desired 
timing.

1. At the Home screen, tap [Fax].

2. Enter the recipient fax number and tap [OK].

3. Tap [Polling Receive].

4. Tap [On].

5. Tap [Start].

Various Fax Features
1. At the Home screen, tap [Fax].

[Enter Fax Number]

Select a fax number from the address book.

Recalls the last dialed fax number.
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Adds a pause symbol "-" to the fax number.

Press and hold , to add the dial tone detection symbol [=] to a fax number. When the dial tone 
detection symbol [=] is added, the machine will begin sending after a dial tone is heard.

Specify on-hook dialing to send or receive faxes manually.

Configuring the Detailed Settings

1. Tap .

2. Scroll the screen to change fax settings as needed.

[Add Chain Dial]
You can add addresses.

Note
 Displayed when [Device]>[General]>[Fax Settings]>[Add Chain Dial] is set to [Yes].

[Preview]
Specify whether to display the preview of the scanned data before sending.

[Lighten/Darken]
Specify the density to make the outgoing fax darker or lighter.

[2-Sided Scanning]
Specify whether one side or both sides of a document are to be scanned.

[Resolution]
Select the image quality when scanning a document.

[Cover Sheet]
Specify whether to attach a cover sheet to faxes when sending.

[Polling Receive]
Operate the machine to receive faxes stored in a remote machine.

[Delay Send]
Send faxes at specified times. Select [On] to specify the time at which a fax will be sent.

[Next Orig on Doc Glass]
Specifies whether to show a confirmation screen regarding the next document after a document has 
been placed on the document glass and scanned.
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[Check G3 ID and Send]
When set to [On], the machine first receives the connection G3ID, and transmits the fax only if the 
authentication numbers match.

7.2 Sending a Fax From a Computer(Direct 
Fax)

When you install the Printer Control Language (PCL) driver or fax driver, you can send a document 
created on a program by fax directly from your computer, in the same way as you print the 
document. This feature is called "Direct Fax."

Note
 Only black and white faxes can be sent using Direct Fax.
 The names of the dialog boxes and the buttons may be different from those given in the following 

procedure depending on the program you are using.

For Windows
You can send a fax from a computer using the PCL driver.

Refer
 For details on how to install the driver, refer to "Installing Software for Windows" (P.25).

1. Open the file that you want to fax.

2. From the [File] menu, select [Print].

PCL/fax driver Sending machine
(this printer)

Receiving machine
(fax machine/
multifunction printer)

Send data Send fax
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3. Select the machine, and click on [Preferences].

4. Under the [Paper/Output] tab, select [Fax] from [Job Type].

5. Select the [Fax] tab.

6. Specify the fax transmission settings.

Refer
 For details about the settings, see the help of the PCL or fax driver.

7. Click on [OK], close the [Printing Preferences] dialog box, and click on [Print].

8. Specify the destination.

Refer
 For details about how to specify the destination, see the help of the PCL or fax driver.

9. Click on [Start Sending].

For Mac
You can send faxes from a computer using the AirPrint feature.

Note
 When sending fax with a Mac, log in to Internet Services as the Administrator and click on [Network] in 

the upper part of the screen. From [Mobile Printing], select [AirPrint], then make sure that the checkbox 
for [Enable] is selected. When the machine and a Mac are connected via USB, select the checkbox for 
[AirPrint]>[USB Connection]. For details, refer to Internet Services Help.

1. From the [Apple] menu, open [System Preferences], and click on [Printers & Scanners].

2. When the machine and a Mac are connected via WiFi or Ethernet, click on [+].
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When the machine and a Mac are connected via USB, make sure the machine appears in the [Fax] 
display, and proceed to step 5.

3. Select the machine, and from [Use], select [AirPrint].

4. Click on [Add].

5. Open the file that you want to fax.

6. From the [File] menu, select [Print].

Note
 The names of the dialog boxes and the buttons may be different from those given in the following 

procedure depending on the program you are using.

7. Select the machine from [Printers], then enter the fax number for the recipient under [To].

8. Click on [Fax].
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8 Operation from 
Smartphones or Tablets

8.1 Connecting the Machine to 
Smartphones/Tablets

You can connect a smartphone, tablet or other mobile device for easy, quick printing or scanning of 
documents, photos, etc.
Use any of the following methods to connect the machine to a mobile device.
 Via Wireless Network

Connect the machine and the mobile device using an access point or wireless router.

 Via Wi-Fi Direct
Connect the machine and the mobile device directly without using an access point or wireless 
router.

Via Wireless Network

Setting Up the Machine

1. Make sure that the machine is connected to the wireless network.

Refer
 For details on connection methods, refer to "Connecting to a Wireless Network" (P.18).

Setting Up the Mobile Devices
Note
 The procedure varies depending on the model of the mobile device. For details, see the manual supplied 

with the mobile device.

1. Enable the Wi-Fi function of the mobile device.

2. Select the network (SSID) that the machine is connected to.

3. Enter the passphrase, and then establish the wireless connection.
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Note
 A passphrase may be printed on the exterior of an access point or wireless router. For details, see the 

manual supplied with the access point or wireless router.

Via Wi-Fi Direct
Note
 You can connect up to three mobile devices.

Setting Up Wi-Fi Direct
To use Wi-Fi Direct, you need to first configure the Wi-Fi Direct settings from the operator panel of 
the machine. When you select the SSID of the machine on the display of the mobile device and then 
enter the specified passphrase, the mobile device will be connected to the machine via Wi-Fi Direct.

Setting Up the Machine
Note
 You can also use Internet Services to configure the settings. For details, refer to Internet Services Help.
 Wi-Fi Direct cannot be used in an IPv6 or Ad-hoc environment.

1. At the Home screen, tap  > [Device].

2. Tap [Network Settings] > [Wi-Fi Direct].

3. Tap [Enable]>[OK] for [Wi-Fi Direct].

4. Turn off the machine, and then turn it on again.

5. After restarting the machine, tap >[Device]>[Network Settings]>[Wi-Fi Direct].

6. Tap [Paired Device].

7. Confirm that no more than two mobile devices are displayed on the screen, and tap .

Note
 If there are three mobile devices connected, additional connections to the Wi-Fi Direct network will not 

be possible. Disconnect all currently connected mobile devices from the network. For details, refer to 
"Disconnecting the Mobile Device From the Wi-Fi Direct Network" (P.110).

8. Tap [SSID].

9. Change SSID as needed, and tap [OK].
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Note
 When the SSID is changed, the mobile devices shown on the screen in step 7 are disconnected.

10. Tap [Passphrase].

11. Confirm the passphrase, then tap .

Note
 Tap [Print Passphrase], and the passphrase will be printed.

Connecting Mobile Devices to the Machine
Refer
 For details, see the manual supplied with the mobile device.

1. Enable the wireless LAN function of the mobile device.

2. Select the SSID of the machine.

3. Enter the passphrase.

Disconnecting the Mobile Device From the Wi-Fi Direct Network

1. At the Home screen, tap  > [Device].

2. Tap [Network Settings] > [Wi-Fi Direct] > [Paired Device].

Note
 When a mobile device is connected to the machine through Wi-Fi Direct, [Paired Device] will appear.

3. Tap [Disconnect All].

4. Tap [Disconnect Now] or [Disconnect and Reset Passphrase].

5. When an execution confirmation message appears, tap [Yes].

Resetting the Passphrase
Note
 Resetting the passphrase will disconnect the mobile device.
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1. At the Home screen, tap  > [Device].

2. Tap [Network Settings] > [Wi-Fi Direct].

3. Tap [Passphrase].

4. Tap [Reset Passphrase] > [Yes].
Mobile devices are disconnected, and the new passphrase is displayed.

8.2 Using the Print Utility
Print Utility is an application for use with smartphones or tablets. You can use it to print, copy, scan 
and fax from smartphones or tablets. When using a device with the NFC feature, you can start the job 
simply by holding the device over the NFC touch area. You can download it from the App Store or 
Google Play.

8.3 Using Other Print Services

AirPrint
AirPrint is a printing service offered by Apple Inc. Without installing the print drivers or special 
programs, you can print the documents specified on iOS devices such as iPad or iPhone, or on Mac.

Note
 When using this feature with [Print Accounting] enabled, it is necessary to enable [Unauthenticated User 

Print]. For details, refer to "[Unauthenticated User Print]" (P.138).

Enabling the AirPrint Settings

1. Enter IP address of the machine in the web browser and start Internet Services.

Note
 To check the machine's IP address, press the  (Home) button on the operator panel, and tap  > 

[Device] > [About].
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2. Click on [Log In] in the upper right part of the screen.

3. Enter the [User Name] and [Password] for the administrator, and click on [Log In].

Refer
 For details on the default user name and password, refer to "Logging in" (P.152).

4. Click on [Network] in the upper part of the screen.

5. Click on [Mobile Printing]>[AirPrint].

6. Select the checkbox for [Enable].

Note
 When connected via USB, select the [USB Connection] check box for [AirPrint].

7. Click on [OK].

8. Click on [Restart Now].

9. Once the machine completes restart, click on [Refresh].

Printing With AirPrint
The following procedure uses iOS as an example.

1. Open your e-mail, photo, web page, or document that you want to print.

2. Tap the  icon.

3. Tap [Print].

4. Select the machine and set machine options.

5. Tap [Print].
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Mopria Print Service
Mopria Print is a service that enables you to print from printers certified by Mopria via Android (5.0 
and later) smartphones and tablets without any special settings.
Start by downloading the Mopria Print Service app to your Android device from the Google Play 
Store and installing it.
In order to print, connect your mobile device to the same network as the machine or use the Wi-Fi 
Direct functionality to connect your mobile device to the machine.

Note
 When using this feature with [Print Accounting] enabled, it is necessary to enable [Unauthenticated User 

Print]. For details, refer to "[Unauthenticated User Print]" (P.138).

Setting Up Mopria Print Service on the Machine

1. Enter IP address of the machine in the web browser and start Internet Services.

Note
 To check the machine's IP address, press the  (Home) button on the operator panel, and tap  > 

[Device] > [About].

2. Click on [Log In] in the upper right part of the screen.

3. Enter the [User Name] and [Password] for the administrator, and click on [Log In].

Refer
 For details on the default user name and password, refer to "Logging in" (P.152).

4. Click on [Network] in the upper part of the screen.

5. Click on [Mobile Printing]>[Mopria].

6. Click on [Enable]>[OK].
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Printing With Mopria Print Service
Refer
 For details, see https://mopria.org/.

https://mopria.org/
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9 Changing the Machine 
Settings

9.1 Understanding the Machine Settings 
Menus

The following describes the settings displayed when you tap  on the home screen, then tap 
[Device].

1. At the Home screen, tap  > [Device].

2. Scroll the screen to change machine settings as needed.

[Language] You can select the language used on the 
machine.

[About] You can check the information such as the 
machine's model name, IP address, and serial 
number of the machine. When the device has a 
fax feature, the fax number will also be 
displayed.

[Notifications] Notifications from the machine are presented.

[Information Pages] You can print various reports and lists.
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9.2 [Language]
You can select the display language.

9.3 [About]
You can check the information such as model name, IP address, and serial number of the machine.
When the device has a fax feature, the fax number will also be displayed.

9.4 [Notifications]
Notifications from the machine are presented.

9.5 [Information Pages]
You can print the following reports and lists.

[System Settings]
Print a list of information on machine settings and configuration, such as network settings and 
installed optional accessories.

[Trays] You can specify the size and type of paper 
loaded in Tray 1, the Bypass Tray, and Tray 2 
(250-Sheet Feeder) (optional).

[Supplies] You can check the status of consumables.

[Billing Meters] You can check the total number of pages printed 
up to now.

[General] You can configure the general settings for the 
machine, such as date, time, or sound.

[Network Settings] You can configure the network settings.

[App Defaults] You can configure the default settings for the 
copy, fax, and scan functions, and the USB 
Direct Print feature.

[Security Settings] You can configure the security settings, such as 
limiting access to the settings menus or 
functions.

[Maintenance] You can configure the maintenance settings, 
such as for cleaning the transfer unit and 
initializing the memory.

[Advanced Settings] You can customize the settings in accordance 
with the setting environment, or your 
preferences.
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[Panel Settings]
Print the details of the machine's settings.

[PCL Font List]
Print a list of the Printer Control Language (PCL) fonts that can be used with the machine.

[PCL Macro List]
Print information on the downloaded PCL macro.

[PS Font List]
Print a list of the PostScript language compatibility fonts that can be used with the machine.

[PDF Font List]
Prints a sample of the available PDF fonts.

[Job History]
Print a history of the print, copy, scan or fax jobs that have been executed with the machine. This list 
contains the latest 20 jobs.

[Error History]
Print a detailed list of paper jams and fatal errors.

[Printer Meter]
Print a report on the total number of pages printed.

[Demo Page]
Prints a sample stored in the machine.

[Protocol Monitor]
Print the latest fax protocol information.

[Address Book]
Print a list of all addresses registered in the address book.

[Server Address]
Print a list of server addresses registered in the address book.



118 9   Changing the Machine Settings

[Fax Activity]
Print a history of faxes sent and received.

[Fax Pending List]
Print a list of all pending fax jobs.

[Stored Document List]
Print a list of print jobs saved using the Sample Set feature.

[Supplies Status Report]
Print the status of consumables usage.

9.6 [Trays]
Specify the size and type of paper loaded in Tray 1, the Bypass Tray, and Tray 2 (250-Sheet Feeder) 
(optional).
 "[Bypass]" (P.118)
 "[Tray 1]" (P.119)
 "[Tray 2]" (P.119)

Refer
 For sizes and types of print media that can be used, refer to "Feed Performance for Each Tray" (P.44).

[Bypass]
Specify the size and type of paper loaded in the Bypass Tray.

[Prioritize Driver Setting]
Specify whether to use the paper size and type specified on the print driver.

Note
 When specifying the paper size and paper type, select [Off].

[Paper Size]
Select the paper size.
When using nonstandard paper sizes, select [Custom Paper Size], and specify the paper length and 
width.

Refer
 For paper that can be used, refer to "Feed Performance for Each Tray" (P.44).

[Paper Type]
Select the paper type.
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[Display Tray Prompt]
Specify whether to display a screen for defining the paper size and type when paper is loaded in the 
Bypass Tray.

[Tray Priority]
Specify an order of priority in which the paper trays are to be used. If two or more paper trays are 
loaded with the same paper size and type, the paper tray to be used is automatically selected 
according to this priority order.

[Tray 1]
Specify the size or type of paper loaded in Tray 1.

[Paper Size]
Select the paper size.

[Paper Type]
Select the paper type.

[Display Tray Prompt]
Specify whether to display a screen for specifying the paper size and paper type when paper is 
loaded in Tray 1.

[Tray Priority]
Specify an order of priority in which the paper trays are to be used. If two or more paper trays are 
loaded with the same paper size and type, the paper tray to be used is automatically selected 
according to this priority order.

[Tray 2]
Note
 When Tray 2 (250-Sheet Feeder) (optional) is installed, it can be used.

Specify the size and type of paper loaded in Tray 2 (250-Sheet Feeder) (optional).

[Paper Size]
Select the paper size.

[Paper Type]
Select the paper type.

[Display Tray Prompt]
Specify whether to display a screen for specifying the paper size and paper type when paper is 
loaded in Tray 2 (250-Sheet Feeder) (optional).
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[Tray Priority]
Set the priority order of the paper trays to be used. If paper trays loaded with the same paper size 
and type exist, the paper tray is automatically selected according to this priority order.

9.7 [Supplies]
You can check the status of consumables usage.

9.8 [Billing Meters]
You can check the total number of pages printed up to now.

[Meter 1]
Displays the total number of color printouts.

[Meter 2]
Displays the total number of monochrome printouts.

[Meter 3]
Always shows "0" on your printer.

[Meter 4]
Displays the total number of color and monochrome prints ([Meter 1]+ [Meter 2]).

9.9 [General]
You can configure the general settings for the machine, such as date, time, or sound.
 "[Date & Time]" (P.121)
 "[Display Brightness]" (P.121)
 "[Sounds]" (P.121)
 "[NFC]" (P.121)
 "[Status LED(Green)]" (P.121)
 "[Power Saver]" (P.121)
 "[Timers]" (P.121)
 "[Units]" (P.121)
 "[Default Paper Size]" (P.122)
 "[Operation for Start Button]" (P.122)
 "[Default View of Home]" (P.122)
 "[Fax Settings]" (P.122)
 "[Email Settings]" (P.126)
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[Date & Time]
Set the date, time, and time zone.

[Display Brightness]
Specify the screen brightness of the touch panel.

[Sounds]
Select the volume level of the notification sounds.

[NFC]
Specify whether to allow a mobile device such as a tablet or a smartphone to connect to the machine 
via NFC communication.

[Status LED(Green)]
Specify whether to enable the blinking feature of the Status LED on the operator panel.

Refer
 For details on status LEDs, refer to "Operator Panel" (P.12).

[Power Saver]
Set the amount of time until the machine enters Power Saver Mode.

Refer
 For details on power saving features, refer to "Power Saver Mode" (P.42).

[Timers]
Configure the timer settings.

[Auto Clear]
Select the amount of time until the machine returns to the [Home] screen when the machine is not 
operated for a certain period of time.

Note
 This setting is also used when scanning the document loaded on the document glass, as the time from the 

printer displays confirmation on the next document until the document is automatically sent.

[Fault Timeout]
Specify the amount of time the machine waits before returning from the error screen to the Home 
screen when an error not requiring users' operation is displayed.

[Units]
Select the default measurement unit of the numeric value displayed on the operator panel.
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[Default Paper Size]
Select from A4 or Letter for paper size used in printing reports or data of unspecified size.

[Operation for Start Button]
You can specify either tap or slide operation for the Start button.

[Default View of Home]
You can specify either the App list screen or PIN list as the Home screen default view.

Refer
 For details of the App and PIN List, refer to the "About the Home Screen" (P.32).

[Fax Settings]
Specify the settings for the fax function.

[Fax Number]
Enter a fax number for the machine. The fax number is printed on the fax header.

[Country/Region]
Select the country where the machine is used.

[Company Name]
Specify the sender name. The specified name will appear in fax headers.

[Fax Line Settings]
Configure the basic settings for the fax line.

[Transmission]
Select the line type.

[Line Monitor Tone Volume]
Select the volume level of the line monitor, which can be heard through the internal speaker until a 
connection is made.
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[DRPD Pattern]
Provides a separate number for faxing with a distinctive ring pattern.

[Ext. Phone Hook Threshold]
Select the detection level of an off-hook signal from the external telephone.

[Off Hook Wake Up]
Specify whether to recover from the power saver mode when you pick up the handset of the external 
telephone.

[Incoming Fax Settings]
Configure the settings for receiving faxes.

[Receive Mode]
Specify the fax receiving mode.

 [TEL Mode]
Receive transmissions using an external telephone or by operating the touch panel display. Once the 
ring tone sounds, the fax can be received by picking up the external handset and entering the remote 
receive code, or by tapping [Receive] on the touch panel display.

 [FAX Mode]
Automatically receives faxes.

Pattern1–7 Distinctive Ring Pattern Detection (DRPD) is a service provided by some 
telephone companies. DRPD Patterns are specified by your telephone company. 
The following shows the patterns provided with the machine.

Pattern1

Pattern2

Pattern3

Pattern4

Pattern5

Pattern6

Pattern7

Ask your telephone company which pattern you need to select to use this service.
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 [TEL/FAX Mode]
If there is an incoming transmission from the sender, fax receipt will begin after the external 
telephone rings for the interval specified in [TEL/FAX Mode] of [Auto Answer Setup]. When the caller 
is using a telephone, a ring tone will sound from the speaker built into the machine.

 [Ans/FAX Mode]
This configuration assumes use of a telephone answering machine. When a signal arrives from the 
caller, it is detected as either a fax transmission or voice call. When the caller is sending a fax, the fax 
will be received automatically, and when a voice call is being made, the caller's message will be 
recorded by the answering machine. If the power supply to the answering machine is turned off, the 
machine's receiving mode will automatically switch to [FAX Mode] after the ring tone sounds for the 
interval specified beforehand.

 [DRPD Mode]
Before using the Distinctive Ring Pattern Detection (DRPD) option, a distinctive ring service must be 
installed on your telephone line by the telephone company. After the telephone company has 
provided a separate number for faxing with a distinctive ring pattern, configure the fax setup to 
monitor for that specific ring pattern.

[Ring Tone Volume]
Specify ring tone volume. This setting is enabled when [Receive Mode] is [TEL/FAX Mode], and the 
ring tone sounds from the machine's built-in speakers for a phone call from the sender.

[Auto Answer Setup]
Specify the settings for automatic fax reception.

 [FAX Mode]
Set the interval at which the machine goes into the fax receive mode after receiving an incoming call.

 [TEL/FAX Mode]
Set the interval at which the machine goes into the fax receive mode after the external 
telephonereceives an incoming call.

 [Ans/FAX Mode]
Set the interval at which the machine goes into the fax receive mode after the external answering 
machine receives an incoming call.

[Junk Fax Filter]
Specify whether to reject faxes from fax numbers not registered in the address book of the machine.

[Forward Settings]
Specify whether to forward incoming faxes to specified destinations.

 [Off]
Print incoming faxes from the machine.

 [Forward]
Forwards incoming faxes to specified destinations.

 [Forwarding Number]
Enter a fax number for the destination to which incoming faxes are forwarded.

 [Print and Forward]
Prints incoming faxes from the machine, and forward them to a specified fax number.

 [Forwarding Number]
Enter a fax number for the destination to which incoming faxes are forwarded.
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 [Forward to Email]
Forwards incoming faxes to specified e-mail addresses.

 [Print and Email]
Prints incoming faxes from the machine, and forward them to a specified e-mail address.

 [Forward to Server]
Forwards incoming faxes to specified destination servers.

 [Print & Fwd to Server]
Prints incoming faxes from the machine and forward them to a specified server address.

Note
 When forwarding to e-mail, it is necessary to specify an e-mail server and forwarding address. For 

details, refer to Internet Services Help.
 The machine may not display forwarding errors, depending on the e-mail server settings. When 

necessary, confirm that the fax was correctly forwarded to the specified forwarding address.
 When forwarding to a server, it is necessary to specify a file server and forwarding address. For details, 

refer to Internet Services Help.

[2-Sided Printing]
Specify whether to print the received faxes on both sides of a sheet of paper.

Note
 This feature may not be available depending on the size of the received faxes or settings of the trays, etc.

[Remote Receive]
Specify whether to allow faxes to be received by operating an external telephone connected to the 
machine. To use this feature, it is necessary to set [Remote Receive] to [On], and to specify a two-
digit code on the displayed screen. When a fax arrives, you can receive faxes using an external 
telephone by entering the two-digit code specified with [Remote Receive].

[Auto Reduction]
Set the operation when the length of a received fax document exceeds the length of paper to be 
printed.

[Outgoing Fax Settings]
Configure the settings for sending faxes.

[Auto Redial Setup]
Specify the settings for automatic redial.

[Dial Type]
Select the dialing type.

[Prefix Dial]
Specify a prefix dial number. This number is dialed preceding any dial number. This is useful in 
telephone networks using Private Branch Exchange (PBX).

[Cover Sheet]
Specify whether to attach a cover page to faxes. The cover page is attached to the first page of the 
outgoing fax as the cover. The cover page contains the recipient, sender name, fax number of the 
machine, number of pages, and date and time of sending.
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[Send Header]
Specify whether to add a Send Header at the top of transmitted documents. A Send Header includes 
the date, transmission start time, sender's name, sender ID and page count.

[ECM]
Specify whether to enable the ECM feature. To use the ECM feature, the remote machines must also 
support the ECM feature. ECM stands for "Error Correction Mode." With ECM, which is one of the G3 
communication methods, the machine checks that the data is properly sent to the recipient, and if 
not, resends the data.

[Modem Speed]
Select the fax modem speed when a fax transmission or reception error occurs.

[Display Manual Fax Recipient]
Specify whether to display a fax number for the recipient on the screen of the operator panel when 
manually sending a fax.

[Fax Reports]
Configure the settings for fax reports.

[Fax Activity]
Specify whether to automatically print the transmission results history when the total number of 
result items reaches 50.

[Fax Transmit]
Specify whether to print the transmission results after a fax is sent.

[Fax Broadcast]
Specify whether to print transmission results after a fax transmission to multiple destinations.

[Protocol Monitor]
Specify whether to print a protocol monitor report, which helps you identify the cause of a 
communication problem.

[Add Chain Dial]
Specify whether to combine multiple fax numbers and specify the other parties.

[Email Settings]
Configure the e-mail settings.

[Max Email Size]
Specify the maximum size of an e-mail that can be sent.

9.10 [Network Settings]
You can configure the network settings.
 "[Network]" (P.127)
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 "[Wi-Fi]" (P.127)
 "[Wi-Fi Direct]" (P.128)
 "[Ethernet]" (P.129)
 "[Protocol]" (P.130)
 "[Other]" (P.130)

[Network]
You can switch between wireless LAN (Wi-Fi) and wired LAN (Ethernet) network connections.

[Wi-Fi]
Note
 This setting can be used when [Wi-Fi] is selected in [Network].

Configure the wireless network settings.

[WPS Setup]
Specify the wireless network settings using WPS.

[Wi-Fi Setup Wizard]
To configure the wireless network settings, either select the wireless network access point from the 
screen display, or tap [Enter SSID] or [WPS Setup].

[Enter SSID]
Enter the name to identify the wireless LAN access point.

 [Infrastructure]
Select the encryption type for an infrastructure network.

 [Ad hoc]
Specify the encryption type for Ad-hoc mode.

Note
 [Ad hoc] settings can be used when [Wi-Fi Direct] is disabled.

[WPS Setup]
Specify the wireless network settings using WPS.

[IP Mode]
Select the IP mode.

Note
 When [IPv6] Mode is set, Wi-Fi Direct cannot be used.

[Dual Stack]
Uses both IPv4 and IPv6 to specify the IP address.

[IPv4]
Uses IPv4 to specify the IP address.
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[IPv6]
Uses IPv6 to specify the IP address.

[TCP/IP]
Configure the TCP/IP settings.

[IP Addressing]
Specify the method for acquiring an IP address.

[IP Address]
Display the IP address assigned to this machine. With [IP Addressing] set to [Manual Input], enter 
the IP address.

[Subnet Mask]
Display the subnet mask assigned to this machine. With [IP Addressing] set to [Manual Input], enter 
the subnet mask.

[Gateway Address]
Display the gateway address assigned to this machine. With [IP Addressing] set to [Manual Input], 
enter the gateway address.

[Reset Wi-Fi Settings]
Initializes wireless network settings. After performing this setting and restarting the machine, all the 
wireless network settings are reset to their factory settings.

[Wi-Fi Direct]
Note
 This setting can be used when [Wi-Fi] is selected in [Network].
 Wi-Fi Direct cannot be used in an IPv6 or Ad-hoc environment.

Configure the Wi-Fi Direct network settings.

[Wi-Fi Direct]
Specify whether to enable or disable the Wi-Fi Direct network.

[Group Role]

[Auto]
Automatically specifies the group role of the machine.

[Group Owner]
Sets the machine as the group owner of the Wi-Fi Direct network. When the machine is set to the 
group owner, the machine functions as the access point or wireless router.

[Device Name]
Enter the machine name that identifies the Wi-Fi Direct network with up to 32 alphanumeric 
characters.
When you select the machine name on your mobile device, find the name specified here.
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[Paired Device]
Displays the status of the Wi-Fi Direct connections.

[Disconnect All] > [Disconnect Now]
Disconnects all the Wi-Fi Direct connections.

[Disconnect All] > [Disconnect and Reset Passphrase]
Disconnects the Wi-Fi Direct connections and changes the passphrase.

[SSID]
Displays the name of the network to be identified by Wi-Fi Direct. It can be entered following 
"DIRECT-XX" using no more than 23 alphanumeric characters. When selecting the name of the 
network connection through a mobile device, the specified name will be displayed here.

[Passphrase]
Displays the passphrase. Enter the passphrase displayed here when you connect to the Wi-Fi Direct 
network from your mobile device.

[Reset Passphrase]
Disconnects the Wi-Fi Direct connections and changes the passphrase.

[Print Passphrase]
Print the passphrase.

[Ethernet]
Note
 This setting can be used when [Ethernet] is selected in [Network].

Configure the wired network settings.

[IP Mode]
Select the IP mode.

[Dual Stack]
Uses both IPv4 and IPv6 to specify the IP address.

[IPv4]
Uses IPv4 to specify the IP address.

[IPv6]
Uses IPv6 to specify the IP address.

[TCP/IP]
Configure the TCP/IP settings.

[IP Addressing]
Specify the method for acquiring an IP address.
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[IP Address]
Display the IP address assigned to this machine. With [IP Addressing] set to [Manual Input], enter 
the IP address.

[Subnet Mask]
Display the subnet mask assigned to this machine. With [IP Addressing] set to [Manual Input], enter 
the subnet mask.

[Gateway Address]
Display the gateway address assigned to this machine. With [IP Addressing] set to [Manual Input], 
enter the gateway address.

[Modem Speed]
Select the communication speed and the duplex settings of Ethernet.

[Protocol]
Specify whether to enable or disable each protocol.

[Other]
Configure the advanced network settings.

[IPv4 Filter]
Specifies whether to restrict devices that can communicate with the machine. Range of IPv4 address 
to allow communication with the machine can be set in Internet Services.

Note
 This feature does not apply to communication via Wi-Fi Direct.

[IPv6 Filter]
Specifies whether to restrict devices that can communicate with the machine. Range of IPv6 address 
to allow communication with the machine can be set in Internet Services.

Note
 This feature does not apply to communication via Wi-Fi Direct.

[PS Data Format]
Specifies the PostScript language compatibility communication protocol.

[Auto]
Used when auto-detecting the PostScript language compatibility communication protocol.

[Standard]
Used when the communication protocol is in ASCII interface.

[BCP]
Used when the communication protocol is in binary format.
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[TBCP]
Used when the communication protocol supports both ASCII and binary data to switch between 
them according to the specified control code.

[Binary]
Used when no special processing is required for data.

[Disable IEEE 802.1x]
Disables IEEE 802.1x authentication.

Note
 This setting can be used when the machine is connected using a LAN cable, and IEEE 802.1x 

authentication has been specified through Internet Services. For details, refer to Internet Services Help.

[Reset Network Settings]
Initialize the wired LAN (Ethernet) and wireless LAN (Wi-Fi) settings stored in memory. After 
performing this setting and restarting the machine, all the Ethernet and wireless network settings 
are reset to their factory settings.

[Delete All Certificates]
Deletes all certificates of the machine.

9.11 [App Defaults]
You can configure the default settings for the copy, fax and scan functions, and the USB Direct Print 
feature.
 "[Copy Settings]" (P.131)
 "[Fax Settings]" (P.132)
 "[Scan Settings]" (P.133)
 "[Direct Print Settings]" (P.134)

[Copy Settings]
Configure the default settings for the copy function.

[Output Color]
Select the default color mode.

[Lighten/Darken]
Specify the default copy density.

[Reduce/Enlarge]
Specify the default copy zoom ratio.

[Paper Trays]
Specify the paper tray to be selected as the default settings.
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[2-Sided]
Specify whether to copy on both sides of a sheet of paper as the default settings.

[2-Up]
Specify whether to copy two pages of a document to fit onto one side of a sheet of paper as the 
default settings.

[Number of Cards]
Select the number of cards to be copied at a time when making a Copy (ID Card) as the default 
settings.

[Sharpness]
Specify the default sharpness level of the image.
Select [Sharpen] to sharpen the appearance of the image, and [Soften] to soften its appearance.

[Original Size]
Select the default document size to be copied.

[Original Type]
Select the default document type.

[Collation]
Configure the default setting to specify whether to produce output page by page or grouped by 
batch when copying multiple pages multiple times.

[Saturation]
Specify the default vividness level of color.

[Background Suppression]
Specify whether to suppress the background color of the document (the color of the paper or 
background) when copying.

[Top & Bottom Erase], [Left & Right Erase], [Center Erase]
Specify the default margins to remove the shadows when copying a thick document or a booklet.

[Color Balance]
Configure color balance default settings for low, medium or high density of each color: yellow, 
magenta, cyan and black.

[Fax Settings]
Configure the default settings for the fax function.
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[Preview]
Specify whether to display the preview of the scanned data before sending a fax as the default 
settings.

[Resolution]
Select the default image quality when scanning a document.

[2-Sided Scanning]
Specify a default value for whether one side or both sides of a document are to be scanned.

[Lighten/Darken]
Specify the default density of outgoing faxes.

[Delay Send]
When setting [Delay Send], specify the default value for the time at which to begin sending.

[Next Original on Document Glass]
Specifies the default value whether to show a confirmation screen regarding the next document after 
a document has been placed on the document glass and scanned.

[Check G3 ID and Send]
When set to [On], the machine first receives the connection G3ID, and transmits the fax only if the 
authentication numbers match.

[Scan Settings]
Configure the default settings for the scan function.

[File Name]
Specify how to name the scanned data as the default settings.
File names can be specified up to 50 characters, in the following format.
img_YYMMDDHHMMSS.extension

Note
 YYMMDDHHMMSS includes two digits each to indicate the year, month, date, hour, minute and second.
 In cases where files are formatted one page per file, destination file names are duplicates, or when a 

scanner (e-mail transmission) is used, a - (hyphen) and consecutive four-digit number (0001 - 9999) are 
added after the file name.

 The following characters cannot be used for the file name even though they are displayed on the screen 
keyboard.
\ / : * ? " < > |

[File Format]
Select the default file format of the scanned data to be saved.

Note
 You can set passwords for encryption when saving to PDF.
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[Preview]
Specify whether to display the preview of the scanned data before storing or sending as the default 
settings.

[Output Color]
Select the default color mode when scanning a document.

[Resolution]
Select the default scan resolution rate when scanning a document.

[Original Size]
Select the default document size to be scanned.

[2-Sided Scanning]
Specify a default value for whether one side or both sides of a document are to be scanned.

[Lighten/Darken]
Specify the default scan density.

[Sharpness]
Specify the default sharpness level of the image.
Select [Sharpen] to sharpen the appearance of the image, and [Soften] to soften its appearance.

[Contrast]
Specify the default difference between the light and the dark.
Select [More] to increase contrast, and [Less] to decrease contrast.

[Background Suppression]
Specify whether to suppress the background color of the document (the color of the paper or 
background) when scanning.

[Top & Bottom Erase], [Left & Right Erase], [Center Erase]
Specify the default margins to remove the shadows when scanning a thick document or a booklet.

[Add Folder]
Specify whether to create a new folder to which the scanned data is stored as the default settings.

[Next Original on Document Glass]
Specifies the default value whether to show a confirmation screen regarding the next document after 
a document has been placed on the document glass and scanned.

[Direct Print Settings]
Configure the default settings for the USB Direct Print feature.
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[Output Color]
Specify whether to print in color or black and white as the default settings.

[Paper Trays]
Specify the paper tray to be selected as the default settings.

[2-Sided]
Specify whether to Print on one side or both sides of a sheet of paper as the default settings. For 
two-sided printing, specify whether the printouts are bound at the long edge or short edge.

[Layout]
Specify the default number of pages to be imposed on one side of print media.

[Image Type]
Select the default print image quality.

[Auto]
Print PDF or TIFF files with [Text] Mode, and JPEG files with [Photos (Standard Quality)] Mode.

[Photos (Standard Quality)]
Settings optimized for photos (standard).

[Photos (High Quality)]
Settings optimized for photos (high quality).

[Text]
Settings optimized for text.

[Collation]
Configure the default setting to specify whether to produce output page by page or grouped by 
batch when printing multiple pages multiple times.

[PDF Password]
Set the default password used to print PDF files protected by a password.

9.12 [Security Settings]
You can configure the security settings, such as limiting access to the setting menus or functions.
 "[Admin Authentication]" (P.136)
 "[User Permissions]" (P.136)
 "[Secure Fax Receive]" (P.137)
 "[Save Fax Job Recipients]" (P.138)
 "[Print Accounting]" (P.138)
 "[Auto Color To Mono Print]" (P.138)
 "[Edit Email From Field]" (P.139)
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 "[Recipient Security]" (P.139)
 "[Domain Filtering]" (P.139)
 "[Software Download]" (P.139)
 "[Login Attempts]" (P.139)
 "[Security Warning]" (P.139)
 "[Service Rep. Op. Restriction]" (P.140)
 "[Restrict Job Display Information]" (P.140)
 "[Address Book Encryption]" (P.140)
 "[Output Restriction for Print Jobs]" (P.140)

[Admin Authentication]
Specify whether to use the Admin Authentication feature to impose restrictions on access to each 
feature by setting passcodes.
Access restrictions can be applied to the following features:
 [Address Book]
 [Information Pages]
 [General]
 [Network Settings]
 [App Defaults]
 [Security Settings]
 [Maintenance]
 [Advanced Settings]

Note
 Features subject to access restrictions are marked with . Passcode entry is necessary in order to 

operate restricted features.

Refer
 For details, refer to "Limiting Access to Features" (P.40).

[Change Passcode]
Change the passcode to be used.

Note
 This setting can be used when [Admin Authentication] is enabled.

[User Permissions]
Note
 This setting can be used when [Admin Authentication] is enabled.

Enable or disable each feature of the machine, or use passcodes to restrict use of features. With 
[Copy] and [USB Direct Print], you can place restrictions on color copying and color printing.

[Customize Home and App]
Specify whether to enable access to the feature that allows Home screen apps to be rearranged, new 
apps added, etc.



1379.12   [Security Settings]

[Copy]
Specify whether to enable access to the copy feature. Select [Black & White Only], and access to 
color copying is disabled.

[Email]
Specify whether to enable the Scan to Email feature.

[Fax]
Specify whether to enable the fax function.

[Scan to Network]
Specify whether to enable the Scan to Network feature.

[Scan to PC/WSD]
Specify whether to enable the Scan to WSD feature.

[Scan to USB]
Specify whether to enable the Scan to USB feature.

[USB Direct Print]
Specify whether to enable access to the USB Direct Print feature. Select [Black & White Only], and 
access to color printing is disabled.

[Show When Inserted]
Specify whether the [USB] screen is displayed when a USB memory is inserted.

[Scan from PC]
Specify whether to enable access to the Scanning From a Computer feature. Select [Allow with 
Passcode], and passcode entry is required when scanning from a computer.

[Direct Fax]
Specify whether to enable access to the Direct Fax feature. Select [Allow with Passcode], and 
passcode entry is required when using the Direct Fax feature.

[Secure Fax Receive]
Note
 This setting can be used when [Admin Authentication] is enabled.
 Even when this setting is enabled, if [Forward Settings] is set to [Forward to Email], [Print and Email], 

[Forward to Server] or [Print & Fwd to Server], received faxes will be saved in the machine's memory, and 
forwarded to the specified destinations. A passcode is required when printing faxes from the machine or 
when forwarding to a specified fax number. A passcode is not required when forwarding to a specified 
address or server. For details on [Forward Settings], refer to "[Forward Settings]" (P.124).

Specify whether to require a passcode to print received faxes, and to change the passcode.
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[Change Passcode]
Change the passcode to be used.

Note
 This setting can be used when [Secure Fax Receive] is enabled.

[Save Fax Job Recipients]
Specify whether to display the other party's information for completed outgoing/incoming fax jobs. 
When [On] is specified, the other party's information will be displayed under the following items.
 [Jobs] Screen
 [Information Pages] > [Job History]
 [Jobs] of Internet Services

[Print Accounting]
Configure the print restriction settings.

[Print Accounting]
Restricts printing and counts up printed pages for each user.

Note
 For details on how to limit user registration and printing with this machine, refer to "Permitting Only 

Registered Users to Print" (P.165) and "Setting Printing Restrictions on Each Registered User" (P.167).

[Unauthenticated User Print]
Enable [Print Accounting], and jobs for which account information (user name and password) is 
missing cannot be printed. Enable this feature when printing of jobs without account information is 
to be permitted. The jobs without account information are the following:
 Jobs generated using other company's print drivers or utilities
 Jobs submitted using the following features:

- USB Direct Print
- AirPrint
- Mopria Print Service

Note
 Even if a print driver or an application provided by us is used, jobs generated with the print driver's or 

application's user authentication settings disabled are regarded as jobs without account information.

[Auto Color To Mono Print]
 When [Print Accounting] is enabled

The system forces monochrome printing of color jobs of users subject to restrictions on color 
printing. When [Unauthenticated User Print] is enabled, the system forces monochrome printing 
of color jobs without account information.

Note
 Users restricted from printing in color are users prohibited to use color printing in [Accounting] of the 

Internet Services. If [Auto Color To Mono Print] is disabled, color print jobs of users restricted from 
printing in color will be canceled. For details, refer to "Permitting Printing Only in Black and White" 
(P.168).

 When [Print Accounting] is disabled
Forcibly prints color jobs in black and white for all users.
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[Edit Email From Field]
Specify whether to enable editing the e-mail address for the sender when you send scanned data 
using the Scan to Email feature.

Refer
 For details on sender addresses, refer to "Configuring the Settings for the Scan to Email Feature" (P.86).

[Recipient Security]
Specifies whether to show the destination confirmation screen for faxes and e-mails.

[Re-enter Fax Recipient]
Specifies whether to show the screen to re-enter or confirm the destination when entering the 
destination.

[Confirm Recipients]
Specify whether to display the destination confirmation screen when sending e-mail or faxes.

Note
 Set [On], and the destinations available for specification will be limited to those in the Address Book. E-

mail addresses and fax numbers cannot be specified by entering them directly.

[Recipient Selection Method]
Set [Only From Address Book], and the destinations available for specification will be limited to those 
in the Address Book. E-mail addresses and fax numbers cannot be specified by entering them 
directly.

[Domain Filtering]
Specify whether to restrict sending e-mails to specified domains.

Note
 The forwarding domain is specified through Internet Services [Domain Filtering]. For details, refer to 

Internet Services Help.

[Software Download]
Specify whether to enable download of firmware updates.

[Login Attempts]
Specify the number of login attempts. The relevant login menus are: [Admin Authentication], [User 
Permissions] and [Secure Fax Receive].

[Security Warning]
Specify whether a security warning will appear when a user identified as the administrator accesses 
Internet Services for a device that has been assigned a global IP address.
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[Service Rep. Op. Restriction]
You can restrict Customer Engineer operations so that a Customer Engineer cannot alter the settings 
of the machine.

[Restrict Job Display Information]
Specify whether to display or hide personal information of the jobs. Items that can be hidden are as 
follows.

[Address Book Encryption]
If [On] is selected, the Address Book data are encrypted and saved in the machine.

Important
 If the setting is changed, the data registered in the Address Book are deleted.

[Output Restriction for Print Jobs]
If [Only Allow Secure Print] is selected, only secure print jobs are printed, while all other print jobs 
are canceled.

9.13 [Maintenance]
You can configure the maintenance settings, such as for cleaning the transfer unit and initializing the 
memory.
 "[Adjust Paper Type]" (P.141)
 "[Adjust Transfer Belt Unit]" (P.141)
 "[Adjust 2nd BTR]" (P.141)
 "[Image Position]" (P.141)
 "[Adjust Fusing Unit]" (P.141)
 "[Adjust Image Quality]" (P.141)
 "[Clean Developer/Transfer Unit]" (P.142)
 "[Toner Refresh]" (P.142)
 "[Bypass Tray Feed Method]" (P.142)
 "[Initialize NVM]" (P.142)
 "[Initialize Print Meter]" (P.143)
 "[Clear Stored Jobs]" (P.143)

Operator Panel Job 
Information

Print, stored print Document title, user name

USB print Document title

Fax Contact name, telephone 
number, sender

Email Contact name, address

Scan to network, ID card 
scan

Server name

WSD Scan PC name

Internet Services All job information Document title, user name
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 "[Clear Forms]" (P.143)
 "[Toner Cartridge]" (P.143)
 "[Adjust Altitude]" (P.143)
 "[Delete Job History]" (P.144)

[Adjust Paper Type]
Select the paper type.

[Adjust Transfer Belt Unit]
If ghosting occurs with output text and images, adjust the transfer voltage. If faint ghosting occurs, 
decrease the value to decrease the voltage.

[Adjust 2nd BTR]
For each paper type, adjust the transfer voltage of the transfer roll (BTR). If the colors on the print 
results are mottled, increase the value to increase the voltage. If there are blank white areas or 
uneven density near the bottom of the paper, decrease the value to decrease the voltage.

[Image Position]
If the print position is misaligned, adjust the image position.

[Lead/Side Registration]
For each tray, misalignment of the image position for either feed direction (lead [L] or side [S] 
registration) can be adjusted numerically.

[Perpendicularity]
Image perpendicularity can be adjusted numerically.

[Print Chart]
Print a position adjustment chart. This enables you to check for any misalignment in image position.

[Adjust Fusing Unit]
Adjust the temperature of the fusing unit for each paper type. If the paper curls, lower the 
temperature. If the toner does not properly adhere to the paper, raise the temperature.

[Adjust Image Quality]
Configure image quality and color correction settings.

[Adjust Color Registration]
If color registration is misaligned in print output, adjust color registration (color registration 
misalignment) either automatically or manually. Print a chart to perform manual adjustment.



142 9   Changing the Machine Settings

[Adjust Density]
Correct toner density. Changing the numerical value changes the thickness and thinness.

[Calibration]
Calibrate automatically. When the rendering of value or hue in copies and prints is poor, the specified 
feature is calibrated.

[AdjPrintHdDensity(1Stripe)]
This can be used when streaks (lines) appear in copy or print output. Print a chart to make 
adjustments.

[AdjPrintHdDensity(Stripes)]
This can be used when regularly patterned streaks (vertical lines) appear in output. Print a chart to 
make adjustments.

[Image Quality for Coated]
Specify image quality when printing on coated paper.

[Clean Developer/Transfer Unit]
Clean the developer and transfer unit. Perform when the output result is blurred.

Note
 This feature uses drum cartridge, and may therefore shorten the service life of the drum cartridge.

[Toner Refresh]
Corrects toner and developer balance. Perform when the output result is blurred.

Note
 This feature uses toner, and may therefore shorten the service life of the toner cartridge, drum cartridge 

and waste toner container.

[Bypass Tray Feed Method]
Paper feed error of the machine will be reduced by selecting [Reduce Covers Feed Error] when using 
thick paper, envelope, label, or coated paper in the Bypass Tray.

[Initialize NVM]
Initialize memory (NVM). After performing this setting and restarting the machine, all the machine 
settings are reset to their factory default values.

[Fax Settings]
Deletes the following data registered in the machine: fax number, sender name, and fax number/e-
mail addresses/server address to which incoming faxes are forwarded.

[Fax Information]
Delete the history of faxes sent and received and stored documents.
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[Scan Settings]
Deletes the server addresses registered in the machine.

[User Account Settings]
Reset the Home screen and apps to the factory default state.

[User App Settings]
Deletes the added widget applications.

[System Settings]
Resets the system settings to the factory default state.

[Address Book]
Deletes the destinations in the address book.

Note
 When deleting the server address, select [Scan Settings].

[Initialize Print Meter]
Resets the print meter count.

[Clear Stored Jobs]
Clears print jobs saved using the stored print feature.

[Clear Forms]
Delete forms stored in the machine.

[Toner Cartridge]
Specify the toner cartridge to be used.

[Non-Genuine Toner]
Set when using the machine in custom mode. Use a compatible toner.

Important
 Once Non-Genuine Toner mode is enabled, it cannot be disabled.
 Quality is not guaranteed when using this mode. Therefore, the designated functions and performance 

may not be achieved with this mode. Continuing using the product in this state may cause a printer 
malfunction.

 In Non-Genuine Toner Mode, the "[End of Drum Life]" (P.149) settings will be ignored. Also, toner and 
drum cartridge remaining content levels will not be displayed.

[Adjust Altitude]
If the machine is installed in a location with a high elevation, specify the altitude.
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When the altitude is correctly selected, optimum printing quality is attained, and the remaining 
amount of toner is correctly displayed.

[Delete Job History]
Clears the job history of all finished jobs.

9.14 [Advanced Settings]
You can customize the settings in accordance with the setting environment, or your preferences.
 "[PS Settings]" (P.144)
 "[PCL Settings]" (P.145)
 "[PDF Settings]" (P.146)
 "[USB Port Settings]" (P.147)
 "[Copy Settings]" (P.147)
 "[Scan Settings]" (P.147)
 "[Output Settings]" (P.148)
 "[Low Toner Alert Message]" (P.149)
 "[End of Drum Life]" (P.149)
 "[Job History]" (P.149)
 "[LDAP Address Book]" (P.149)
 "[Optional Apps]" (P.150)

[PS Settings]
Configure PostScript language compatibility-related settings.

[PS Error Report]
Specifies whether to print the contents of the errors concerning PostScript language compatibility 
page description language. The change becomes effective after the printer is restarted.

Note
 Instructions from the PostScript language compatibility driver override the settings specified on the 

operator panel.

[PS Job Timeout]
Specifies whether to specify the execution time for one PostScript language compatibility job. The 
change becomes effective after the printer is restarted.

[Paper Trays]
Specifies the way to select the tray for PostScript language compatibility mode. The change becomes 
effective after the printer is restarted.

[PS Default Color]
Select the default color mode for PostScript language compatibility mode.
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[PCL Settings]
Configure the machine settings related to the Printer Control Language (PCL).

[Paper Trays]
Specify the paper tray to be used.

[Output Size]
Specify the print paper size.

[Original Orientation]
Specify how text and graphics are oriented on a page.

[2-Sided]
Specify whether to print on both sides of a sheet of paper. For two-sided printing, specify whether 
the printouts are bound at the long edge or short edge.

[Font]
Specify the default font.

[Symbol Set]
Specify the default symbol set.

[Font Size]
Specify the font size for scalable typographic fonts.

[Font Pitch]
Specify the font pitch for scalable mono spaced fonts. Font pitch refers to the number of characters 
printed in one horizontal inch.

[Form Line]
Specify the number of prints to be made of each page. Line spacing is configured based on [Output 
Size] and [Original Orientation]. Specify paper size and document orientation in advance.

[Quantity]
Specify the number of copies to print.

Note
 For a specific job, set the quantity from the print driver. Values selected from the print driver always 

override values selected from the operator panel.

[Image Enhance]
Specify whether to enable the image enhance feature. Enabling this feature makes the boundary line 
between black and white smoother to decrease jagged edges and enhance the visual appearance.
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[Hex Dump]
All data sent to the machine is printed in hexadecimal and representation, facilitating 
troubleshooting analysis. Control codes are not executed.

[Draft Mode]
Specify whether to save toner when printing. The print quality is lower when compared to normal 
printing.

[Line Termination]
Specify whether to add line termination commands.

[Output Color]
Select the color mode.

[Ignore Form Feed]
Specify whether not to print the blank pages without any images, and to print only the pages with 
images.

[PDF Settings]
Configure the machine settings that only affect PDF files.

[Quantity]
Specify the number of copies to print.

[2-Sided]
Specify whether to print on both sides of a sheet of paper. For two-sided printing, specify whether 
the printouts are bound at the long edge or short edge.

[Print Mode]
Select the print mode.

[PDF Password]
Set the password used to print PDF files protected by a password.

[Collation]
Configure the default setting to specify whether to produce output page by page or grouped by 
batch when printing multiple pages multiple times.

[Output Size]
Specify the print paper size.

[Layout]
Specify a print layout.
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[PDF Default Color]
Select the color mode.

[Detect Job Separator]
Specify whether to detect that a print job has been completed successfully.

[USB Port Settings]
Configure the machine USB port settings.

[Port Status]
Specify whether to enable the machine's USB port.

[Fixed Port]
Specify whether to use the same port as the one specified when the software has been installed.

[PS Data Format]
Specify the PostScript language compatibility transmission protocol.

[Job Timeout]
Set the amount of time the machine waits until the machine receives data from the computer. The 
print job is canceled when the job is not printed within the specified time frame.

[Copy Settings]
Configure the advanced copy settings.

[Background Suppression Level]
Select the background suppression level to adjust the background density of the original.

[Scan Settings]
Configure the advanced scan settings.

[Background Suppression Level]
Select the background suppression level to adjust the background density of the original.

[TIFF Format]
Select the TIFF file format.

[Quality/File Size]
Select the image compression level.
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[Output Settings]
Configure the settings for printing from the machine.

[Print ID]
Specify whether to print the user ID, and select the location where the ID is printed.

[Print Text]
Specify whether to print Page Description Language (PDL) data as text when the data is not 
supported by the machine.

[Substitute Tray]
Specify whether to use paper of a different size when the paper that is loaded in the specified tray 
does not match the paper size settings for the current job.

[A4/Letter Switch]
Specify whether to print A4 size jobs on Letter size paper if A4 size paper is not available, or to print 
Letter size jobs on A4 size paper if Letter size paper is not available.

[Prioritize Bypass Tray]
Specify whether to use the bypass tray when the paper tray is automatically selected from the print 
driver.
When [On] is specified, the paper tray is automatically selected from the printer driver, and the 
Bypass Tray is loaded with paper, the Bypass Tray will be used.

[Show Size Mismatch Error]
Specify whether an error is to be indicated on the operator panel in cases where the paper size 
specified in the print driver matches that on the operator panel, but the paper size specified in the 
print driver is different from that loaded in the specified tray.

Note
 When [Off] is selected, there is a possibility that the following may occur with all trays.

- When the paper size is smaller than the document size, the back side of the paper may become soiled.
- Printing may take some time.
- Misalignment may occur with two-sided printing.

 With Tray 1, the following may occur.
- Paper jams may occur when using paper sizes A5, B6 or smaller.
- Paper may remain inside the machine after printing.
- Paper jams may occur when using paper sizes smaller than A5 for two-sided printing.

 With Tray 2 (250-Sheet Feeder) (optional), the following may occur.
- Paper jams may occur when using paper size A5 or smaller.
- Paper may remain inside the machine after printing.

 With the Bypass Tray, the following may occur.
- Paper jams may occur when using paper size A5 or smaller for two-sided printing.

[Banner Sheet]
Specify banner sheet insertion position and the tray from which to print.
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[Report 2-Sided Print]
Specify whether to print reports on both sides of a sheet of paper.

[Letterhead 2-Sided Print]
Specify whether to print on both sides of letterhead.

[Hex Dump]
All data sent to the machine is printed in hexadecimal and representation, facilitating 
troubleshooting analysis. Control codes are not executed.

[Low Toner Alert Message]
Specify whether to show the alert message when toner is low.

[End of Drum Life]
Specify whether to stop printing when a drum cartridge reaches the end of its service life.

Note
 Make sure that this menu should be specified before the message is displayed to notify you to replace the 

drum cartridge. This setting cannot be changed after the message of the drum cartridge replacement is 
displayed.

[Cancel Printing]
Stops printing when a drum cartridge reaches the end of its life.

[Continue Printing]
Does not stop printing even when a drum cartridge reaches the end of its life.

Note
 When the [Order Drum Cartridge] message appears, print image quality is not guaranteed, and it is 

therefore recommended that the drum cartridge be replaced with a new one.
 When the [Replace Drum Cartridge now.] message appears, printing is not possible until the drum 

cartridge is replaced with a new one.

[Job History]
Specify whether to print a Job History report automatically.
If automated, a printout will be generated for every 20 jobs processed.

Note
 Reports can also be printed from the [Information Pages] menu.

[LDAP Address Book]
Specify whether searches can be performed from the machine for E-mail addresses and fax numbers 
(only for models with the fax feature) registered in LDAP servers.

Note
 Internet Services settings are required to access the LDAP server from the machine. For details, refer to 

"Using the Address Book in an LDAP Server" (P.159).
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[Optional Apps]
Specify whether to enable plug-in app functions to be used when they are added.
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10 Making Better Use of 
Your Machine

10.1 Using Internet Services
Internet Services is a service to display status of the machine and job history as well as change 
settings of the machine using a web browser.
In TCP/IP environments, you can use a computer connected to the machine via network.

Main functions that can use Internet Services are as the following.

*1 :When Internet Services [Administrator Mode] is enabled and you log in as the administrator, the menu will be displayed. 
For details on how to log in as the administrator, refer to "Logging in" (P.152)

*2 :Displayed only when User Authentication is enabled.
*3 :Displayed when the Print Accounting feature is enabled.

Menu name Features
[Home] You can check the status of the paper tray and consumables, support 

information, and notifications.

[Apps]*1 You can configure the fax and e-mail settings.

[Address Book]*1 You can add, edit or delete destinations.

[Jobs] You can check the job list or job history.

[Network]*1 You can configure the settings necessary for network communication.

[Permissions]*1*2 You can restrict the features available on the machine for each user.

[Accounting]*3 You can tabulate print volumes and restrict use for each user.

[System]*1 You can configure the settings for security and administrator.
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Refer
 For details on settings that can be configured from Internet Services, refer to Internet Services Help.

Starting Internet Services
1. Turn on the computer and open a Web browser.

2. Enter the machine's IP address or URL in the Web browser address entry field, and press the 
<Enter> key.
The top page of the Internet Services will be displayed.

Note
 If you are specifying the port number, type ":" after the address, followed by "80" (the factory default 

port number). You can check the port number at [Configuration Report].
 To check the machine's IP address, press the  (Home) button on the operator panel, and tap  > 

[Device] > [About].

Logging in
1. Start Internet Services.

2. Click on [Log In] in the upper right part of the screen.

3. Enter [User Name] and [Password], then click on [Log In].

Note
 The default user name is set to "11111" with the serial number set as the password.

“Serial Number” can be checked from [About] > [Details] of Internet Services.
 To revoke authentication, click on [Log Out] for the authenticated user name in the upper right part of the 

screen.

About Internet Services Help
For details on settings that can be configured from Internet Services, refer to Internet Services Help.

Click on  in the upper right part of the screen to display Internet Services Help.

10.2 Using Software Supplied With the 
Machine

Download [Printer Software] software for the machine and install it in your computer.
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Print & Scan Hub (Windows)
The [Print & Scan Hub] software provides the following key features:
 "Checking the Status of the Machine/Jobs/Consumables" (P.153)
 "Notification of Printing Completion/Error" (P.154)
 "Scanning and Easy Editing of the Scanned Image" (P.155)

Checking the Status of the Machine/Jobs/Consumables
Note
 This feature is available only when the machine is connected to a network.

You can check whether the machine has generated an error, and job status. By starting Internet 
Services from [Print & Scan Hub], you can also check the status of the toner cartridges, drum 
cartridge, and waste toner container, as well as paper tray loads.

1. Click on [Start] > [FUJIFILM Print & Scan Hub] > [Print & Scan Hub].

2. From [Device List], select this machine, and click on [Device Management].
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3. Check the status of the machine and jobs.

4. To check the status of consumables, click on [Device Information].
Internet Services will start and you can check the status of consumables.

Notification of Printing Completion/Error
Note
 This feature is available when the machine is connected to Wi-Fi or Ethernet.

When printing is completed or when an error occurs, a notification is displayed on the task bar of the 
computer screen.

To use this feature, perform the following procedure to enable auto refresh.



15510.2   Using Software Supplied With the Machine

1. Click on [Start] > [FUJIFILM Print & Scan Hub] > [Print & Scan Hub].

2. Click on  in the upper right part of the screen, and click on [Device Monitor Settings].

3. Select the checkbox for [Auto Check].

4. Configure the [Check Interval (1-60 Minutes)] settings as needed, and click on [OK].

Scanning and Easy Editing of the Scanned Image
You can use [Print & Scan Hub] to scan documents, and rotate/trim the scanned images. The 
scanned images can be saved in JPEG/PNG/PDF formats.

Refer
 For details on how to scan using [Print & Scan Hub], refer to "Scanning With the Print & Scan Hub" (P.94).

Address Book Editor (Windows)
The Address Book Editor software provides the following key features.
 Acquiring/registering/editing/deleting destinations (fax numbers/e-mail addresses/server 

addresses) stored in the machine
 Editing the address book for Direct Fax registered on your computer
 Importing address data exported with the Address Book Editor of this and certain other products
 Exporting destination data registered in the machine
 Editing the subject and body text of the e-mail when sending documents scanned by the machine 

via e-mail
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To start the Address Book Editor, click [Start] > [FUJIFILM Scan Fax Address Book Editor] > [Scan 
Fax Address Book Editor].

Registering Destinations From the Address Book Editor

1. For fax numbers / e-mail addresses, click on >[Contact…].
In the case of a server address, click on  > [Server…].

2. Enter each item, and click on [OK].
Addresses will be registered in [Scan/Fax phonebook tool].

3. Click on .

The registered destination is saved in the machine.

Refer
 For details on how to use [Scan/Fax phonebook tool], refer to [Scan/Fax phonebook tool] Help.

ContentsBridge Utility (Windows)
This software makes it possible to send files on your computer directly to the printer for printing. You 
can print PDF files.
To start the ContentsBridge Utility, double-click on the ContentsBridge shortcut on the desktop.
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Updating Software
You can download the latest software versions from the official company website.
https://fujifilm.com/fbglobal/eng/support

10.3 Using the Address Book
The address book is a feature used for storing destinations. Fax numbers, e-mail addresses, and SMB 
or FTP server addresses can be registered as destinations. The procedures to register/edit/delete 
destinations vary depending on the destination type.
 Fax numbers/e-mail addresses

You can register, edit and delete from the Address Book of the machine, Internet Services or the 
Address Book Editor.

 Server addresses
It can be registered, edited, and deleted from the Address Book Editor.

Registering Destinations/Groups in the Address Book
You can register contacts and groups in the address book.
 Contact

Fax numbers, e-mail addresses, and server addresses can be registered. Both a fax number and e-
mail address can be assigned in one contact.

Note
 For server addresses, you can register up to 32 contacts. For fax numbers/e-mail addresses, you can 

register up to 120 contacts.
 Group

Enables you to select multiple destinations from those registered in the address book and put 
them together as a single group. This feature is useful when you want to send the same document 
to multiple destinations at one time.

Note
 You can register 10 groups with [Email Group], and 6 groups with [Fax Group].
 You can register 10 addresses with 1 [Email Group], and 120 addresses with 1 [Fax Group].
 Server addresses cannot be registered in a group.

Registering Fax Numbers/E-mail Addresses
Note
 Use [Scan/Fax phonebook tool] to register the server address.
 For details on how to use [Scan/Fax phonebook tool], refer to [Scan/Fax phonebook tool] Help.

https://fujifilm.com/fbglobal/eng/support
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Registering Contacts

1. At the Home screen, tap  > [Address Book].

2. Tap  > [Contact].

3. Tap [Name].

4. Enter the contact name and tap [OK].

Note
 Enter [Name], and the index name will automatically appear in the [Index Key] field below. Tap on the 

entry field to change an index name.
 Contacts will be displayed in the order of the index names entered in the [Index Key] field.

5. Tap [Fax Number].
When not registering a fax number, proceed to step 7.

6. Enter the fax number and tap [OK].

7. Tap [Email Address].
When not registering an e-mail address, proceed to step 9.

8. Enter the e-mail address and tap [OK].

9. To register a destination as a favorite, tap [Add to Favorites].
If you do not want to register it as a favorite, proceed to step 12.

Note
 Once you register a contact as a favorite, you can easily and quickly select it from the favorites list in the 

machine address book.

10. Tap [On].

11. Tap .

12. Tap [OK].
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Registering Destinations in a Group

1. At the Home screen, tap  > [Address Book].

2. Tap  > [Email Group] or [Fax Group], and then choose the type of destination to be registered to 
the group.

3. Tap the group name.

4. Enter the group name and tap [OK].

Note
 The registered groups are listed by index name in the address book.
 Enter [Name], and the index name will automatically appear in the [Index Key] field below. Tap on the 

entry field to change an index name.

5. Tap [Add Member].

6. Tap all destinations to be registered in the group, then tap [OK].

7. To register a group as a favorite, tap [Add to Favorites].
If you do not want to register it, proceed to step 10.

Note
 Once you register a contact as a favorite, you can easily and quickly select it from the favorites list in the 

machine address book.

8. Tap [On].

9. Tap .

10. Tap [OK].

Using the Address Book in an LDAP Server
You can search fax numbers and e-mail addresses registered in the LDAP server, and specify them as 
destinations. To access an LDAP Server from the machine, it is necessary to register the server 
settings in the machine using Internet Services settings.

Note
 To use the address book in an LDAP Server, click on Internet Services>[Address Book]>[Advanced 

Settings]>[Server Address Book]>[On].
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Preparing to Access an LDAP Server
Set the following items by using Internet Services.
 Authentication type
 LDAP server address
 LDAP attribute names

Refer
 For details on how to start Internet Services, refer to "Using Internet Services" (P.151).

Setting an Authentication Type

1. Enter IP address of the machine in the web browser and start Internet Services.

Note
 To check the machine's IP address, press the  (Home) button on the operator panel, and tap  > 

[Device] > [About].

2. Click on [Log In] in the upper right part of the screen.

3. Enter the [User Name] and [Password] for the administrator, and click on [Log In].

Refer
 For details on the default user name and password, refer to "Logging in" (P.152).

4. Click on [System] in the upper part of the screen.
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5. Click on [Security].

6. Click on [Address Book Authentication].

7. From [Authentication Protocol], select [LDAP] as the authentication method, and click on [OK].

Note
 When the access point server is operating with Kerberos authentication, select [Kerberos (Windows 

ADS)] as the authentication method. Enter Kerberos server-related settings information in 
[Protocols]>[Kerberos (Windows ADS)]. For details, refer to Internet Services Help.

8. Click on [Restart Now].

9. Once the machine completes restart, click on [Refresh].

Setting the LDAP Server Address
Note
 If the access point server is operating with SSL/TLS communication, configure the SSL/TLS settings for 

the machine. For details, refer to "Using the Encryption Feature" (P.178).

1. Enter IP address of the machine in the web browser and start Internet Services.

Note
 To check the machine's IP address, press the  (Home) button on the operator panel, and tap  > 

[Device] > [About].



162 10   Making Better Use of Your Machine

2. Click on [Log In] in the upper right part of the screen.

3. Enter the [User Name] and [Password] for the administrator, and click on [Log In].

Refer
 For details on the default user name and password, refer to "Logging in" (P.152).

4. Click on [Network] in the upper part of the screen.

5. Click on [Protocols]>[LDAP].

6. Click on [LDAP Servers/Directory Services].

7. Configure the server settings.

Refer
 For details on how to configure settings, refer to Internet Services Help.

8. Click on [OK].

9. Click on [Restart Now].

10. Once the machine completes restart, click on [Refresh].

Setting the LDAP Attribute Names

1. Enter IP address of the machine in the web browser and start Internet Services.

Note
 To check the machine's IP address, press the  (Home) button on the operator panel, and tap  > 

[Device] > [About].
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2. Click on [Log In] in the upper right part of the screen.

3. Enter the [User Name] and [Password] for the administrator, and click on [Log In].

Refer
 For details on the default user name and password, refer to "Logging in" (P.152).

4. Click on [Network] in the upper part of the screen.

5. Click on [Protocols]>[LDAP].

6. Click on [LDAP User Mappings].

7. Specify the attribute names used in the LDAP server.

Note
 If the attribute names are not customized in the LDAP server, leave the settings in this step as they are by 

default.

8. Click on [OK].

9. Click on [Restart Now].

10. Once the machine completes restart, click on [Refresh].

Specifying Destinations From an LDAP Server
Note
 To specify a contact from the LDAP server, it is necessary to enable [LDAP Address Book]. For details, 

refer to "Using the Address Book in an LDAP Server" (P.159).
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1. At the Home screen, tap [Fax] or [Email].

2. Tap .

3. Tap  > [LDAP Address Book], then enter the search string.

4. Tap [Search].

5. When the results are displayed, tap the desired destination.

6. Tap [Start].

10.4 Using Print Accounting

Overview
When the Print Accounting feature is enabled, only users registered in the machine (registered 
users) can print. This feature can also restrict each user's printing and count up printed pages. To 
print, the registered user needs to use a print driver or an application provided by us on which the 
user account information is specified.

Note
 You can register up to 50 users.
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The following illustration shows how the machine works with Print Accounting.

Print Accounting has the following features:
 "Permitting Only Registered Users to Print" (P.165)
 "Setting Printing Restrictions on Each Registered User" (P.167)

- "Permitting Printing Only in Black and White" (P.168)
- "Limiting the Number of Pages Printable in Color/Black and White" (P.170)

 "Permitting Print Jobs Without Account Information" (P.172)
- "Permitting Printing in Color/Black and White" (P.173)
- "Permitting Printing Only in Black and White" (P.173)

Permitting Only Registered Users to Print
To use this feature, settings in the printer driver/application, operator panel and Internet Services are 
required.

Configuring Authentication Settings on the Print Driver/
Application

Specify account information (user name and password) that is required for authentication when 
printing from a print driver or an application provided by us.
This section describes the procedure using the PCL driver as an example.

1. Click on [Start]>[Windows System]>[Control Panel]>[View devices and printers] or [Devices and 
Printers].

Account information Printing restrictions

User name Password
Color print

 : Permitted
 -  : Prohibited

Color print limit 
(pages)

Black and white
print limit (pages)

A
B
C

xxxx
-yyyy

zzzz

5,000

9,000

5,000
3,000
7,000

User registered in the machine

Sending a print job with account information

Printing the job

User authentication
Counting up the
number of printed
pages

Printing prohibited Printing a report to check
the printing usage

Account information

User name Password

User not registered in the machine

A xxxx

Setting restrictions on each user
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2. Right-click on the machine icon, and select [Printer properties].

3. Click on [Configuration].

4. Click on [Accounting].

5. Select [Enable Account Setup] in [Accounting System].

6. From [Account Mode], select [User].

7. Specify a user account (user name and password).

When displaying a dialog box to enter a user account every time a job is submitted:

1)Select [Prompt User for Entry when Submitting Job].

2)Select the checkboxes for [Display Last Entered User Details] and [Mask User ID (***)] as 
necessary.

When you use a Windows login name as your user name and normally use the same account:

1)Select [Always Use Default User Details].

2)From [Specify Job Owner Name], select [Use Login Name].

3)Configure [Passcode] settings.

When always using the same user account by specifying a user name manually:

1)Select [Always Use Default User Details].

2)From [Specify Job Owner Name], select [Enter owner name].

3)Configure [User ID] and [Passcode].

8. Click on [OK].

9. Click on [Apply].

10. Click on [OK].

Enabling Print Accounting on the Operator Panel

1. At the Home screen, tap  > [Device].
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2. Tap [Security Settings] > [Print Accounting].

3. Tap [Print Accounting] > [On] > [OK].

4. Turn off the machine, and then turn it on again.

Registering Users with Internet Services
Register with the machine the account information (user name and password) for users specified for 
the print driver or application.

1. Enter IP address of the machine in the web browser and start Internet Services.

Note
 To check the machine's IP address, press the  (Home) button on the operator panel, and tap  > 

[Device] > [About].

2. Click on [Log In] in the upper right part of the screen.

3. Enter the [User Name] and [Password] for the administrator, and click on [Log In].

Refer
 For details on the default user name and password, refer to "Logging in" (P.152).

4. Click on [Accounting] in the upper part of the screen.

5. Click on [User Accounts] > [Add].

6. Specify [User Name], [Password] and [Retype Password], then click on [Add].

Setting Printing Restrictions on Each Registered User
To use this feature, settings in the printer driver/application, operator panel and Internet Services are 
required.
You can set the following restrictions:
 "Permitting Printing Only in Black and White" (P.168)
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 "Limiting the Number of Pages Printable in Color/Black and White" (P.170)

Permitting Printing Only in Black and White

Configuring Authentication Settings on the Print Driver/Application
Specify account information (user name and password) that is required for authentication when 
printing from a print driver or an application.
This section describes the procedure using the PCL driver as an example.

1. Click on [Start] > [Windows System] > [Control Panel] > [View devices and printers] or [Devices 
and Printers].

2. Right-click on the machine icon, and select [Printer properties].

3. Click on [Configuration].

4. Click on [Accounting].

5. Select [Enable Account Setup] in [Accounting System].

6. From [Account Mode], select [User].

7. Specify a user account (user name and password).

When displaying a dialog box to enter a user account every time a job is submitted:

1)Select [Prompt User for Entry when Submitting Job].

2)Select the checkboxes for [Display Last Entered User Details] and [Mask User ID (***)] as 
necessary.

When you use a Windows login name as your user name and normally use the same account:

1)Select [Always Use Default User Details].

2)From [Specify Job Owner Name], select [Use Login Name].

3)Configure [Passcode] settings.

When always using the same user account by specifying a user name manually:

1)Select [Always Use Default User Details].

2)From [Specify Job Owner Name], select [Enter owner name].

3)Configure [User ID] and [Passcode].

8. Click on [OK].

9. Click on [Apply].

10. Click on [OK].
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Enabling Print Accounting on the Operator Panel

1. At the Home screen, tap  > [Device].

2. Tap [Security Settings] > [Print Accounting].

3. Tap [Print Accounting] > [On] > [OK].

4. Turn off the machine, and then turn it on again.

Registering Users and Setting Usage Restriction with Internet Services
Register user account information (user name and password) of users specified for the print driver or 
application to the machine and set usages restrictions for printing. You must be logged in the 
Internet Services as an administrator to configure settings.

1. Enter IP address of the machine in the web browser and start Internet Services.

Note
 To check the machine's IP address, press the  (Home) button on the operator panel, and tap  > 

[Device] > [About].

2. Click on [Log In] in the upper right part of the screen.

3. Enter the [User Name] and [Password] for the administrator, and click on [Log In].
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Refer
 For details on the default user name and password, refer to "Logging in" (P.152).

4. Click on [Accounting] in the upper part of the screen.

5. Click on [User Accounts] > [Add].

6. Specify [User Name], [Password] and [Retype Password], then click on [Add].

7. Click the added user account.

8. Click on [Edit].

9. Click on  next to [Color Prints], deselecting the check box.

10. Click on [OK].

Note
 Color print jobs of users restricted from printing in color will be canceled. For not canceling a job and 

printing in black and white, refer to "Printing Color Jobs in Black and White" (P.58).

Limiting the Number of Pages Printable in Color/Black and 
White

Set the maximum number of pages that can be printed in color or in black and white.

Configuring Authentication Settings on the Print Driver/Application
Specify account information (user name and password) that is required for authentication when 
printing from a print driver or an application.
This section describes the procedure using the PCL driver as an example.

1. Click on [Start] > [Windows System] > [Control Panel] > [View devices and printers] or [Printer 
properties].

2. Right-click on the machine icon, and select [Printer properties].

3. Click on [Configuration].

4. Click on [Accounting].

5. Select [Enable Account Setup] in [Accounting System].

6. From [Account Mode], select [User].

7. Specify a user account (user name and password).

When displaying a dialog box to enter a user account every time a job is submitted:

1)Select [Prompt User for Entry when Submitting Job].

2)Select the checkboxes for [Display Last Entered User Details] and [Mask User ID (***)] as 
necessary.

When you use a Windows login name as your user name and normally use the same account:

1)Select [Always Use Default User Details].
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2)From [Specify Job Owner Name], select [Use Login Name].

3)Configure [Passcode] settings.

When always using the same user account by specifying a user name manually:

1)Select [Always Use Default User Details].

2)From [Specify Job Owner Name], select [Enter owner name].

3)Configure [User ID] and [Passcode].

8. Click on [OK].

9. Click on [Apply].

10. Click on [OK].

Enabling Print Accounting on the Operator Panel

1. At the Home screen, tap  > [Device].

2. Tap [Security Settings] > [Print Accounting].

3. Tap [Print Accounting] > [On] > [OK].

4. Turn off the machine, and then turn it on again.

Registering Users and Setting Usage Restriction with Internet Services
Register user account information (user name and password) of users specified for the print driver or 
application to the machine and set usages restrictions for printing. You must be logged in the 
Internet Services as an administrator to configure settings.

1. Enter IP address of the machine in the web browser and start Internet Services.

Note
 To check the machine's IP address, press the  (Home) button on the operator panel, and tap  > 

[Device] > [About].
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2. Click on [Log In] in the upper right part of the screen.

3. Enter the [User Name] and [Password] for the administrator, and click on [Log In].

Refer
 For details on the default user name and password, refer to "Logging in" (P.152).

4. Click on [Accounting] in the upper part of the screen.

5. Click on [User Accounts] > [Add].

6. Specify [User Name], [Password] and [Retype Password], then click on [Add].

7. Click the added user account.

8. Click on [Edit].

9. Enter the desired values for [Limit] under [Color Prints].

10. Enter the desired values for [Limit] under [Black & White Prints].

11. Click on [OK].

Permitting Print Jobs Without Account Information
When [Print Accounting] is enabled, jobs for which account information (user name and password) 
is missing cannot be printed. When you wish to allow printing, enable [Unauthenticated User Print]. 
You can also permit only black-and-white printing.
The jobs without account information are the following:
 Jobs generated using other company's print drivers or utilities
 Jobs submitted using the following features:

- USB Direct Print
- AirPrint
- Mopria Print Service
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Note
 Even if a print driver or an application provided by us is used, jobs generated with the print driver's or 

application's user authentication settings disabled are regarded as jobs without account information.

Permitting Printing in Color/Black and White

1. At the Home screen, tap  > [Device].

2. Tap [Security Settings].

3. Tap [Print Accounting].

4. Tap [Unauthenticated User Print] > [Enable] > [OK].

5. Tap  to return to the previous screen.

6. Tap [Auto Color To Mono Print] > [Off] > [OK].

7. Turn off the machine, and then turn it on again.

Permitting Printing Only in Black and White

1. At the Home screen, tap  > [Device].

2. Tap [Security Settings].

3. Tap [Print Accounting].

4. Tap [Unauthenticated User Print] > [Enable] > [OK].
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5. Tap  to return to the previous screen.

6. Tap [Auto Color To Mono Print] > [On] > [OK].

7. Turn off the machine, and then turn it on again.

Checking Printing Usage
Print a Printer Meter report to check the current settings of printing restrictions and the total number 
of printed pages.

Refer
 For details on how to print an Accounting report, refer to "Checking by User or Paper Size" (P.201).

10.5 Using the User Authentication Feature

Overview
When the user authentication feature is enabled, you can restrict access to the features of the 
machine on each user.
To use the machine, registered users log in to a registered user account using the operator panel. A 
registered user who uses the machine without logging in will be treated as a guest user.

Note
 The features that are restricted by [User Permissions] cannot be used even if they are permitted by the 

Authentication feature.
For details on [User Permissions] settings, refer to "[User Permissions]" (P.136).
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The following illustration shows how the machine works with the User Authentication feature.

The work flow from configuring User Authentication settings to using the feature is as follows:
 "Enabling User Authentication" (P.175)
 "Configuring settings for user registration and restrictions" (P.176)

Configuring the User Authentication Feature Settings
To use the User Authentication feature, it is necessary to configure the settings in Internet Services.

Enabling User Authentication

1. Enter IP address of the machine in the web browser and start Internet Services.

Note
 To check the machine's IP address, press the  (Home) button on the operator panel, and tap  > 

[Device] > [About].

Setting usage restrictions on each registered user

User name

Password

Usage 
restrictions

ABC

XXXX

· Copying  
 prohibited

User A

DEF

XXXX

· No restrictions

User BRegistered user

Usage 
restrictions

· Copying prohibited

· Scanning prohibited

· Faxing prohibited

Setting usage restrictions on guest users

User 
authentication

Login to the machine 
with a registered account

Registered user

Unable to use the 
restricted functions

Guest user

Account information

User name Password

ABC xxxx
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2. Click on [Log In] in the upper right part of the screen.

3. Enter the [User Name] and [Password] for the administrator, and click on [Log In].

Refer
 For details on the default user name and password, refer to "Logging in" (P.152).

4. Click on [System] in the upper part of the screen.

5. Click on [Security].

6. Click on [User Authentication].

7. Select [Local], and click on [OK].

8. When the confirmation screen appears, click [Change].

9. Click on [Restart Now].

10. Once the machine completes restart, click on [Refresh].

Configuring settings for user registration and restrictions
Register user account information with the machine, and set usage restrictions on each feature for 
each user.
You must be logged in the Internet Services as an administrator to configure settings.

1. Enter IP address of the machine in the web browser and start Internet Services.

Note
 To check the machine's IP address, press the  (Home) button on the operator panel, and tap  > 

[Device] > [About].
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2. Click on [Log In] in the upper right part of the screen.

3. Enter the [User Name] and [Password] for the administrator, and click on [Log In].

Refer
 For details on the default user name and password, refer to "Logging in" (P.152).

4. Click on [Permissions] in the upper part of the screen.

5. Click [User Accounts] > [Edit].

6. Click on [Add New Account].

7. Configure [User Name], [Password] and [Retype Password], then click [Add].

8. Repeat steps 5 through 7 as needed to add user accounts.

9. Set the usage restrictions for each feature.

To set the usage restrictions on a guest user:

1)Click [Edit] > [Guest User Settings].

2)Click the desired setting item, and then change the settings.

Refer
 For details on setting items, refer to Internet Services Help.

3)Click on [OK].

To set the usage restrictions on a registered user:

1)Click the added user account.

2)Click [Permissions] > [Edit].

3)Click the desired setting item, and then change the settings.
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Refer
 For details on setting items, refer to Internet Services Help.

4)Click on [OK].

Logging in as a Registered User

1. Tap  on the upper left part of the Home screen.

Note
 When the user authentication feature is enabled,  will be displayed.

2. Tap the user account to login.

3. Enter the passcode and tap [OK].
When you log in, your user icon is displayed in the upper left part of the Home screen.

Logging out Registered Users

1. Tap the user icon in the upper left part of the Home screen.

2. Tap [Logout].

10.6 Using the Encryption Feature
When the encryption feature is used, data can be encrypted for transmission to prevent data 
falsification. A digital certificate is required to use the machine's encryption feature.

Note
 The machine supports the following kinds of digital certificates:

- Self-signed certificate created using Internet Services
- Certificate signed by the certificate authorities (CA)

 The machine can import the digital certificates of the following formats:
- PKCS#12 (DER encoded)
- PKCS#7 (for CSR) (DER encoded)

Use Internet Services to configure encryption feature.

Preparing for Encryption

Enabling the SSL/TLS Server Communication
Before using the encryption feature with digital certificates, enable the SSL/TLS server 
communication.

1. Enter IP address of the machine in the web browser and start Internet Services.

Note
 To check the machine's IP address, press the  (Home) button on the operator panel, and tap  > 

[Device] > [About].
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2. Click on [Log In] in the upper right part of the screen.

3. Enter the [User Name] and [Password] for the administrator, and click on [Log In].

Note
 For details on the default user name and password, refer to "Logging in" (P.152).

4. Click on [System] in the upper part of the screen.

5. Click on [Security].

6. Click on [SSL/TLS Settings].

7. Click on  for [HTTP - SSL/TLS Communication] to select the checkbox.

8. Click on [OK].

9. Click on [Restart Now].

Generating a Digital Certificate
Setting procedure differs for self-signed certificate created using Internet Services and certificate 
signed by Certificate Authorities (CA).

Generating a Self-Signed Certificate

1. Enter IP address of the machine in the web browser and start Internet Services.

Note
 To check the machine's IP address, press the  (Home) button on the operator panel, and tap  > 

[Device] > [About].
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2. Click on [Log In] in the upper right part of the screen.

3. Enter the [User Name] and [Password] for the administrator, and click on [Log In].

Note
 For details on the default user name and password, refer to "Logging in" (P.152).

4. Click on [System] in the upper part of the screen.

5. Click on [Security].

6. Click on [Security Certificates].

7. Make sure that [Device Certificates] is selected, and click on [Create].

8. Click on [Create Self-Signed Certificate].

9. Select a digital signature algorithm from [Digital Signature Algorithm].

10. Select a public key size from [Public Key Length].

11. Set the certificate's period of validity from [Validity Period].

12. Click on [Create].

13. Click on [Close].

Using a Certificate Signed by the Certificate Authorities (CA)
When using a certificate signed by the certificate authorities (CA), generate the certificate signing 
request (CSR), and receive the signed certificate from the certificate authorities (CA).

 Generating the Certificate Signing Request (CSR)

1. Enter IP address of the machine in the web browser and start Internet Services.
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Note
 To check the machine's IP address, press the  (Home) button on the operator panel, and tap  > 

[Device] > [About].

2. Click on [Log In] in the upper right part of the screen.

3. Enter the [User Name] and [Password] for the administrator, and click on [Log In].

Note
 For details on the default user name and password, refer to "Logging in" (P.152).

4. Click on [System] in the upper part of the screen.

5. Click on [Security].

6. Click on [Security Certificates].

7. Make sure that [Device Certificates] is selected, and click on [Create].

8. Click on [Create Certificate Signing Request (CSR)].

9. Specify each item.

10. Click on [Create].

11. Click on [Download].
A CSR file is saved to your computer.

Important
 Once the CSR file is downloaded, do not download another CSR before you import the certificate. If you 

generate another CSR, the secret key stored in the machine does not match with the secret key included 
in the signed certificate, and you cannot import the certificate.

12. Click on [Close].

13. Send the CSR file to the certificate authority (CA) and receive the CA-signed certificate.
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Note
 For details about how to send the CSR, follow the procedure specified by the certificate authority (CA).

 Importing a Certificate Signed by the Certificate Authorities (CA)

Important
 Before importing a certificate file, backup the certificate file.

Note
 After importing a PKCS#12 format certificate, the secret key is not exported even if you perform 

exporting.

1. Enter IP address of the machine in the web browser and start Internet Services.

Note
 To check the machine's IP address, press the  (Home) button on the operator panel, and tap  > 

[Device] > [About].

2. Click on [Log In] in the upper right part of the screen.

3. Enter the [User Name] and [Password] for the administrator, and click on [Log In].

Note
 For details on the default user name and password, refer to "Logging in" (P.152).

4. Click on [System] in the upper part of the screen.

5. Click on [Security].

6. Click on [Security Certificates].

7. Click on [Device Certificates], and select [Trusted Root CA Certificates] or [Intermediate CA 
Certificates].

8. Click on [Import].

9. Click on [Select] and select the files to be imported.
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10. Enter a password corresponding to the certificate file to be imported.

Note
 The password is not necessary when importing a PKCS#7 format certificate, which has the filename 

extension of p7b.

11. Enter the password again to confirm it.

12. Click on [Import].

Selecting the Certificate

1. Enter IP address of the machine in the web browser and start Internet Services.

Note
 To check the machine's IP address, press the  (Home) button on the operator panel, and tap  > 

[Device] > [About].

2. Click on [Log In] in the upper right part of the screen.

3. Enter the [User Name] and [Password] for the administrator, and click on [Log In].

Note
 For details on the default user name and password, refer to "Logging in" (P.152).

4. Click on [System] in the upper part of the screen.

5. Click on [Security].

6. Click on [Security Certificates].

7. Click on [Device Certificates], and select [Trusted Root CA Certificates], [Intermediate CA 
Certificates] or [Other Certificates].

8. Click the certificate you want to use.
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9. Check the certificate.

Note
 Make sure that [On] is displayed in the [Validity] column for the selected certificate.

10. Click on [Close].

11. Click on [SSL/TLS Settings].

12. Click [Device Certificate - Server], and then select the certificate to be used.

13. Click on [OK].

14. Click on [Restart Now].

15. Once the machine completes restart, click on [Refresh].

Refer
 For details on deleting or exporting digital certificates, refer to Internet Services Help.

Setting the Encryption Features
The following encryption features can be used:
 Encrypting the HTTP communication and the IPP printing
 Encrypting the SMTP communication
 Encrypting the LDAP communication
 Wireless LAN connection with WPA-Enterprise

Encrypting the HTTP Communication and the IPP Printing
When the communication between the web browser and the machine is encrypted, enter the 
address in the address text box, starting with "https" instead of "http."
 Example of entering the IP address

https://192.0.2.1/ (for IPv4 network)
https://[2001:DB8::1234]/ (for IPv6 network)

 Example of entering the Internet address
https://myhost.example.com/

To encrypt the IPP communication (Internet printing), enter the URL of the machine, starting with 
"https" instead of "http" when you add the machine to your computer.

Encrypting the SMTP Communication

1. Enter IP address of the machine in the web browser and start Internet Services.

Note
 To check the machine's IP address, press the  (Home) button on the operator panel, and tap  > 

[Device] > [About].
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2. Click on [Log In] in the upper right part of the screen.

3. Enter the [User Name] and [Password] for the administrator, and click on [Log In].

Note
 For details on the default user name and password, refer to "Logging in" (P.152).

4. Click on [System] in the upper part of the screen.

5. Click on [Security].

6. Click on [SSL/TLS Settings].

7. Click on [SMTP - SSL/TLS Communication] and select your connection method.

8. Click on [OK].

Encrypting the LDAP Communication

1. Enter IP address of the machine in the web browser and start Internet Services.

Note
 To check the machine's IP address, press the  (Home) button on the operator panel, and tap  > 

[Device] > [About].
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2. Click on [Log In] in the upper right part of the screen.

3. Enter the [User Name] and [Password] for the administrator, and click on [Log In].

Note
 For details on the default user name and password, refer to "Logging in" (P.152).

4. Click on [System] in the upper part of the screen.

5. Click on [Security].

6. Click on [SSL/TLS Settings].

7. Click on  for [LDAP - SSL/TLS Communication] to select the checkbox.

8. Click on [OK].

9. Click on [Restart Now].

10. Once the machine completes restart, click on [Refresh].

Wireless LAN Connection With WPA-Enterprise

For EAP-TLS

1. Enter IP address of the machine in the web browser and start Internet Services.

Note
 To check the machine's IP address, press the  (Home) button on the operator panel, and tap  > 

[Device] > [About].
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2. Click on [Log In] in the upper right part of the screen.

3. Enter the [User Name] and [Password] for the administrator, and click on [Log In].

Note
 For details on the default user name and password, refer to "Logging in" (P.152).

4. Click on [Network] in the upper part of the screen.

5. Click on [Connections]>[Wi-Fi].

6. From [Security Settings]>[Encryption Type], select [WPA2 Enterprise].

Note
 This can be used only when [Infrastructure] is specified for [Network Type].

7. From [Authentication Method], select [EAP-TLS].

8. Click [Root Certificate], and then select the root certificate.

9. Click on [Client Certificate], and then select the client certificate.

10. Configure [EAP-Identity] settings.

11. Click on [OK].

12. Click on [Restart Now].

13. Once the machine completes restart, click on [Refresh].

For PEAPv0 MS-CHAPv2, EAP-TTLS/PAP or EAP-TTLS/CHAP

1. Enter IP address of the machine in the web browser and start Internet Services.

Note
 To check the machine's IP address, press the  (Home) button on the operator panel, and tap  > 

[Device] > [About].
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2. Click on [Log In] in the upper right part of the screen.

3. Enter the [User Name] and [Password] for the administrator, and click on [Log In].

Note
 For details on the default user name and password, refer to "Logging in" (P.152).

4. Click on [Network] in the upper part of the screen.

5. Click on [Connections]>[Wi-Fi].

6. From [Security Settings]>[Encryption Type], select [WPA2 Enterprise].

Note
 This can be used only when [Infrastructure] is specified for [Network Type].

7. From [Authentication Method], select [PEAPv0 MS-CHAPv2], [EAP-TTLS/PAP] or [EAP-TTLS/
CHAP].

8. Click [Root Certificate], and then select the root certificate.

9. Configure [EAP-Identity], [Login Name], [Password] and [Retype Password].

10. Click on [OK].

11. Click on [Restart Now].

12. Once the machine completes restart, click on [Refresh].
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11 Maintenance
11.1 Replacing Consumables

The following consumables are supplied as the replaceable items.
 Toner cartridge
 Drum cartridge
 Waste toner container
When the time for replacing a consumable part approaches, a message appears on the touch panel 
display.
For details on replacement procedures, refer to the packaging containing the consumable part.

WARNING
 Never use a vacuum cleaner for spilled toner and residual toner in this product, toner 

cartridge or waste toner container. It may catch fire by electric sparks inside a vacuum 
cleaner and cause explosion. Use a broom or a wet cloth to wipe off the spills. If you spill a 
large volume of toner, contact our local representative.

 Never throw a toner cartridge into an open flame. Remaining toner in the cartridge may 
catch fire and cause burn injuries or explosion. If you have a used toner cartridge no longer 
needed, contact our local representative for its disposal.

 Never throw a waste toner container an open flame. Toner may catch fire and cause burn 
injuries or explosion. If you have a used waste toner bottle no longer needed, contact our 
local representative for its disposal.

CAUTION
 Keep toner cartridge and drum cartridge out of the reach of children. If a child accidentally 

swallows toner, spit it out, rinse mouth with water, drink water and consult a physician 
immediately.

 When replacing toner cartridge and drum cartridge, be careful not to spill the toner. In case 
of any toner spills, avoid contact with clothes, skin, eyes and mouth as well as inhalation.

 Perform the corresponding first-aid treatment in the following cases.
- If toner spills onto your skin or clothing, wash it off with soap and water.
- If you get toner particles in the eyes, wash it out with plenty of water for at least 15 

minutes until irritation is gone. Consult a physician if necessary.
- If you inhale toner particles, move to a fresh air location and rinse your mouth with water.
- If you swallow toner, spit it out, rinse your mouth with water, drink plenty of water and 

consult a physician immediately.
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Important
 When replacing a drum cartridge, do not touch the areas indicated in the illustration. This could cause 

poor print quality.

11.2 Cleaning the Machine
WARNING
 When cleaning this product, use the designated cleaning materials exclusive to it. Other 

cleaning materials may result in poor performance of the product. Never use aerosol 
cleaners to avoid catching fire and explosion.

CAUTION
 When cleaning this product, always switch off and unplug it. Access to a live machine 

interior may cause electric shock.

Cleaning Outside the Machine
Important
 Using volatile solvents such as benzine or thinner, or spraying with insecticide may cause discoloration, 

deformation, or cracks on the covers or exterior.
 When the exterior gets too much wet, the machine may break down, or documents may be torn while 

copying.

1. Wipe the exterior of the machine with a soft, moistened, and tightly-squeezed cloth.
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Important
 Use only water or neutral detergent, and never use other solutions.

Note
 When stains cannot be removed easily, wipe lightly with the soft cloth slightly moistened with a thin 

neutral detergent solution.

2. Wipe the moisture off with a dry soft cloth.

Cleaning the Touch Panel
1. Wipe the touch panel surface lightly with a soft cloth moistened with a neutral detergent or 

alcohol.

Important
 When you moisten a cloth with a neutral detergent or alcohol, make sure that no drips come of the cloth. 

When the cloth is heavily soaked with detergent or alcohol, squeeze the cloth lightly.
 Using volatile solvents such as benzine or thinner or spraying with insecticide may cause discoloration, 

deformation, or cracks on the covers or exterior.
 Do not wipe the panel strongly, as it may damage the panel. Wipe lightly.

Cleaning Inside the Machine

Cleaning the LED Print Head
If you have image quality problems such as stripes appearing on copied or printed outputs, clean the 
LED print head.

1. Confirm that the machine has stopped, and open the right side cover.
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2. Release the toner cartridge lock.

3. Remove all four toner cartridges.

4. Release the waste toner container lock.

5. Remove the waste toner container.
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6. Remove the cleaning rod.

7. Insert the cleaning rod into one of the four holes of the tabs on the drum cartridge until it stops, 
and then pull it out.

Note
 Insert the cleaning rod with the pad side up.

8. Repeat step 7 for the remaining three holes.

9. Replace the cleaning rod.



194 11   Maintenance

10. Press the waste toner container into the machine until you hear a "click" sound.

11. Align the protrusion on the underside of the toner cartridge with the indentation in the machine, 
then press the toner cartridge into the machine until you hear a "click" sound.

12. Load the remaining toner cartridges.

13. Close the right side cover.
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Cleaning the Paper Feeder Rollers
Paper jams may occur if paper does not feed correctly. To prevent problems, regularly clean the 
paper feed rollers of the Bypass Tray, Tray 1, and Tray 2 (250-Sheet Feeder) (optional).

Cleaning the Bypass Tray Paper Feeder Rollers

1. Turn off the machine.

Refer
 For details on how to turn the power supply off, refer to "Turning Off the Machine" (P.16).

2. Open the Bypass Tray.

3. Open the cover.

4. Wipe the paper feeder rollers with a soft dampened cloth, then close the cover.

5. Close the Bypass Tray.
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6. Supporting the paper tray with both hands, pull it out completely.

7. Place a finger on the lever and press it downward.

8. Wipe the rollers in the machine with a soft dampened cloth.

Important
 Do not force the paper feeder rollers to rotate. Doing so may damage the machine.

9. Insert the paper tray into the machine main unit, and press it in slowly until it stops.
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Cleaning the Paper Feeder Rollers of Tray 1, Tray 2 (250-Sheet Feeder) (Optional)

1. Turn off the machine.

Refer
 For details on how to turn the power supply off, refer to "Turning Off the Machine" (P.16).

2. Supporting the paper tray with both hands, pull it out completely.

3. Manually rotate the paper feeder rollers while gently wiping them with a soft dampened cloth.

4. Manually rotate the rollers in the machine while gently wiping them with a soft dampened cloth.

Important
 Do not place the machine on its side. Doing so may spill toner.
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 Do not touch any other internal parts of the machine. Doing so may damage the machine.

5. Insert the paper tray into the machine main unit, and press it in slowly until it stops.

Cleaning the Document Glass Cover, Document 
Glass, Document Presser and Narrow Glass Strip

When the document glass cover or document glass become dirty, this could result in soiling of the 
copy, fax and scan output. To ensure clean output results at all times, perform cleaning about once a 
month.

Important
 Do not use chemicals such as benzine or thinner. Doing so may damage the paint or coating on plastic 

parts.
 Use only water or neutral detergent, and never use other solutions.
 When the exterior gets too much wet, the machine may break down, or documents may be torn while 

copying, faxing, or scanning.

Note
 When stains cannot be removed easily, wipe lightly with the soft cloth slightly moistened with a thin 

neutral detergent solution.

1. Open the document glass cover.
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2. Wipe the document presser, document glass cover, document glass and narrow glass strip with a 
soft dampened cloth. Use a dry cloth or paper towel to completely remove any remaining 
moisture.

1 Document Glass Cover
2 Document Glass
3 Narrow Glass Strip
4 Document Presser

Note
 Be careful not to damage the document presser.

For Apeos C325 dw, proceed to step 6.

3. Pull on the knob to open the chute cover.

4. Wipe the two-sided sensor glass and narrow glass strip cover with a soft dampened cloth. Use a 
dry cloth or paper towel to completely remove any remaining moisture.

1 Two-sided Sensor Glass

3

4

2

1

1

2
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2 Narrow Glass Strip Cover

5. Close the chute cover.

6. Close the document glass cover.

Cleaning the Document Feeder Rollers
When the document feeder rollers become dirty, this could result in paper jams, and in spots or 
stains appearing on copies, faxes and scans.
To ensure clean output results at all times, perform cleaning about once a month.

Important
 Do not use chemicals such as benzine or thinner. Doing so may damage the paint or coating on plastic 

parts.
 When the exterior gets too much wet, the machine may break down, or documents may be torn while 

copying, faxing, or scanning.

1. Pull up on the handle on the lefthand side cover (upper cover) of the Document Feeder, and open 
it to its fullest extent.

2. Gently clean the rollers and pads with a cloth dampened with a small amount of water.

Important
 Use only water or neutral detergent, and never use other solutions.
 Use a cloth firmly wrung to prevent water drops from falling into the machine. If water gets into the 

machine, it may cause the machine to malfunction.

Note
 When stains cannot be removed easily, wipe lightly with the soft cloth slightly moistened with a thin 

neutral detergent solution.
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3. Close the lefthand side cover of the Document Feeder, pressing until it clicks into place, and check 
to ensure that the cover is not raised in the front or back.

11.3 Counting up the Number of Printed 
Pages

The total number of printed pages can be checked by meter, by user, or by paper size. One-sided 
print is counted as one job, and two-sided print is counted as two.

Checking by Meter
There are three meters classified according to color mode.

1. At the Home screen, tap  > [Device].

2. Tap [Billing Meters].

Refer
 For details on each meter, refer to "[Billing Meters]" (P.120).

Checking by User or Paper Size
Check the number of pages on the printed report.

Note
 When [Print Accounting] is disabled, you can check the output page count for each paper size.
 When [Print Accounting] is enabled, prints from jobs for which there is no account information will be 

included as [Unauthenticated User Print] in the report.
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1. At the Home screen, tap  > [Device].

2. Tap [Information Pages] > [Printer Meter].

11.4 Adjusting Image Position ([Image 
Position])

If the output image is misaligned, enter the adjustment value to make the correction.

Printing a Chart
1. Load either of the following paper sizes into the paper tray to be adjusted.

 A4
 8.5×11

2. At the Home screen, tap  > [Device].

3. Tap [Maintenance] > [Image Position] > [Print Chart].

4. Tap [Paper Trays].

5. Select the tray be adjusted, and tap  to return to the previous screen.

6. Tap [2-Sided Printing].

7. Select [1-Sided] or [2-Sided], and tap  to return to the previous screen.
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8. Tap [Start].
A chart will be printed.

9. Check the printed chart.
If the output image is aligned properly, a line will be printed 10 mm from the edge of the paper. If the 
line is misaligned, adjustment is necessary.

Note
 A square symbol is printed on the trailing edge of the paper to display the paper feed direction. One 

square  is printed on the front side, and two squares  are printed on the back side.
 When [Lead/Side Registration] adjustment is needed

 When [Perpendicularity] adjustment is needed

Refer
 For details on [Lead/Side Registration] adjustment, refer to "Adjusting [Lead/Side Registration]" (P.204).
 For details on [Perpendicularity] adjustment, refer to "Adjusting [Perpendicularity]" (P.205).

10 mm
10 mm

10 mm
10 mm

Paper feed direction

Desired image

Current image

Side registration
misalignment

Lead registration
misalignment

B

A

Fast scan direction
Slow scan direction
(Paper feed direction)
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Adjusting [Lead/Side Registration]
At [Lead/Side Registration], you can adjust both the front and back sides.

1. Check the chart, and measure the amount (mm) of misalignment in the image position.
Adjustment amount (mm) = distance (mm) of the actual image position from the edge of the paper -
10

2. At the Home screen, tap  > [Device].

3. Tap [Maintenance] > [Image Position] > [Lead/Side Registration].

4. Select the tray to adjust.

5. Select the side to adjust (front or back).

6. Add the value for the amount of misalignment confirmed in step 1 to the current settings value, 
and tap [OK].

Lead Registration
If the image in the step 1 diagram shifts downward, specify a positive [+] value. If it shifts upward, 
specify a negative [-] value.

Side Registration
If the image in the step 1 diagram shifts to the left, specify a positive [+] value. If it shifts to the right, 
specify a negative [-] value.

10 mm

10 mm

10 mm

10 mm

Desired image

Current image

Side registration
misalignment

Lead registration
misalignment
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(Ex.: Front side adjustment screen)

7. Print a chart when needed to check the adjustment results.

Refer
 For details, refer to "Printing a Chart" (P.202).

Adjusting [Perpendicularity]
At [Perpendicularity], you can adjust both the front and back sides, but the adjustments will affect all 
trays.

1. Check the chart, and measure the amount (mm) of misalignment in the image position.
Use the following formula to obtain the amount of perpendicularity misalignment, with the leading 
edge of the paper facing upward, "A" representing the lead registration length (mm) of the left edge 
and "B" representing the lead registration length (mm) of the right edge.
Amount of perpendicularity misalignment (mm) = (A-B) x 216 / (main scanning direction [mm] - 20)

2. At the Home screen, tap  > [Device].

B

A

Fast scan direction
Slow scan direction
(Paper feed direction)
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3. Tap [Maintenance] > [Image Position].

4. Tap [Perpendicularity].

5. Select the side to adjust (front or back).

6. Add the value for the amount of print position misalignment confirmed in step 1 to the current 
settings value, and tap [OK].
If the image forms a parallelogram that slopes down to the right when the leading edge of the paper 
is facing upward and you want to correct it to a rectangle, press the minus sign [-] to enter the 
adjustment value. If the parallelogram to be corrected slopes down to the left, press the plus sign [+].
(Ex.: Front side adjustment screen)

7. Print a chart when needed to check the adjustment results.

Refer
 For details, refer to "Printing a Chart" (P.202)

11.5 Adjusting Color Registration ([Adjust 
Color Registration])

If color registration is misaligned in print output, adjust color registration (color registration 
misalignment) either automatically or manually. Perform manual adjustment by printing a chart 
when a left-right difference in color registration misalignment amount (tilt) occurs.
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Adjusting Automatically
1. At the Home screen, tap  > [Device].

2. Tap [Maintenance] > [Adjust Image Quality] > [Adjust Color Registration].

3. Tap [Auto Registration].

4. Tap [Start].
Color registration will be corrected automatically.

Adjusting Manually
1. Load either of the following paper sizes into the paper tray.

 A4
 8.5×11

2. At the Home screen, tap  > [Device].

3. Tap [Maintenance] > [Adjust Image Quality] > [Adjust Color Registration].

4. Tap [Manual Registration].

5. Tap [Print Chart].

6. Tap [Start].
A chart will be printed.
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7. Check the printed chart.
Reference lines are located on both sides of the chart. Look to both sides of a given color, and 
confirm the value at which the black and colored lines are most closely aligned.
If the numerical values at left and right differ, enter each observed value to make the adjustment. If 
the numerical values are the same (same degree of misalignment), adjustment is not necessary. You 
can enter numerical values between those printed on the chart, for adjustments at one-integer 
increments from +10 to -10.

8. Tap [Enter Adjustment Value].

Note
 Once back at the Home screen, perform steps 2 - 4.

9. Select the items requiring adjustment from among the values confirmed in step 7.

Confirmation lines Confirmation lines
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10. Specify the values you checked, and tap  to return to the previous screen.

11. Configure other adjustment items as needed.

12. Tap [Start].

13. Tap [Close].

14. Repeat steps 2 - 6 as needed, printing a chart to check the adjustment results.

11.6 Adjusting Print Head Density (1 Stripe)
When streaks (lines) about 1mm wide appear in copy or print output, print a chart to make 
adjustments. There are charts for copying and for printing.

Note
 When no change occurs despite adjustment, it is necessary to restore the pre-adjustment value. Make a 

note of the pre-adjustment values, since the value on the input screen reverts to 0 after adjustment.

1. Load either of the following paper sizes into the paper tray.
 A4
 8.5×11

2. At the Home screen, tap  > [Device].

3. Tap [Maintenance] > [Adjust Image Quality] > [AdjPrintHdDensity(1Stripe)].

4. Tap [Print Chart].
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5. Tap [Target].

6. Select the item to be adjusted, and tap  to return to the previous screen.

7. Tap [Start].
A chart will be printed.

8. Look at the printed chart and check the color of the lines that appear.
If the pale lines of each color appear lighter than the adjacent ones, and the dark lines appear darker 
than the adjacent ones, adjust the value upward.
If the pale lines of each color appear darker than the adjacent ones, and the dark lines appear lighter 
than the adjacent ones, adjust the value downward.

Note
 The bottom-most part is for confirmation of the pale yellow line. Use it when the pale yellow line is 

difficult to see.

9. Tap [Enter Adjustment Value].

Note
 Once back at the Home screen, perform steps 2 - 4.

10. Tap [Target].

11. Select the item to be adjusted, and tap  to return to the previous screen.

12. Select the color requiring adjustment.
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13. Specify the calibration value, and tap  to return to the previous screen.

14. Configure other colors as needed.

15. Tap [Start].

16. Tap [Close].

17. Repeat steps 2 - 7 as needed, printing a chart to check the adjustment results.

11.7 Adjusting Print Head Density (Stripes)
Print a chart to make adjustments when regularly patterned streaks (vertical lines) of dark and light 
shading appear on copy or print output. When striping occurs throughout, perform common 
correction. When striping occurs in a specific 10.8 mm (chip), correct that chip individually.

Note
 Striping may occur in a specific chip for a specific color.
 When no change occurs despite adjustment, it is necessary to restore the pre-adjustment value. Make a 

note of adjustment values.

Printing a Chart
1. Load either of the following paper sizes into the paper tray.

 A4
 8.5×11
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2. At the Home screen, tap  > [Device].

3. Tap [Maintenance] > [Adjust Image Quality] > [AdjPrintHdDensity(Stripes)].

4. Tap [Print Chart].

5. Tap [Start].
A chart will be printed.

6. 10.8 mm width (chip) Check the printed chart.

10.8mm width (chip) 2010.8mm width (chip) 1
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Performing Common Correction
When striping occurs throughout, perform common correction. When striping occurs in a specific 
line (chip), correct that line individually.

1. At the Home screen, tap  > [Device].

2. Tap [Maintenance] > [Adjust Image Quality] > [AdjPrintHdDensity(Stripes)].

3. Tap [Chip Common Correction].

4. Select the color requiring adjustment.

5. Specify the calibration value, and tap  to return to the previous screen.
To make odd-numbered lines darker and even-numbered lines paler, enter a positive value. To make 
odd-numbered lines paler and even-numbered lines darker, enter a negative value.

6. Configure other colors as needed.

7. Tap [Start].

8. Tap [Close].

9. Print a chart to check the adjustment results as needed.

Refer
 For details, refer to "Printing a Chart" (P.211)
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Performing Individual Correction
1. At the Home screen, tap  > [Device].

2. Tap [Maintenance] > [Adjust Image Quality] > [AdjPrintHdDensity(Stripes)].

3. Tap [Individual Chip Correction].

4. Tap [Color].

5. Select the color requiring adjustment, and tap  to return to the previous screen.

6. Tap [Chip No.].

7. Specify the value for the chip No. requiring adjustment, and tap  to return to the previous 
screen.

8. Tap [Adjustment Value].
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9. Specify the adjustment value, and tap  to return to the previous screen.
To increase density, enter a positive value. To decrease density, enter a negative value.

10. Tap [Start].

11. Tap [Close].

12. Print a chart to check the adjustment results as needed.

Refer
 For details, refer to "Printing a Chart" (P.211)
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12 Troubleshooting
12.1 Clearing Jams

When a paper jam occurs, the touch panel display will indicate how to clear it. Follow the instructions 
shown on the touch panel display.

CAUTION
 Do not forcibly remove paper or shreds jammed inside the machine,

Take particular care not to forcefully remove paper when it has wrapped around fusing unit 
parts or rollers. This could cause burns or other injuries. Turn off the power switch 
immediately, and contact our local representative.

12.2 Troubleshooting
This section describes how to solve the problems with the machine.

Menu Settings Problems

Machine Problems

Problem Action
Menu settings changed from 
the operator panel have no 
effect.

Settings in the software, the print driver, or the printer utilities 
have precedence over the settings made on the operator panel.

Problem Possible Cause Action
The status LED is 
blinking in orange.

The system of the 
machine or the 
components installed may 
have a trouble.

Turn on the machine and re-enter your passcode. 
If the problem persists, consult our local 
representative.

Is paper or a document 
jammed?

Remove the jammed paper or document.

Is the cover of the 
machine open?

Follow the displayed message to solve the 
problem.

The display is dark. Is the  (Power Supply 
/ Power Saver) button 
illuminated?

The machine is in Power Saver mode. Press the 
 (Power Supply / Power Saver) button on the 

operator panel to leave Power Saver mode.
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Unable to print or 
copy.

Is a message displayed on 
the touch panel?

Follow the displayed message to solve the 
problem. Closed messages can be checked from 
the device management screen.

Refer
 For details on the device management screen, 

refer to "3. Device Management Screen" (P.34).

Is the memory full? Solve the problem by any of the following 
actions:
 Set [Image Quality] to [Standard] with the print 

driver
 Set unused ports to [Off].

Is the print driver in offline 
mode?

Open the printer icon and clear the check box for 
using the print driver in offline mode in the 
printer menu.

Printing does not 
start in spite of the 
instruction.

Is the Ethernet cable or 
USB cable disconnected? 
Is the machine connected 
to the wireless network?

Check the Ethernet and USB cable connections. 
When connecting to Wi-Fi, make sure that the 
necessary settings are configured.

Refer
 For details on connecting with LAN and USB 

cables, refer to "Connecting to a Wired (Ethernet) 
Network" (P.16) or "Connecting to a Computer 
With USB" (P.17).

 For details on wireless LAN connections, refer to 
"Connecting to a Wireless Network" (P.18).

Is the protocol to use 
enabled?

Enable the protocol to use.

Refer
 For details, refer to "[Protocol]" (P.130).

Problem Possible Cause Action



218 12   Troubleshooting

Paper is often 
jammed or 
wrinkled.

Is the paper tray mounted 
properly?

Mount the paper tray properly by inserting it 
securely all the way into the machine.

Refer
 For details, refer to "Loading Paper in Tray 1 / Tray 

2 (250-Sheet Feeder) (Optional)" (P.46).

Is the paper damp? Replace the paper with new paper.

Is the paper curled? Turn over the paper in the paper tray, or replace 
the paper with new paper.

Are the paper and paper 
tray settings correct?

Specify the paper and paper tray according to the 
loaded paper.

Refer
 For details, refer to "Loading Paper in Tray 1 / Tray 

2 (250-Sheet Feeder) (Optional)" (P.46).

Are any jammed sheets, 
scraps of paper or other 
foreign debris left inside 
the machine?

Open the cover of the machine or pull the paper 
tray to remove any shreds or foreign objects.

Is paper exceeding the 
maximum fill line in the 
paper tray?

Load paper in the paper tray so that it does not 
exceed the maximum fill line.

Refer
 For details, refer to "Loading Paper in Tray 1 / Tray 

2 (250-Sheet Feeder) (Optional)" (P.46).

Are the paper guides 
aligned properly?

Load the paper properly, and then align the paper 
guides with the paper so that the paper guides 
contact the paper lightly.

Refer
 For details, refer to "Loading Paper in Tray 1 / Tray 

2 (250-Sheet Feeder) (Optional)" (P.46) or 
"Loading paper in the Bypass Tray" (P.48).

Is the paper finely cut out? Some paper types may not be cut out finely. Flex 
and fan the paper well, and then load it again.

Refer
 For details, refer to "Flex and Fan the Paper" 

(P.46).

Documents are 
often jammed.

Are you using irregularly 
shaped documents or 
business cards, OHP film, 
thin or thick documents?

Correctly load the appropriate documents in the 
document feeder.

Refer
 For details, refer to "Loading a Document" (P.54).

Are there any sticky tags, 
paper clips or adhesive 
tape on the document?

Remove any sticky tags, paper clips or adhesive 
tape on the document before copying.

Are the document guides 
misaligned?

Adjust the document guide positions according to 
the document size that you want to load.

Refer
 For details, refer to "Loading a Document" (P.54).

Has a document torn 
partially, leaving a shred 
in the document feeder?

Open the top cover of the document feeder to 
check.

Problem Possible Cause Action



21912.2   Troubleshooting

The edge of the 
document is 
creased.

Is the document curled? Flatten the curl and load the document again.

The document gets 
stained.

Are the document feeder 
rollers dirty?

Clean the document feeder rollers.

Refer
 For details, refer to "Cleaning the Document 

Feeder Rollers" (P.200)

The document is 
not being fed.

Is the document wrinkled? Load the document properly.

Refer
 For details, refer to "Loading a Document" (P.54).

Is the document loaded 
correctly?

Is the document too thick 
or too thin?

Is the top cover of the 
document feeder open?

Close to securely the top cover of the document 
feeder.

Has document 
feeding failed, or 
have documents 
been fed in while 
overlapping?

Are the document feeder 
rollers dirty?

Clean the document feeder rollers.

Refer
 For details, refer to "Cleaning the Document 

Feeder Rollers" (P.200).

Is the loaded document 
paper compatible with the 
machine's settings?

Switch the document media to a type that is 
compatible with the machine's specifications.

Refer
 For details, refer to "Loading a Document" (P.54).

Is the document loaded 
correctly in the document 
feeder?

Load the document properly.

Refer
 For details, refer to "Loading a Document" (P.54).

Are the document feeder 
document guides 
adjusted correctly?

Load the paper correctly, and then align the 
paper guides with the paper so that the paper 
guides contact the paper lightly.

Refer
 For details, refer to "Loading the Document 

Feeder" (P.54).

Does the number of 
documents exceed the 
capacity of the document 
feeder?

Load a number of documents in the document 
feeder that is within its capacity limit.

Is the document curled? Replace the paper with new document.

Are the documents 
sticking together?

Flex and fan the documents well before loading 
them into the document feeder.

Problem Possible Cause Action
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Print Quality Problems
Problem Possible Cause Action

The printed result 
is too light (faded, 
unclear).

The paper is damp. Replace the paper with new paper.

The drum cartridge has 
deteriorated or been 
damaged.

Replace the drum cartridge with a new one.

No toner is left in the 
toner cartridge.

Replace the toner cartridge with a new one.

Black spots appear 
in printouts.

The drum cartridge has 
deteriorated or been 
damaged.

Replace the drum cartridge with a new one.

Black or colored 
lines appear in 
printouts.

The drum cartridge has 
deteriorated or been 
damaged.

Replace the drum cartridge with a new one.

The narrow glass strip is 
dirty.

Clean the narrow glass strip.

Refer
 For details, refer to "Cleaning the Document Glass 

Cover, Document Glass, Document Presser and 
Narrow Glass Strip" (P.198).

The document is dirty. Clean the document.
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Dirt appears at 
regular intervals in 
the printout.

The paper feed path gets 
stained.

Print several sheets.

The drum cartridge has 
deteriorated or been 
damaged.

Replace the drum cartridge with a new one.

White spots 
appear in areas of 
black fill.

The paper is unsuitable. Load the correct type of paper.

The drum cartridge has 
deteriorated or been 
damaged.

Replace the drum cartridge with a new one.

The printout comes 
off on the fingers.
The toner is not 
fused to the paper.
The paper gets 
stained with toner.

The paper is damp. Replace the paper with new paper.

The paper is unsuitable. Load the correct type of paper.

The specified paper type 
does not match the type 
of the paper loaded in the 
tray.

Specify the paper type correctly.

Refer
 For details on paper type settings, refer to 

"Loading Print Media" (P.46).

The entire printout 
is black.

The drum cartridge has 
deteriorated or been 
damaged.

Replace the drum cartridge with a new one.

A high-voltage power 
supply failure may have 
occurred.

Contact our local representative.

Problem Possible Cause Action
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The printout is 
blank.

Multiple sheets of paper 
are fed through the 
machine at once (double 
feeding).

Flex and fan the paper well, and then load it 
again.

A high-voltage power 
supply failure may have 
occurred.

Contact our local representative.

The printout 
contains white 
areas, or white or 
colored stripes.

The paper is damp. Replace the paper with new paper.

The paper is unsuitable. Load the correct type of paper.

The entire printout 
is faint.

When printing using the 
Bypass Tray, the paper 
size specified in the print 
driver is different from the 
size and type of the paper 
actually loaded.

Load the Bypass Tray with the correct type and 
size of paper.

Refer
 For details, refer to "Loading paper in the Bypass 

Tray" (P.48).

Multiple sheets of paper 
are fed through the 
machine at once.

Flex and fan the paper well, and then load it 
again.

Refer
 For details, refer to "Flex and Fan the Paper" 

(P.46).

A high-voltage power 
supply failure may have 
occurred.

Contact our local representative.

The paper is 
wrinkled.

The paper is unsuitable. Load the correct type of paper.

Paper has been added to 
the paper loaded.

Replace the paper with new paper.

The paper is damp.

Problem Possible Cause Action
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Text is blurry. The paper is unsuitable. Replace the paper with new paper.

Paper has been added to 
the paper loaded.

The paper is damp.

Vertical patterns of 
uneven density 
appear in halftone 
images.

The paper is dry. With [Adjust 2nd BTR], decrease the value to 
decrease the voltage.

Refer
 For details, refer to "[Adjust 2nd BTR]" (P.141)

White or color 
patches appear 
vertically.

The internal components 
of the machine may be 
soiled.

Use the cleaning rod to clean the inside of the 
machine, print a demo page, and check the 
output result.

Refer
 For details, refer to "Cleaning the LED Print Head" 

(P.191).

The drum cartridge has 
deteriorated or been 
damaged.

Replace the drum cartridge with a new one.

No toner is left in the 
toner cartridge.

Replace the toner cartridge with a new one.

The printout is 
slanted.

The paper guides of the 
paper tray are not aligned 
properly.

Align the horizontal and vertical paper guides 
properly.

Refer
 For details, refer to "Loading Paper in Tray 1 / Tray 

2 (250-Sheet Feeder) (Optional)" (P.46) or 
"Loading paper in the Bypass Tray" (P.48).

Problem Possible Cause Action
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Copy Problems

Copy Output Problems
Problem Possible Cause Action

Copies get stained. Is the document glass 
cover or document glass 
soiled?

Clean the document glass cover or document 
glass.

Refer
 For details, refer to "Cleaning the Document Glass 

Cover, Document Glass, Document Presser and 
Narrow Glass Strip" (P.198).

The internal components 
of the machine is soiled.

Use a cleaning rod and clean the machine.

Refer
 For details, refer to "Cleaning Inside the Machine" 

(P.191).

A highly translucent 
document is used.

With highly translucent documents, any 
discoloration of the document glass cover will 
show up in the copy. Place a white sheet of paper 
over the document when copying.

Colored or rough paper, or 
a blueprint is used as the 
document.

The background color of the document shows up 
in the copy. Adjust the copy density, specify the 
image type, or specify the background 
suppression feature to remove the background 
paper color before copying.

Glossy printing paper is 
used as the document.

Glossy printing paper easily sticks to the 
document glass, and shadows can resemble dirt 
in the copy. Place a transparent sheet such as 
transparency film under the document before 
copying.

Copies are too dark 
or too light.

The specified image type 
setting is not suitable to 
the document.

When copies of black characters appear faint, in 
[Original Type] select [Text].

Refer
 For details, refer to "[Original Type]" (P.71).

The color of the 
copy differs from 
that of the 
document.

The calibration is not 
correct.

Perform the calibration.

Refer
 For details, refer to "[Calibration]" (P.142).

The specified document 
type is not suitable to the 
document.

From [Original Type], select a quality suitable to 
the document type.

Refer
 For details, refer to "[Original Type]" (P.71).

The specified image type 
setting is not suitable to 
the document.

When copies of black characters appear faint, in 
[Original Type] select [Text].

Refer
 For details, refer to "[Original Type]" (P.71).
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Copies have 
missing parts in 
them.

The paper is damp. Damp paper creates missing parts or unclear 
copies. Replace the paper with new paper.

Creased or wrinkled paper 
is loaded in the paper tray.

Remove any problematic sheets, or replace the 
paper with new paper.

A cut-and-pasted or 
creased document is 
used.

Cut-and-pasted or creased parts of the 
document may not be making proper contact 
with the document glass. Place a stack of white 
paper on top of the document to bring it into 
proper contact with the document glass.

The document gets 
dirty when making 
copies.

The document feeder 
rollers are dirty.

Clean the document feeder rollers.

Refer
 For details, refer to "Cleaning the Document 

Feeder Rollers" (P.200).

Striped patterns 
appear in copies.

The zoom ratio for the 
document is too large.

When making enlarged copies, some zoom ratio 
can create striped patterns. Adjust the zoom 
ratio.

Refer
 For details, refer to "[Reduce/Enlarge]" (P.71).

Copied images are 
misaligned or bent.

The document loaded on 
the document glass is 
misaligned.

Load the document properly, in alignment with 
the top left corner of the document glass.

The document feeder 
document guide is 
incorrectly positioned.

Load the document properly, and then align the 
document guides with the edges of the 
document.

The paper tray is not 
securely mounted.

Mount the paper tray properly by inserting it 
securely all the way into the machine.

The edges of 
copies are cut off.

The specified sizes of the 
document and paper do 
not match (document is 
oversized).

Match the paper to the document or adjust the 
zoom ratio.

Problem Possible Cause Action
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Printing Problems

Unable to Print

Print Output Problems

Fax Problems

Problem Possible Cause Action
Data remains in the 
printer icon.

The machine is turned off. Turn on the machine.

The Ethernet cable on the 
computer is disconnected.

Connect the Ethernet cable to the computer.

The computer is not 
connected to the wireless 
network.

Connect the computer to the wireless network.

The cable of the machine 
is disconnected or the 
machine is not connected 
to the wireless network.

Connect the cable to the machine. When 
connecting to Wi-Fi, make sure that the 
necessary settings are configured.

Refer
 For details on connecting with LAN and USB 

cables, refer to "Connecting to a Wired (Ethernet) 
Network" (P.16) or "Connecting to a Computer 
With USB" (P.17).

 For details on wireless LAN connections, refer to 
"Connecting to a Wireless Network" (P.18).

An error has occurred on 
the machine.

Check the error information, and take the 
required action.

The protocol to use is not 
enabled.

Enable the protocol to use.

Refer
 For details, refer to "[Protocol]" (P.130).

The machine is connected 
to multiple computers.

Wait for a while and try printing again.

Problem Possible Cause Action
Unable to print in 
color.

The machine is specified 
to print color jobs in black 
and white forcibly.

Set [Auto Color To Mono Print] to [Off].

Refer
 For details, refer to "Printing Color Jobs in Black 

and White" (P.58).

The image at the 
edges of the paper 
is missing.

The document exceeds 
the printable area of the 
machine.

Enlarge the print area of the machine, or reduce 
that of the document.

Problem Action
There is no dial tone. Make sure the telephone line is properly connected to the 

machine.

Insert another telephone into the telephone socket and check 
whether it can be used.
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Faxes are not received 
automatically.

Make sure the telephone line is properly connected to the 
machine.

Make sure Fax Mode has been selected.

Confirm that [Fax Memory Full] appears on the screen.

Configure the following settings to a short interval, such as 30 
seconds.
 FAX Mode
 TEL/FAX Mode
 Ans/FAX Mode

This machine does not send 
faxes.

Check whether a message stating that a fax is being sent is 
displayed onscreen.

Check the receiving fax machine to see if the sent fax has arrived.

For [Dial Type], check [PB], [DP (10pps)] and [DP (20pps)].

Check whether documents are loaded in the document feeder or 
on the document glass.

There may not be enough memory to store the document. Check 
whether the message [Fax Memory Full] is displayed on the 
screen, or whether errors 017-970, 033-787, 033-788 are 
included in the job history report.
In such a case, try the following.
 Set the resolution to standard
 Decrease the number of pages to send at one time
 If a fax has been received, wait until printing is finished
 If there are faxes in the transmission queue, wait until their 

transmission has been completed

There are white sections in 
received faxes or the quality of 
received faxes is low.

Copy an appropriate document to make sure this machine is 
operating properly.

Replace the toner cartridge when it is empty.

Reduce the speed of the fax modem.

There may be a problem with the fax machine that is sending 
faxes to this machine.

Some text of the received fax is 
stretched out.

A paper jam may have occurred temporarily in the fax machine 
that is sending the fax to this machine.

There are lines on received 
documents.

Wipe away any stains on the surfaces of the Document Glass and 
Narrow Glass Strip.

Refer
 For details, refer to "Cleaning the Document Glass Cover, Document 

Glass, Document Presser and Narrow Glass Strip" (P.198).

A number can be dialed, but 
there is no connection.

The fax machine of the other party may be switched off, out of 
paper, or not responding to incoming messages. Ask the other 
party to deal with the problem.

Documents are not saved to 
memory.

There may not be enough memory to store the document. If the 
message [Fax Memory Full] is displayed on the screen, delete 
unnecessary documents from the memory and re-save the 
document, or wait until the job being executed, such as sending 
or receiving faxes, is complete.

Problem Action
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Scanning Problems

This machine does not send or 
receive faxes.

For [Dial Type], check [PB], [DP (10pps)] and [DP (20pps)].

Make sure the cable is properly connected to the machine.

If the telephone line is connected to this machine via a telephone 
answering machine, computer, or other device, connect the 
telephone line directly to this machine.

Errors occur frequently during 
the sending and receiving of 
faxes.

At the Home screen, reduce modem speed using 
>[Device]>[General]>[Fax Settings]>[Outgoing Fax 

Settings]>[Modem Speed].

Faxes are received but not 
printed.

Check to ensure that [Forward Settings] is set to [Off].

Check to ensure that [Junk Fax Filter] is set to [Off].

Check to ensure that [Secure Fax Receive] is set to [Off].

Execute [Initialize NVM] > [Fax Settings].

Problem Action
The scanner does not work. Specify low resolution and scan again.

There may not be enough memory to store the document to scan. 
Check that the preview feature operates properly. Or lower the 
scan resolution rate.

Make sure that the USB or Ethernet cable is properly connected 
to the machine.

Check if there are any problems with the USB or Ethernet cable. If 
any, replace the cable.

Vertical lines appear in the 
output of the scanned data 
when scanning with the 
document feeder.

Clean the narrow glass strip.

Refer
 For details, refer to "Cleaning the Document Glass Cover, Document 

Glass, Document Presser and Narrow Glass Strip" (P.198).

When scanning with the 
document glass, stains appear 
in the same position.

Clean the document glass.

Refer
 For details, refer to "Cleaning the Document Glass Cover, Document 

Glass, Document Presser and Narrow Glass Strip" (P.198).

The document gets stained 
when scanning with the 
document feeder.

Clean the document feeder rollers.

Refer
 For details, refer to "Cleaning the Document Feeder Rollers" 

(P.200).

Images are skewed. Check to ensure that the document is properly aligned when 
loaded in the document feeder or on the document glass.

Diagonal lines appear on the 
output of the scanned data 
when scanning with the 
document feeder.

Scan the thick document using the document glass.

Check to ensure that the document feeder is not raised. Remove 
any objects that may be caught between the document feeder 
and document glass.

Problem Action
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Wireless Problems

Wi-Fi Direct Problems

Problem Action
Cannot set up wireless 
connection.

Check to ensure that [Wi-Fi] is enabled.

Refer
 For details, refer to "[Wi-Fi]" (P.127).

The firewall on your computer may be blocking communication 
with your machine. Disable the firewall on your computer.

Unable to set up wireless 
connection with WPS.

Make sure that the security settings of the access point or 
wireless router is WPA or WPA2. WEP is not supported on WPS.

Make sure that the access from the MAC address of the machine 
is not restricted on your access point or wireless router.

Refer
 For details on the operations of your access point or wireless router, 

see the manual supplied with the access point or wireless router.

Unable to set up wireless 
connection with WPS (push 
button method).

Press the WPS button on the access point or wireless router 
within 2 minutes after starting the WPS operation on the 
machine.

Refer
 For details about the access point or wireless router, see the manual 

supplied with the access point or wireless router.

Unable to set up wireless 
connection with WPS (PIN 
code method).

Make sure that you have entered the correct PIN on the access 
point or wireless router.

Refer
 For details about how to enter the PIN code, see the manual 

supplied with the access point or wireless router.

The network mode of the 
machine cannot be set to an 
Ad-hoc mode.

Check to ensure that [Wi-Fi Direct] is disabled.

Refer
 For details on settings, refer to "[Wi-Fi Direct]" (P.128).

Problem Action
The mobile device cannot 
discover the machine.

The machine may be connected to another mobile device via Wi-
Fi Direct. Disconnect the machine and the mobile device.

Refer
 For details, refer to "Disconnecting the Mobile Device From the Wi-

Fi Direct Network" (P.110).

Unable to connect the mobile 
device with the machine.

When connecting to the machine using the Wi-Fi Direct feature of 
an Android device, set the machine's [Group Role] to [Group 
Owner].

Refer
 For details on settings, refer to "[Wi-Fi Direct]" (P.128).
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IPv6 Environment Problems

Scanner Driver/Software Problems

12.3 Understanding Machine Messages
When the operation finishes abnormally due to an error or when problems occur on the machine, the 
operator panel displays error messages and the status codes (***-***). Solve the problems, 
referring to the status codes in the following list.

Note
 When the displayed error code is not included in the following list, follow the instructions in the error 

message displayed on the operator panel. If you cannot solve the problem after following the instructions 
in the list or operator panel error message, contact our local representative.

You will not be able to 
disconnect the mobile device 
from the machine, even by 
performing the procedure for 
"Disconnecting the Mobile 
Device From the Wi-Fi Direct 
Network" (P.110).

The mobile device may be automatically reconnecting to the 
machine. Reset the passphrase for Wi-Fi Direct and disconnect 
the mobile device.

Refer
 For details, refer to "Resetting the Passphrase" (P.110).

Unable to enable [Wi-Fi 
Direct].

Make sure that the network mode is set to an infrastructure 
mode.

Check to ensure that [IP Mode] is set to a mode other than [IPv6].

Problem Action
Unable to set an IP address for 
IPv6.

Check to ensure that [Wi-Fi Direct] is disabled.

Refer
 For details on settings, refer to "[Wi-Fi Direct]" (P.128).

Problem Action
Address Book data can't be 
imported from the machine 
into the Address Book Editor.

Make sure that the USB or Ethernet cable is properly connected 
to the machine. For a wireless network, make sure that the 
machine and the computer are correctly connected to the 
wireless network.

Make sure that the machine is turned on.

Check that the scanner driver is installed in the computer 
(Address Book Editor acquires address book data via the scanner 
driver when the machine and the computer are connected with a 
USB cable).

Status-Code What you can do
016-404 There is a problem with the certificate. Contact your system 

administrator. Tap [OK] to begin initialization.016-405

016-503 Unable to resolve the SMTP server hostname. Make sure that the 
SMTP server and DNS server are set correctly.

Problem Action
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016-504 Unable to resolve the POP3 server hostname. Make sure that the user 
name and password for the POP3 server and DNS server are set 
correctly.

016-505 A login error has occurred when accessing a POP3 server. Make sure 
that the user name and password used for POP3 server are set 
correctly.

016-506 The SMTP or POP3 server settings are not configured. Configure the 
SMTP or POP3 server settings.

016-507 A login error has occurred when accessing an SMTP server. Make sure 
that the user name and password used for the SMTP server are set 
correctly.

016-520 The certificate of the machine is invalid. Contact your system 
administrator.

016-521 The certificate of the destination client is invalid. Contact your system 
administrator.

016-522 Unable to acquire the SSL certificate. Contact your system 
administrator.

016-523 The SSL certificate data is incorrect. Contact your system 
administrator.

016-524 The validity period of the SSL certificate has expired. Contact your 
system administrator.

016-530 An authentication error has occurred when accessing an LDAP server. 
Turn off the machine, and then turn it on again. Check the access 
settings for the authentication server. If the problem persists, contact 
our local representative.

016-541 A wireless certificate of the server or client cannot be correctly 
referenced while using Wireless LAN Mixed Mode Enterprise or WPA2-
Enterprise. Ask your system administrator to connect the machine 
with a wired network, and then initialize the wireless settings. After 
that, import the wireless certificate, and then set Mixed Mode 
Enterprise or WPA2-Enterprise again.

016-542 A server certificate error has occurred when acquiring the certificate 
with the operation of Mixed Mode Enterprise or WPA2-Enterprise. This 
is a problem in the server certificate, such as the validity period has 
expired for the server certificate being used with the Radius server. 
Ask your system administrator to check the server certificate being 
used with the Radius server.

016-543 A wireless certificate of the server or client corruption error has 
occurred while using the Wireless LAN Mixed Mode Enterprise or 
WPA2-Enterprise. Ask your system administrator to connect the 
machine with a wired network, and then initialize the wireless settings. 
After that, import the wireless certificate, and then set Mixed Mode 
Enterprise or WPA2-Enterprise again.

016-718 An error has occurred when there is insufficient memory to print.  The 
print job is canceled. Reduce the data size of the print job.

016-720 Incompatible Page Description Language (PDL) is included. Use the 
machine's print driver.

Refer
 For details on how to install print drivers, refer to "Installing Software for 

Windows" (P.25) or "Installing Software for Mac" (P.28).

Status-Code What you can do
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016-757 The account is not registered. Contact your system administrator.

016-759 Printable page limit is exceeded. Contact your system administrator.

016-764 An error occurs when the machine is connected to the SMTP server. 
Check the SMTP server settings or contact the SMTP server 
administrator.

016-765 The capacity of the SMTP server is not enough. Contact the SMTP 
server administrator.

016-766 The e-mail exceeds the SMTP server size restriction. Contact the SMTP 
server administrator.

016-767 The e-mail address for the recipient is incorrect. Check the e-mail 
address, and then try scanning again.

016-768 The e-mail address for the sender is incorrect. Check the e-mail 
address, and then try scanning again.

016-786 A timeout error occurs when sending or receiving scanned data. Make 
sure that the Ethernet cable is connected properly. If there is no 
problem with the Ethernet cable, contact your server administrator.

016-790 Network connection error has occurred. If you use a wired LAN 
connection, make sure that the Ethernet cable is connected properly.
If there is no problem with the cable, or if you use a wireless LAN 
connection, contact your server administrator.

016-799 The job is invalid. Check the configuration of the machine on the print 
driver.

016-924 When specifying the encryption type as WEP and connecting to a 
wireless network, [Quick Setup] cannot be used to configure wireless 
network settings. If the wireless network access point encryption type 
is WEP, configure the wireless network settings from the machine's 
operator panel.

Refer
 For details on wireless network settings, refer to "Manually Connecting to 

a Wireless Network" (P.20).

016-985 Lower the scan resolution rate, and then try scanning again. Or change 
the file format of the scanned data.016-986

017-970 There was not enough memory capacity to store the document. Select 
[Close], and try the following.
 Set the resolution to standard
 Decrease the number of pages to send at one time
 Delete received faxes, or wait for a while until fax transmission is 

completed
 Print saved fax jobs

Refer
 For details on Secure Receiving Mode, refer to "Using the Secure 

Receiving Mode" (P.102).

027-446 IPv6 address is overlapped. Change the IPv6 address.

027-452 IPv4 address is overlapped. Change the IPv4 address.

031-521 SMB server login error. Check login-able computer with your system 
administrator.

031-522 SMB server login error. Check if login name (domain name and user 
name) and password are correct.

Status-Code What you can do
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031-523 Invalid SMB share name. Check the share name you specified.

031-524 Exceeded the SMB server user account limit. Check the number of 
users who use the server at the same time is not exceeding the upper 
limit.

031-525 SMB destination client permission error. Check if the specified user can 
read and write files at the storage location.

031-526 Unable to find the SMB server hostname on the network. Check DNS 
connection, or check if the forwarding destination server is registered 
with DNS.

031-527 Unable to find the SMB server hostname on the network. Set the DNS 
address, or set the forwarding destination IP address.

031-528 Unable to connect to the SMB server. Check if the machine can 
communicate via network with the forwarding destination SMB server.

031-529 SMB server login error has occurred. Password is invalid. Make sure 
that the password is correct.

031-530 Unable to find the SMB share folder on the specified SMB server. 
Check the following:
 Is the storage location correct?
 Is the file name you specified the same with the name of the file you 

created on the SMB server?
 Is the DFS settings correct? Are the SMB server, share name, and 

storage location directly specified according to the checked 
settings?

031-531 Unable to find a file or folder name on the SMB server. Check access 
rights to the folder you specified.

031-532 SMB scan file or folder name limit exceeded. Change the file name or 
the forwarding destination folder. Or move or delete the file in the 
forwarding destination folder.

031-533 Unable to write a file in the SMB server. Check if the file name you 
specified is not used by other users.

031-534 Unable to create a folder on the SMB server. Check if the folder name 
you specified is not used by other users.

031-535 Unable to delete a file on the SMB server. Check if another user is not 
operating the file.

031-536 Unable to delete a folder on the SMB server. Check if another user is 
not operating the folder.

031-537 SMB server capacity exceeded. Check if the storage location has free 
space.

031-539 The specified SMB server is invalid. Check if the server name is correct.

031-540 The specified domain name is invalid. Check if the domain name is 
correct.

031-541 The specified user name is invalid. Check if the user name is correct.

031-542 Unable to initialize TCP/IP. Wait for a while and try the same operation 
again. If the problem persists, contact our local representative.

031-543 SMB server login error. Check login permitted time with your system 
administrator.

031-544 SMB server login error. Password is expired. Check the password 
validity period with your system administrator.

Status-Code What you can do
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031-545 SMB server login error. Password is to be changed. Check necessity of 
password change with your system administrator.

031-546 SMB server login error. Invalid user is specified. Contact your system 
administrator for the destination server settings.

031-547 SMB server login error. User restricted from accessing the SMB server 
is specified. Contact your system administrator for the destination 
server settings.

031-548 SMB server login error. Login time of SMB destination is expired. 
Contact your system administrator for the destination server settings.

031-549 SMB server login error. Specified user is restricted. The password must 
be entered. On server security settings, check access permission of null 
password user.

031-550 The APPEND command error has occurred. Check if the machine has 
access rights to append data to the SMB server. Check if the server 
supports the APPEND command.

031-551 The RENAME command error has occurred. Check if the machine has 
access rights to rename data on the SMB server. Check if the server 
supports the RENAME command.

031-552 Job canceled. Change the file name that already exists on FTP server.

031-574 Unable to resolve the FTP server hostname. Check DNS connection. Or 
check if the forwarding destination server is registered with DNS.

031-575 Unable to resolve the FTP server hostname. Sets the DNS address. Or 
set the address for the forwarding destination server address as IP 
address.

031-576 Unable to connect to the FTP server. Check if the machine 
communicates with forwarding destination FTP server. For example, 
check if the Ethernet cable is connected, or the IP address for the 
server is correct.

031-578 FTP server login error has occurred. Check if the login name (user 
name) and password are correct.

031-579 Invalid FTP subdirectory path. Check if the storage location is correct.

031-580 Unable to find a file or folder name of the FTP server. Check the server 
access rights.

031-581 FTP scan file or folder name limit exceeded. Change the file name or 
the forwarding destination folder, or move or delete the file in the 
forwarding destination folder.

031-582 Unable to write a file to the FTP server. Check if a file with the name 
you specified can be created in the storage location, or check if the 
storage location has free space.

031-584 Unable to create a scan folder on the FTP server. Check if a folder with 
the name you specified can be created in the storage location, or check 
if a folder with the same name that you specified already exists.

031-585 Unable to delete a file on the FTP server. Check the server access 
rights.

031-587 Unable to delete a folder on the FTP server. Check the server access 
rights.

031-588 Unable to write a file to the FTP server. Check if the storage location 
has free space.

Status-Code What you can do
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031-590 Job canceled. Change the file name that already exists on FTP server.

031-594 A TYPE command error has occurred. Try the same operation again. If 
the problem persists, contact our local representative.

031-595 A PORT command error has occurred. Try the same operation again. If 
the problem persists, contact our local representative.

031-598 The APPEND command error has occurred. Check if the machine has 
access rights to append data to the FTP server. Check if the server 
supports the APPEND command.

031-599 The PNFR command error has occurred. Check if the machine has 
access rights to rename a file on the FTP server. Check if the server 
supports the PNFR command.

033-513 The fax communication error has occurred. Perform the following:
 Print the received fax, or wait for a while until sending a fax is 

completed.
 If [Secure Fax Receive] is enabled, stored faxes will be printed.

033-762 The machine rejects faxes sent from unwanted numbers.

033-776 The size of the fax document data is too large and may have exceeded 
the space available in memory. Lower the scan resolution rate, and 
then try scanning again.

Refer
 For details, refer to "[Resolution]" (P.104).

033-788 There was not enough memory capacity to store the document. Select 
[Close], and try the following.
 Set the resolution to standard
 Decrease the number of pages to send at one time
 Delete the received fax, or wait for a while until fax transmission is 

completed
 If you are using the secure receiving mode, print the stored fax jobs

Refer
 For details on Secure Receiving Mode, refer to "Using the Secure 

Receiving Mode" (P.102).

034-515 The fax communication error has occurred. Check if the memory of the 
machine or the remote fax machine is full.

034-791 Check if the telephone cable is connected properly. If the line 
connection is correct, check the following:
 Is the dialing type settings correct?

Refer
 For details, refer to "[Dial Type]" (P.125).

If the dialing type settings is correct, check the following:
 Can the remote fax machine receive a fax?

035-708 The fax communication error has occurred. Reduce the modem speed.

Refer
 For details, refer to "[Modem Speed]" (P.126).

035-717

035-718 The sender's fax machine does not respond. Check the status of the 
remote fax machine.

035-720 A fax communication error has occurred. Check the features of the 
remote fax machine.

Status-Code What you can do
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062-371 The amount of data to process exceeds the limit.
Cancel 2-up (copy two pages onto one side), copy to one side, or copy 
in black and white.
Scan in reduced resolution, image quality, or file size (10.14).

062-956 The document size was not correctly detected. Reload the document 
on the document glass, and tap [Start].

Note
 When loading a custom document size, specify the document size using 

[Original Size]. Depending on the selected document size, the document 
may not fit on the paper, or shadows around the document may be 
copied.

116-721 The job was canceled because of insufficient memory capacity to copy 
or print multiple copies. Divide the data to be printed or copied and 
execute the job again.

116-722 The destination computer does not respond. Make sure that the 
specified computer is running, and then try scanning again.

Status-Code What you can do
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13 Installing Optional 
Accessories

13.1 Installing the 250-Sheet Feeder (Tray 
2)

Installing the 250-Sheet Feeder (Tray 2)
1. Press the  (Power Supply / Power Saver) button to turn the power off.

2. Disconnect the power cord from the power outlet and from the machine main unit.

3. Position the 250-Sheet Feeder (Tray 2) for installation.

4. Lift the machine main unit as shown in the illustration.

CAUTION
 The main unit should always be lifted by two or more people.

5. Make sure that the front surface and corners of the 250-Sheet Feeder (Tray 2) align with those of 
the machine, and gently lower it into place.
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Important
 Installation with the machine and 250-Sheet Feeder (Tray 2) at different angles could result in damage to 

the machine.

Configure Settings with the Print Driver
Networked print options and paper tray information are reflected in the print driver settings.

1. Click on [Start]>[Windows System]>[Control Panel]>[View devices and printers] or [Devices and 
Printers].

2. Right-click on the machine icon, and select [Printer properties].

3. Click on the [Configuration] tab, and click on [Bi-Directional Setup]>[Get Information from 
Printer]>[OK].

4. Click on [Apply]>[OK].

Note
 If the printer information is not updated when you click on [Get Information from Printer], configure 

using the [Configuration] tab > [Installable Options].
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14 Appendix
14.1 Specifications

Basic Specifications/Copy Function
Type Desktop

Memory Capacity 512 MB (Max: 512 MB)

Colour Capability Full Colour

Scan Resolution 600x600 dpi

Printing Resolution 600x2400 dpi

Warm-up Time 35 seconds or less (23 degrees Celsius room temperature)

Recovery Time (from Sleep 
Mode)

17 seconds or less (23 degrees Celsius room temperature)

Original Size Maximum of A4, Letter, Legal*1 for both Sheet and Book

Paper Size Max: A4, Letter, Legal
Min: A6, 76x127 mm
Image loss width: 4.1 mm on top, bottom, left and right edges

Paper Weight Paper Tray: 60 to 176 gsm
Bypass Tray: 60 to 176 gsm

Important
 It is recommended to use our recommended paper. Correct print output 

may not be possible depending on the requirement.

First Copy Output Time B/W: 9.5 sec. (A4), Colour: 12.0 sec. (A4)

Important
 Measured in accordance to ISO/IEC 29183.

Continuous Copy Speed A4: B/W 31 ppm, Colour 31 ppm
A5: B/W 41 ppm, Colour 41 ppm

Important
 The speed may be reduced due to the image quality adjustment.

Paper Tray Capacity Standard: 250 sheets (Tray1), 50 sheets (Bypass Tray)
Optional: 250 sheets (250-Sheet Feeder (Tray 2))
Max: 550 sheets

Important
 80 gsm paper

Output Tray Capacity 150 sheets (Face down)

Important
 80 gsm paper

Power Supply AC220-240 V +/- 10 %, 10 A, 50/60 Hz common
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*1 :Not available on Document Glass.

Print Function

Maximum Power 
Consumption

1120 W
Sleep Mode: 0.5 W
Low Power Mode: 11 W
Ready Mode: 41 W

Dimensions Width 410 x depth 430 x height 366 mm

Weight  Apeos C325 z: 20.6 kg
 Apeos C325 dw: 20.5 kg

Important
 Excluding Toner Cartridges.

Type Built-in

Continuous Print Speed Same as the Basic Specifications/Copy Function

Important
 When Continuously Printing Original (Plain). The performance may be 

reduced depending on the paper type and the paper size. The speed 
maybe reduced due to the image quality adjustment. Measured in 
accordance to ISO/IEC 24734.

Printing Resolution Standard: 600x2400 dpi

Page Description Language Standard: PCL5 / PCL6, PostScript language compatibility

Operating System Standard
PCL Driver:
Windows 10 (32 bit)
Windows 10 (64 bit)
Windows 8.1 (32 bit)
Windows 8.1 (64 bit)
Windows Server 2019 (64 bit)
Windows Server 2016 (64 bit)
Windows Server 2012 R2 (64 bit)
Windows Server 2012 (64 bit)
PostScript language compatibility:
Windows 10 (32 bit)
Windows 10 (64 bit)
Windows 8.1 (32 bit)
Windows 8.1 (64 bit)
Windows Server 2019 (64 bit)
Windows Server 2016 (64 bit)
Windows Server 2012 R2 (64 bit)
Windows Server 2012 (64 bit)
macOS 11 / 10.15 / 10.14 / 10.13 / 10.12

Important
 For information about the latest supported OS, visit our web site.

Interface Standard:
Ethernet 1000BASE-T / 100BASE-TX / 10BASE-T, USB2.0,
Wireless LAN (IEEE 802.11 b / g / n)



24114.1   Specifications

Scan Function

*1 :Only when Document glass is used.

Fax Function
Note
 Only on Apeos C325 z

*1 :No. of FAX lines is up to 1 port. Port refers to number of channels for FAX.

Automatic Document Feeder

Type Colour Scanner

Scan Resolution Scan to PC
TWAIN: 50x50 to 9600x9600 dpi
WIA : 75 dpi, 100 dpi, 150 dpi, 200 dpi, 300 dpi, 400 dpi, 600 dpi

Scan to Network / e-mail
200 dpi, 300 dpi, 400 dpi*1, 600 dpi*1

Scan Speed Same as the Scan Speed for the Automatic Document Feeder

Interface Standard:
Ethernet 1000BASE-T / 100BASE-TX / 10BASE-T, USB2.0,
Wireless LAN (IEEE 802.11 b / g / n)

Original Size Document Glass: Max A4, Letter
Automatic Document Feeder: Max Legal

Recording Paper Size Max: Legal
Min: A4, Letter

Transmission Time 3 seconds and more but fewer than 4 seconds

Important
 When A4 size document with approximately 700 characters is 

transmitted in standard image-quality (8 x 3.85 lines/mm) and in high-
speed mode (33.6 kbps or faster, JBIG). Only indicates the time for 
transmitting the image information and does not include the 
communication control time. The total communication time will vary 
depending on the contents of the document, the type of machine 
receiving the fax, and line condition.

Transmission Mode ITU-T G3

Applicable Lines Subscribed telephone line, PBX, maximum 1 port *1(G3-1 port)

Type  Apeos C325 z
1 pass, 2 sided scanning Duplex Automatic Document Feeder

 Apeos C325 dw
Automatic Document Feeder
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14.2 About Supplies

Life of Consumables
Use of consumables/periodical replacement parts not recommended by us may impair machine 
quality and performance. Use only consumables/periodical replacement parts recommended by us.

Original Size / Paper 
Weight

 Apeos C325 z
Max: Legal; Min: A5
60 to 105 gsm (In Duplex: 60 to 105 gsm)

 Apeos C325 dw
Max: Legal; Min: A5
60 to 105 gsm

Important
 The minimum custom size is 139.7 x 139.7 mm.

Capacity 50 sheets

Important
 80 gsm paper

Scan Speed Copy (A4, Simplex)
B/W: 30 ppm, Colour: 16 ppm
Scan
 Apeos C325 z

B/W: 30 ppm, Colour: 15 ppm (1 pass, 2 sided scanning; B/W: 45 
ppm, Colour: 22 ppm)
(Standard Document (A4), 200 dpi, to USB memory)

 Apeos C325 dw
B/W: 30 ppm, Colour: 15 ppm
(Standard Document (A4), 200 dpi, to USB memory)

Important
 The scanning speed varies depending on the documents.

Consumables Printable page yield
Black Toner [K] Cartridge (High Capacity) Approximately 6000 pages

Cyan Toner [C] Cartridge (High Capacity) Approximately 4000 pages

Magenta Toner [M] Cartridge (High Capacity) Approximately 4000 pages

Yellow Toner [Y] Cartridge (High Capacity) Approximately 4000 pages

Black Toner [K] Cartridge Approximately 3000 pages

Cyan Toner [C] Cartridge Approximately 2000 pages

Magenta Toner [M] Cartridge Approximately 2000 pages

Yellow Toner [Y] Cartridge Approximately 2000 pages

Drum Cartridge [YMCK] Approximately 50000 pages

Waste Toner Container Approximately 6000 pages
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14.3 Updating the Machine's Firmware
You can use a computer to update the machine's firmware (the software programmed into the 
machine). You can download the firmware updating tool from the official company website.
https://fujifilm.com/fbglobal/eng/support

14.4 Legal Notice
Printing certain documents may be illegal in your country. Penalties of fines or imprisonment may be 
imposed on those found guilty. The following are examples of items that may be illegal to copy or 
print in your country.
 Currency
 Banknotes and checks
 Bank and government bonds and securities
 Passports and identification cards
 Copyright material or trademarks without the consent of the owner
 Postage stamps and other negotiable instruments
This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of 
doubt, contact your legal counsel.

14.5 New Zealand FAX modem statements
General

"The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has 
accepted that the item complies with minimum conditions for connection to its network. It indicates 
no endorsement of the product by Telecom, nor does it provide any sort of warranty. Above all, it 
provides no assurance that any item will work correctly in all respects with another item of 
Telepermitted equipment of a different make or model, nor does it imply that any product is 
compatible with all of Telecom’s network services"
"This equipment does not fully meet Spark's impedance requirements. Performance limitations may 
occur when used in conjunction with some parts of the network. Telecom will accept no 
responsibility should difficulties arise in such circumstances."
"This equipment shall not be set up to make automatic calls to the Telecom ‘111’Emergency 
Service."
"If a charge for local calls is unacceptable, the ‘Dial’ button should NOT be used for local calls. Only 
the 7-digits of the local number should be dialed from your telephone. DO NOT dial the area code 
digit or the ‘0’ prefix."
"This equipment may not provide for the effective hand-over of a call to another equipment 
connected to the same line."

Important Notice
"Under power failure conditions, this telephone may not operate. Please ensure that a separate 
telephone, not dependent on local power, is available for emergency use."
"Some parameters required for compliance with Spark’s Telepermit requirements are dependent on 
the equipment (PC) associated with this equipment. The associated equipment shall be set to 
operate within the following limits for compliance with Telecom’s Specification:
There shall be no more than 10 call attempts to the same number within any 30-minute period for 
any single manual call initiation, and the equipment shall go on-hook for a period of not less than 30 
seconds between the end of one attempt and the beginning of the next attempt.

https://fujifilm.com/fbglobal/eng/support
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Where automatic calls are made to different numbers, the equipment shall go on-line for a period of 
not less than 5 seconds between the end of one attempt and the beginning of the next attempt.
The equipment shall be set to ensure that calls are answered between 3 and 30 seconds of receipt of 
ringing."
"All persons using this equipment for recording telephone conversations shall comply with New 
Zealand law. This requires that at least one party to the conversation is to be aware that it is being 
recorded. In addition, the Principles enumerated in the Privacy Act of 1993 shall be complied with in 
respect to the nature of the personal information collected, the purpose for its collection, how it is 
used and what is disclosed to any other party."
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